Getting Started with NCD X Terminals

NCDware Version 3.2
Part Number 9300276 Rev. A
April, 1994

Network Computing Devices, Inc.
350 North Bernardo Avenue
Mountain View, California 94043
Telephone 415/694-0650
FAX 415/961-7711
Email: support@ncd.com
Guidelines for Productive and Healthy Use of Your X Terminal

You may have read or heard of articles which have linked prolonged viewing of computer video display terminals with eye fatigue, and prolonged use of computer keyboards and mouse devices with repetitive stress injuries such as carpal tunnel syndrome. One common example is the syndrome known as “tennis elbow.” Although a conclusive direct causal relationship between computer use and these adverse health effects has yet to be scientifically proven, NCD recommends that you read and follow these guidelines in setting up and using your new NCD X terminal.

- Set up your X terminal in a well lit, glare and shadow-free environment.
- Avoid using your X terminal in a position you find awkward or unnatural.
- Select a chair that provides good lower back support. Adjust your chair so that your feet rest flat on the floor with your thighs in a horizontal position.
- Place your keyboard on a surface so that your wrists are not tilted, or only slightly tilted while using the keyboard. Many people find a comfortable keyboard height is at the same level as their elbows.
- If the height of your work surface cannot be adjusted, position the chair at a comfortable height and use a footrest to place your feet on a level surface.
- Place your mouse on a surface which is at the same height as your keyboard. Many people find using the mouse and keyboard within 16” inches of the body is comfortable.
- Avoid resting your arm on your work surface and merely bending your wrist when using your mouse. Consider using a wristrest to provide a padded surface for your wrists when working with your mouse.
- Place your display monitor at a comfortable viewing distance. Many people favor a distance of 16” to 28” from their eyes. Position the screen so that you are not looking up or down at the screen.
- Take breaks to rest your eyes, stretch your muscles, and move around.
- Vary your work patterns so that you alternate working at your X terminal with other tasks that use different muscle groups and allow you to focus your eyes at different distances.
- See your physician if you experience persistent muscle ache, joint pain, eye fatigue or other discomfort when using your X terminal.

These are guidelines. What is comfortable for some may not be comfortable for you. You are the only one who can decide if these guidelines are appropriate for your needs.

What about electromagnetic emissions from your monitor? Many objects we encounter in our everyday lives produce very low frequency (VLF) and extremely low frequency (ELF) electromagnetic emissions. These objects include such common appliances as portable cellular telephones, televisions, toasters, electric blankets, and video display terminals (VDT) such as the monitor which is part of your X terminal. VDTs, have been the focus of a growing controversy over the potential health effect of VLF and ELF emissions.

NCD is monitoring this issue and shares the public’s concern over the potential health consequences of exposure to VLF and ELF emissions from VDTs. To date, the research and testing on
this subject is inconclusive. Moreover, the link, if any between VDT emissions and adverse health effects is unproven and the subject of much debate. Stress, postural strain and poor working conditions are frequently cited in addition to, and instead of, VDT emissions as posing potential health hazards to frequent users of VDTs.

The prevailing professional opinion to date is that VDTs are safe. NCD products comply with the applicable regulations and standards for electromagnetic radiation set forth by the U.S. Code of Federal Regulations, Underwriters Laboratories, Inc., the Canadian Standards Association, and the German VDE Standard. When and if new or additional standards are adopted, NCD will take appropriate steps to comply with them.

Even though the preponderance of professional opinion is that VDTs are safe, some of our customers have asked us for information on how to reduce their exposure to VLF and ELF emissions. Although NCD does not endorse the following as having health benefits, the easiest and perhaps most economical and effective measures are to turn off your display when not in use, to position your display at arm's length, and to avoid working in areas where you are positioned close to the rear of a VDT where the emissions are strongest. Also, shields are available from third party vendors that reduce glare and electric emissions.
Before You Begin

Intended Audience

This document is written for NCD X terminal users who do not have much experience using X, workstations, or X terminals.

Getting Started provides an explanation of how X terminals work and the purpose of the NCD software. Understanding how the X Window System (also called X) and NCD X terminals work will help you to take advantage of all the available options.

In addition, Getting Started suggests ways to get the best performance out of your NCD X terminal when you run any of four common graphical user interfaces (GUIs) provided by other vendors to simplify X usage.

Assumptions

Getting Started assumes that you are running the Standard X server. However, notes are included to point out the differences between the Standard, Minimal, mwm, and XRemote-only X servers. DPS and PEX X servers are documented in NCDware 3.2 Advanced User’s Guide for UNIX Systems and NCDware 3.2 Advanced User’s Guide for VMS Systems. The 3270 emulation X server is documented in Using the 3270 Terminal Emulator.
Getting Started assumes that a system administrator (or an experienced user) has already:

- Set up an account for you on your X terminal’s primary host computer
- Prepared the startup files you need for X to run on your X terminal
- Installed the terminal on the network
- Configured an X display manager (xdm)
- Configured a window manager
- Configured the local terminal emulators
- Configured the setup parameters and prepared the startup files you need to run XRemote (if you plan to use XRemote).

Before you start reading Getting Started, ask your system administrator for the following items. We refer to these items in later sections of Getting Started.

- Name of the primary host and operating system you are using
- Name of the graphical user interface and window manager you are using
- Name of the X server you are using (Several X servers are available. Some X servers do not include all of the features described in this manual.)
- Your login and password

**Note** If you do not have a system administrator, refer to the system administration guides and manuals cited in “Additional Documents” at the end of this section.
Contents of this Manual

The contents of this document are organized as follows:

- Chapter 1, A Quick Tour on an NCD X Terminal, illustrates some X features and defines some concepts and terms.
- Chapter 2, Introducing X Terminals and the X Window System, specifies the X network architecture, the characteristics that make the X environment unique, and X software components.
- Chapter 3, Introducing X with NCD, describes the NCD family of X terminals and NCD software.
- Chapter 4, NCD X Terminal Interface Basics, explains how to use the various software and hardware tools to enter and manipulate data and screens.
- Chapter 5, Starting and Ending an X Session, explains how to log in and out of your NCD X terminal.
- Chapter 6, Using the NCD User Services, explains how to take advantage of the Console, the menu system used to control your X session and work environment.
- Chapter 7, Using the NCD Local Window Manager, explains how to manipulate windows and icons using ncdwm.
- Chapter 8, Using the NCD XRemote Software, explains how to use XRemote software to log in to (1) remote hosts over modems or (2) local hosts over RS-232 C cables.
- Chapter 9, Common GUIs on NCD X Terminals, introduces four common graphical user interfaces and offers tips on how to get the most out of them.
Software Version Numbers

NCD documents refer to versions of software using one of the following formats:

- **maj.min**
  This format refers generically to all versions with the same major and minor version number; for example, 3.2.

- **maj.min.fix**
  This format specifies a distinct product version; for example, 3.1.1 or 3.2.0.

In this notation:

- **maj** indicates the major version number. This field changes for major functional enhancements.
- **min** indicates the minor version number. This field changes for minor functional enhancements.
- **fix** indicates the bug-fix version. This field distinguishes one bug-fix version from another.
Text Conventions

This document uses the following conventions:

Ctrl-Z indicates that you should press two keys at the same time; in this case the Ctrl key and Z.

<CR> indicates that you should press the Return key.

⇒ indicates movement through menus. For example, the phrase “In the Console, select Statistics ⇒ Show Version” means that you display the Statistics menu and select the Show Version menu item.

bold indicates a directory, file, or remote configuration parameter, such as /tftpboot, or boot-automatically.

bold italic indicates a variable or a utility, such as Xncdxxx where xxx indicates the variable portion.

italic indicates emphasis or the name of a publication, such as Getting Started with NCD X Terminals.

courier indicates information displayed on the screen or entries in a file.

bold courier indicates information you should type.
Related Documents

The following documents describing NCD hardware and software products are published by NCD.

For documents describing the X Window System and specialized features of the NCD X server, see the Bibliography in the back of this manual.

- NCD terminal installation booklets
  Terminal installation booklets explain how to unpack and set up NCD terminals and connect them to the network. Each document is designed for a specific NCD terminal or family of terminals.

- NCD memory installation booklets
  Memory installation booklets explain how to install memory in NCD terminals and run the recommended memory test.

- A Roadmap to NCDware 3.2 Publications
  This roadmap is a high-level index of major topics. The roadmap points the reader to the document or chapter in which a specific topic is addressed.

- Getting Started with NCD X Terminals
  This introductory manual explains what users need to know to become productive and efficient with their NCD X terminals. This manual explains the X Window System, how X terminals work, and the purpose of NCD software; provides step-by-step instructions for using the terminal and the software; and suggests how to get the best performance from your terminals when you run four common user interfaces.

  This guide tells how to manage NCD X terminals in a UNIX environment. It includes information for advanced users and system administrators, including terminal and host software configuration, remote configuration,
booting, file service, security, login services, fonts, local clients, keyboards, and more.

- **NCDware 3.2 Installation Guide for UNIX Systems**
  This guide describes how to use the NCDconfig utility to install NCDware software on your host computer, configure terminals, and update system services and databases.

- **NCDware 3.2 Advanced User’s Guide for VMS Systems**
  This guide provides the information a system manager needs to manage NCD X terminals in a VMS environment. This guide details how NCD terminals work and explains how to use remote configuration, file service, fonts, login services, local clients, Display PostScript, and XRemote communications in a VMS environment. The NCDware distribution for VMS includes an online Bookreader version of this guide.

- **NCDware 3.2 Installation Guide for VMS Systems**
  Written for system managers, this guide explains how to install NCO software on a VMS host and add terminals to an existing configuration. It identifies the disk space and memory requirements for systems and terminals and describes recommended post-installation activities. This guide also explains how to copy the NCD distribution to disk, contains an example upgrade installation script, and includes examples of files and UAF entries that are part of the NCDware distribution.

- **NCDware 3.2 Reference Manual**
  This reference manual contains information about new features and reference material about the following subjects: boot monitor functions, features and commands; NVRAM (non-volatile random-access memory); remote configuration language and parameters; using the console to configure and monitor terminals; NCDterm (VT320) terminal emulation; NCD keyboards, keycodes, and keysyms; NCDware X server error messages; and man pages for NCD clients and utilities.
Using the 3270 Terminal Emulator
This manual describes NCD's 3270 emulator local client and provides directions for using and customizing the client.

EXPORT Catalog
This catalog contains descriptions of the X applications (called clients) recommended for NCD X terminals plus an extensive bibliography of X-related books. You can obtain this catalog from computer bookstores or order it directly from NCD.
Contents

This table of contents contains only the major topics (the top-level headings). See the individual chapters for more detailed tables of contents.

Chapter 1 A Quick Tour on an NCD X Terminal
Power On, Booting, and Logging In  1-2
Connecting to Hosts and Applications  1-5
Using Windows  1-9
Locking the Screen and Logging Out  1-16

Chapter 2 Introducing X Terminals and the X Window System
Network Computing  2-1
A Closer Look at X Software and Hardware  2-8

Chapter 3 Introducing X with NCD
The NCD Family of X Terminals  3-1
NCDware  3-2
Common X Clients  3-7
Network Connectivity  3-10
X-Compatible Software and Hardware  3-12
Contents

Chapter 4  NCD X Terminal Interface Basics
Using the Mouse   4-2
Using the Keyboard  4-5
Using Windows Management Tools  4-8
Using Motif-Style Graphical Tools  4-14

Chapter 5  Starting and Ending an X Session
Assumptions   5-2
Powering Up   5-2
Booting   5-3
Logging In   5-4
Logging Out   5-8

Chapter 6  Using the NCD User Services
The Console   6-2
Starting, Suspending, and Ending X Sessions   6-8
Starting the Local Window Manager   6-13
Connecting to Hosts   6-15
Using a Terminal Emulator Window   6-20
Changing User Preferences   6-27
Getting System Information   6-47

Chapter 7  Using the NCD Local Window Manager
Introducing ncdwm   7-2
Using the ncdwm Window   7-12
Advanced ncdwm Features   7-21
Chapter 8 Using the NCD XRemote Software
Assumptions 8-2
XRemote and Related Software and Hardware 8-3
Before Running XRemote 8-7
Deciding Which Protocol to Use 8-12
Using XRemote 8-13
Ending an XRemote Session 8-20
Checking XRemote Diagnostics 8-22

Chapter 9 Common GUIs on NCD X Terminals
OpenWindows Environment on NCD X Terminals 9-2
DECeXwindows Environment on NCD X Terminals 9-10
OSF/Motif Environment on NCD X Terminals 9-27

Glossary
Bibliography
Index
Figures

Figure 1-1  X Terminal Display After Booting  1-2
Figure 1-2  The Login Chooser  1-3
Figure 1-3  A Login Banner  1-4
Figure 1-4  An X Display After Login  1-5
Figure 1-5  A Root Menu  1-6
Figure 1-6  An Applications Submenu  1-6
Figure 1-7  Starting an Application  1-7
Figure 1-8  An Active Window  1-10
Figure 1-9  Enlarging a Window  1-11
Figure 1-10  Adding Another Terminal Emulator  1-12
Figure 1-11  Moving a Window  1-13
Figure 1-12  Using the Window Menu Button  1-14
Figure 1-13  The Console’s Utilities Menu  1-16
Figure 1-14  The Lock Screen Utility  1-16
Figure 2-1  Batch Processing Computing Model  2-2
Figure 2-2  Time-Share Computing Model  2-2
Figure 2-3  Standalone Computing  2-3
Figure 2-4  Work Group Computing  2-3
Figure 2-5  Network Computing Model  2-4
Figure 2-6  Network Access Via an X Terminal  2-5
Figure 2-7  An X Display  2-6
Figures

Figure 2-8  A Window Manager’s Window Frame  2-7
Figure 2-9  X System Components  2-9
Figure 3-1  The Console  3-3
Figure 3-2  An Example of a Root Menu  3-4
Figure 3-3  Multi-Vendor Connectivity  3-10
Figure 4-1  Mouse  4-2
Figure 4-2  Trackball  4-2
Figure 4-3  Keyboard  4-5
Figure 4-4  Window Manager Indicating the Active Window  4-10
Figure 4-5  Window Menu  4-11
Figure 4-6  Iconified and Deiconified Windows  4-13
Figure 4-7  Menu Bar and Related Tools  4-14
Figure 4-8  Motif-Style Buttons in Popup Windows  4-16
Figure 4-9  Slider and Textual Tools  4-18
Figure 5-1  The X Display After Booting  5-4
Figure 5-2  An XDM Login Banner  5-6
Figure 5-3  Typical Display After Login  5-7
Figure 6-1  The Console  6-2
Figure 6-2  The Console with Messages  6-6
Figure 6-3  The Lock Screen Popup Window  6-9
Figure 6-4  Confirming Logging Out  6-11
Figure 6-5  An X Display Without a Window Manager  6-13
Figure 6-6  An X Display with ncdwm Running  6-14
Figure 6-7  The Terminal Host Chooser  6-15
Figure 6-8  A Telnet Terminal Emulator Window  6-18
Figure 6-9  A VT320 Terminal Emulator Window  6-20
Figure 6-10  User Preferences Popup Window  6-28
Figure 6-11  Keyboard Preferences  6-31
Figure 6-12  Bell Preferences  6-33
Figure 6-13  Pointing Devices Preferences  6-34
Figure 6-14  Screen Background Preferences  6-36
Figure 6-15  Screen Saver Preferences  6-37
Figure 6-16  Power Management Preferences  6-38
Figure 6-17  Font Preferences  6-39
Figure 6-18  X, Graphics, and SIE Preferences  6-41
Figure 6-19  Compatibility Preferences  6-43
Figure 6-20  Console and Utilities Preferences  6-44
Figure 6-21  Audio Preferences  6-45
Figure 6-22  The Statistics Menu  6-47
Figure 6-23  The Show Version Popup Window for Ethernet  6-47
Figure 6-24  The Show Memory Popup Window  6-50
Figure 6-25  The Show X Connections Popup Window  6-51
Figure 6-26  The Show Statistics Popup Window  6-52
Figure 7-1  The Default Root Menu  7-5
Figure 7-2  A Window and Icon  7-6
Figure 7-3  Adding Windows  7-7
Figure 7-4  ncdwm Window  7-8
Figure 7-5  Resize Handles and Pointer Appearance  7-10
Figure 7-6  Window Menu  7-13
Figure 7-7  Icons in the Icon Box  7-18
Figure 8-1  A Local Area Network With XRemote  8-3
Figure 8-2  Serial Ports on NCD Terminals  8-5
Figure 8-3  Groups of Equipment: DCE and DTE  8-5
Figure 8-4  Checking X Terminal Parameters  8-8
Figures

Figure 8-5  Checking X Terminal Serial Parameters  8-11
Figure 8-6  NCD Terminal Host Chooser  8-15
Figure 8-7  Dialer Client Communications Menu  8-21
Figure 9-1  An OpenWindows Display After Login  9-3
Figure 9-2  An OpenWindows Window  9-5
Figure 9-3  The DECwindows Start Session Dialog Box  9-11
Figure 9-4  DECwindows Motif Display After Logging In  9-12
Figure 9-5  A DECwindows Motif Window  9-14
Figure 9-6  DECwindows Motif Session Manager  9-18
Figure 9-7  DECwindows Menus Dialog Box  9-19
Figure 9-8  Adding an Item to the Item Names Box  9-20
Figure 9-9  Adding an Item to the Applications Menu  9-21
Figure 9-10 DECwindows Motif Applications Menu  9-22
Figure 9-11 Removing a Client from Automatic Startup  9-23
Figure 9-12 Adding *ncdwm* to the Auto Start List  9-24
Tables

Table 1-1  Powering On, Booting, and Logging In 1-4
Table 1-2  Connecting to Hosts and Applications 1-8
Table 1-3  Using X 1-15
Table 1-4  Pausing and Logging Out 1-17
Table 2-1  Characteristics of X 2-8
Table 2-2  Common Window Managers 2-13
Table 3-1  Protocols Used to Connect to Hosts 3-5
Table 4-1  Mouse Actions 4-4
Table 4-2  Setup Key Equivalent Combinations 4-8
Table 4-3  Use of Menu Bar Tools 4-15
Table 4-4  Use of Motif-Style Buttons 4-17
Table 4-5  Use of Sliders and Textual Tools 4-19
Table 6-1  Console Pulldown Menus 6-3
Table 6-2  Types of X Server Messages 6-7
Table 6-3  The Terminal Emulator File Menu 6-22
Table 6-4  The Terminal Emulator Options Menu 6-23
Table 6-5  The User Preferences File Menu 6-29
Table 6-6  Keyboard LED Functions 6-32
Table 6-7  Contents of the Show Version Window 6-48
Table 7-1  Window Manager Tools 7-9
Table 7-2  ncdwm Pointers 7-11
## Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7-3</td>
<td>Window Menu Items 7-14</td>
</tr>
<tr>
<td>7-4</td>
<td>Moving Windows: Use the Mouse and Title Bar 7-15</td>
</tr>
<tr>
<td>7-5</td>
<td>Raising or Lowering a Window: Use the Mouse 7-16</td>
</tr>
<tr>
<td>7-6</td>
<td>Lowering a Window: Use the Alt Key and Mouse 7-16</td>
</tr>
<tr>
<td>7-7</td>
<td>Changing Window Size: Use the Window Frame 7-17</td>
</tr>
<tr>
<td>7-8</td>
<td>Changing Window Size: Use the Maximize Button 7-17</td>
</tr>
<tr>
<td>7-9</td>
<td>Iconifying a Window: Use the Minimize Button 7-19</td>
</tr>
<tr>
<td>7-10</td>
<td>Iconifying a Window: Use the Alt Key and Mouse 7-19</td>
</tr>
<tr>
<td>7-11</td>
<td>Deiconifying a Window: Use the Mouse 7-20</td>
</tr>
<tr>
<td>7-12</td>
<td>Closing Windows: Use the Window Menu Button 7-20</td>
</tr>
<tr>
<td>8-1</td>
<td>Tasks for Your System Administrator 8-2</td>
</tr>
<tr>
<td>8-2</td>
<td>Modem Configuration Settings 8-9</td>
</tr>
<tr>
<td>8-3</td>
<td>Modem Messages When Attempting to Connect 8-10</td>
</tr>
<tr>
<td>8-4</td>
<td>Characteristics of Protocols Used With XRemote 8-12</td>
</tr>
<tr>
<td>9-1</td>
<td>Pointers in OpenWindows 9-4</td>
</tr>
<tr>
<td>9-2</td>
<td>OpenWindows Window Management Functions 9-6</td>
</tr>
<tr>
<td>9-3</td>
<td>Pointers in DECwindows Motif 9-16</td>
</tr>
</tbody>
</table>
1 A Quick Tour on an NCD X Terminal

Power On, Booting, and Logging In 1-2
   For More Information 1-4
Connecting to Hosts and Applications 1-5
   For More Information 1-8
Using Windows 1-9
   For More Information 1-15
Locking the Screen and Logging Out 1-16
   For More Information 1-17
1 A Quick Tour on an NCD X Terminal

This chapter is a short introduction to X on your NCD X terminal. Its purpose is to give you an idea of what it is like to use the X Window System on the terminal.

This chapter describes how a person might use an X terminal to write a memo. In the example, the X terminal is on a network that includes:

- Minicomputers, used primarily for data storage and retrieval
- Workstations, used to run software such as a word processing program

Your X software may not be the same as in the example, so it may function somewhat differently. Nonetheless, the example gives you an idea of what it’s like to use X on an NCD X terminal.

If you have questions about how your particular system differs from the examples included in this manual, refer to these sources for more information:

- NCDware 3.2 Advanced User’s Guide for UNIX Systems
- NCDware 3.2 Advanced User’s Guide for VMS Systems
- Your system administrator

To get more information about each of the functions introduced in this chapter, see “For More Information” at the end of each section.
The first thing the user—Sam, a sales manager for a nautical supplies manufacturer—does to start his $X$ session is to turn on his $X$ terminal. When he powers on the NCD $X$ terminal, it automatically boots.

**Note** Most users keep their terminals powered on. They simply log out when they leave their terminals for an extended period. Logging in when they return to the terminal bypasses the booting process.

Booting is the process of testing the $X$ terminal's memory and loading the $X$ software into the $X$ terminal. Sam can tell that the terminal is booting by the appearance of test results and other information that scrolls by on the display. It takes 20 seconds or so for his terminal to boot.

When booting is finished, the Console, labeled NCD User Services: Console, appears on the display with the Login Chooser. (See Figure 1-1.)

---

**Figure 1-1 X Terminal Display After Booting**
The Console provides a way of:

- Connecting to host computers and applications
- Customizing your working environment

We'll see some uses of the Console later in this chapter.

Some system administrators configure the software so that the Login Chooser appears after booting. Others set up the software to display an entirely different way to log in. We examine the different login methods in later chapters.

The Login Chooser lets Sam select a primary login host and start an X session on that host. Sam selects a login host by:

- Moving the mouse pointer to the host’s name
- Clicking the left mouse button to highlight the host’s name in the chooser list
- Clicking the OK button to confirm the selection

In the example, Sam wants to select Octopus as the host computer. (See Figure 1-2.)

Figure 1-2 The Login Chooser

Once Sam selects a login host, the Console disappears and a login banner appears. Now Sam is ready to log in and start work.

Logging in is the process of entering a name and a password so that the host computer can verify that a person has the right to use the computer.
A login banner contains prompts that show Sam where to enter his login name and password. (See Figure 1-3.)

![Login Banner](image)

**Figure 1-3  A Login Banner**

**For More Information**

For more information on powering on, booting, and logging in, see the sections in *Getting Started* that are listed in Table 1-1.

**Table 1-1  Powering On, Booting, and Logging In**

<table>
<thead>
<tr>
<th>For Information On</th>
<th>Look In</th>
</tr>
</thead>
<tbody>
<tr>
<td>Booting</td>
<td>“Booting” on page 5-3</td>
</tr>
<tr>
<td>Login chooser</td>
<td>“Login Chooser” on page 5-5</td>
</tr>
<tr>
<td>Login banner</td>
<td>“Login Banner” on page 5-6</td>
</tr>
<tr>
<td>Logging in</td>
<td>“Logging In” on page 5-4</td>
</tr>
<tr>
<td>Logging into a remote host</td>
<td>“Log Into the Host For PPP or SLIP” on page 8-15, “Log Into the Host For XRemote/Serial” on page 8-19</td>
</tr>
<tr>
<td>X software and hardware</td>
<td>“A Closer Look at X Software and Hardware” on page 2-8, “NCDware” on page 3-2</td>
</tr>
<tr>
<td>Console</td>
<td>“NCD User Services” on page 3-2 “The Console” on page 6-2</td>
</tr>
</tbody>
</table>
Connecting to Hosts and Applications

After entering his login name and password, the applications that the system administrator requested to start up automatically for Sam appear on the display. (See Figure 1-4.)

Figure 1-4 An X Display After Login

A custom program (such as a voice mail flag) and a terminal emulator started automatically. These programs are called clients. A client is a software application that is written especially to run with X.

A terminal emulator is a client that allows you to display a connection to a host in order to use programs that are not written especially for X when you are using an X terminal. A common
terminal emulator called xterm runs from a host and mimics the behavior of an ordinary VT102 terminal.

Another client, called a window manager, also started automatically. It controls aspects of the appearance and function of the windows in which the other applications appear. For example, the window manager is what gives you the outside borders on a window. (We’ll see how a window manager works in “Using Windows” on page 1-9.)

Sam needs to write a report using a program that runs on a different computer from the primary host to which he logged in. To start the program running on his X terminal, he clicks a mouse button to display a root menu. (See Figure 1-5.)

A root menu is a menu that appears when you place the mouse pointer on the root window (the background upon which the other windows appear) and click a mouse button. Often root menus are set up by the system administrator to list the most frequently needed applications (clients). When a user selects an item from the list in a root menu, the selection invokes the commands needed to connect the X terminal to the host computer and start the client on the X terminal.

Sam clicks on the Applications item in his root menu. A submenu appears with a list of applications. (See Figure 1-6.)
He selects a desktop publishing system, such as FrameMaker (owned by Frame Technology Corporation). The submenu disappears, and in a moment the application appears as a window on the X terminal display. (See Figure 1-7.)

Figure 1-7 Starting an Application
Connecting to Hosts and Applications

For More Information

For more information on connecting to hosts and applications, see the sections in Getting Started that are listed in Table 1-2.

Table 1-2 Connecting to Hosts and Applications

<table>
<thead>
<tr>
<th>For Information On</th>
<th>Look In</th>
</tr>
</thead>
<tbody>
<tr>
<td>X applications</td>
<td>“A Closer Look at X Software and Hardware” on page 2-8</td>
</tr>
<tr>
<td></td>
<td>“NCD User Services” on page 3-2</td>
</tr>
<tr>
<td></td>
<td>“Common X Clients” on page 3-7</td>
</tr>
<tr>
<td>Automatically starting X applications</td>
<td>“Startup File” on page 5-6</td>
</tr>
<tr>
<td>Terminal emulators</td>
<td>“Local Terminal Emulator” on page 3-5</td>
</tr>
<tr>
<td></td>
<td>“Terminal Emulators” on page 3-8</td>
</tr>
<tr>
<td>Connecting to hosts and applications</td>
<td>“Connecting to Hosts” on page 6-15</td>
</tr>
<tr>
<td></td>
<td>“Starting Clients” on page 7-4</td>
</tr>
<tr>
<td></td>
<td>“Using XRemote” on page 8-13</td>
</tr>
<tr>
<td>Window managers</td>
<td>“Window Managers” on page 2-12</td>
</tr>
<tr>
<td></td>
<td>“Local Window Manager and Companion Software” on page 3-4</td>
</tr>
<tr>
<td></td>
<td>Chapter 7, Using the NCD Local Window Manager</td>
</tr>
<tr>
<td>Root window and root menu</td>
<td>“Local Window Manager and Companion Software” on page 3-4</td>
</tr>
<tr>
<td></td>
<td>“Starting Clients” on page 7-4</td>
</tr>
</tbody>
</table>
Sam wants to use some information from an old memo in a report he is writing. To read the old memo, he can use the terminal emulator that started automatically when he logged in. The report Sam is writing is in a file he created using the FrameMaker application that he started with the root menu.

The NCD local window manager, called *ncdwm*, started automatically when Sam logged in. (The NCD window manager is called a *local* window manager when it runs on the NCD X terminal instead of on a host computer.) The window frames that appear around the application windows are a function of *ncdwm*. They give Sam control over the placement and size of the windows.

To read the old memo, Sam has to make the terminal emulator window the *active* window. The active window is the window that accepts keyboard and mouse input. The *ncdwm* software lets him select the active window by placing the mouse pointer on the window and clicking the left mouse button. The method of selecting the active window is called the *focus policy*.

The frame of the active window is a different shade from the other windows. In the example, the frame on the active terminal emulator window is darker than the frame around the FrameMaker application window. (See Figure 1-8.)
Now that the terminal emulator window is the active window, Sam can read the memo. He uses the terminal emulator just as he would an ordinary terminal connected to the host. In the example, the host is running the UNIX operating system, so Sam uses the UNIX *vi* editor to see the memo.

Sam finds the information he needs, so he opens the FrameMaker file that contains his report.
The part of the report displayed in the screen is too small for Sam’s purpose, so he uses the `ncdwm` window frame to make the window larger. First he clicks with the left mouse button in the report’s window to make it the active window. Then he places the pointer on a corner of the window frame called a resize handle. He drags the mouse while pressing with the left mouse button. As he does, an outline of the window appears and changes its size in proportion to the mouse’s movement. (See Figure 1-9.)

A small box also appears in the center of the display to indicate the size of the outlined window in units that are decided by the client, usually pixels or rows by columns.

---

**Figure 1-9 Enlarging a Window**
When the window outline is the size he wants, Sam releases the mouse button. The window immediately changes to the size of the outline and more of the report shows in the window.

Sam then decides he wants to compare the old memo against another one. He needs another terminal emulator to look at the second memo, so he displays the root menu again and selects the item xterm, which invokes the command to start another terminal emulator just like the one that appeared automatically when Sam logged in. (See Figure 1-10.)

Sam uses the vi editor again to view the file containing the second memo. The second terminal emulator overlaps the window.
containing the first memo, so Sam needs to move the windows to be able to compare the two.

To move a window, Sam places the pointer on the title bar running across the top of the window frame, presses the left mouse button, and drags the mouse. An outline of the window appears, moving in proportion to the movement of the mouse. (See Figure 1-11.)

A small box also appears in the center of the display indicating the location of the upper left corner of the outline.

Figure 1-11 Moving a Window
When the outline is where he wants the window to appear, Sam releases the mouse button. In this case, Sam moves the window so that it is partially off screen. The window immediately moves to the spot where the outline appeared.

After studying the windows, Sam decides he doesn’t need the information in the first memo after all, so he exits from the vi editor and closes the terminal emulator by double clicking on the Window menu button in the upper left corner of the window frame. (See Figure 1-12.)

![Figure 1-12 Using the Window Menu Button](image)

The window disappears.

Next Sam wants to copy a portion of the memo and paste it into the report. To do so, Sam:

- Presses and drags the left mouse button to highlight some text in the memo
- Clicks in the window containing the report to make it the active window
- Places the pointer where he wants the memo text to appear
- Clicks the middle mouse button to place the highlighted text into the report at the position of the pointer

Now that his report is complete, Sam saves the file.
For More Information

For more information on using X, see the sections in *Getting Started* that are listed in Table 1-3.

**Table 1-3 Using X**

<table>
<thead>
<tr>
<th>For Information On</th>
<th>Look In</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>ncdwm</em></td>
<td>“Local Window Manager and Companion Software” on page 3-4, Chapter 7, Using the NCD Local Window Manager</td>
</tr>
<tr>
<td>Active window</td>
<td>“Focus Policy” on page 4-9</td>
</tr>
<tr>
<td>Changing window size using <em>ncdwm</em></td>
<td>“Changing Window Size” on page 7-17</td>
</tr>
<tr>
<td><em>ncdwm</em> resize handles</td>
<td>“ncdwm Windows” on page 7-8</td>
</tr>
<tr>
<td>Moving windows using <em>ncdwm</em></td>
<td>“Moving Windows” on page 7-15</td>
</tr>
<tr>
<td>Copying and pasting text</td>
<td>“Copy and Paste Mechanism” on page 3-9</td>
</tr>
</tbody>
</table>
Locking the Screen and Logging Out

After saving and printing the report, Sam intends to leave his X terminal for a while. He doesn’t want to leave his terminal available for other users, yet he doesn’t want to have to log in all over again when he returns. He invokes a Lock Screen utility from the Console to secure the X terminal from use.

To display the Console, Sam presses the Setup key.

**Note** Some NCD keyboards do not have a Setup key. See Table 4-2 for equivalent key combinations.

From the Utilities menu in the menu bar, Sam selects the item Lock Screen. (See Figure 1-13.)

![Figure 1-13 The Console’s Utilities Menu](image)

The Lock Screen utility causes the screen to become blank except for a popup window that prompts him to enter a password, then to retype it a second time. (See Figure 1-14.)

![Figure 1-14 The Lock Screen Utility](image)
As Sam types the password, asterisks appear instead of the characters he types. After he types the password the second time, the box reappears prompting for the password again. Until Sam retypes the same password that he typed twice before, the X terminal display is locked and accepts no other input.

When Sam decides he wants to log out, he quits any applications that are still running to prevent any loss of data or hung processes on the host.

Next, Sam selects the Login menu from the Console. He clicks on the Logout item. A popup window appears asking him to confirm that he wants to log out. He clicks on Yes. The popup window disappears, all the clients that are still running disappear, and in a moment the Console and the Login Chooser reappear so that another X session can begin when required.

**For More Information**

For more information on pausing and logging out, see the sections in *Getting Started* that are listed in Table 1-4.

**Table 1-4 Pausing and Logging Out**

<table>
<thead>
<tr>
<th>For Information On</th>
<th>Look In</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock Screen</td>
<td>“Starting, Suspending, and Ending X Sessions” on page 6-8</td>
</tr>
<tr>
<td>Setup key</td>
<td>“The Console” on page 6-2</td>
</tr>
<tr>
<td>Console</td>
<td>“The Console” on page 6-2</td>
</tr>
<tr>
<td>Logging out</td>
<td>“Logging Out” on page 5-8&lt;br&gt;“Logging Out” on page 6-10&lt;br&gt;“Starting Clients” on page 7-4&lt;br&gt;“Ending an XRemote Session” on page 8-20</td>
</tr>
</tbody>
</table>
Locking the Screen and Logging Out
2 Introducing X Terminals and the X Window System

Network Computing  2-1
One Computer—Many Users  2-2
One Computer—One User  2-3
Network Computing—One Computer per Window  2-4
Network Computing in Practice  2-4
A Closer Look at X Software and Hardware  2-8
Characteristics of X  2-8
X Software Components  2-9
   Servers  2-10
   Clients  2-11
Window Managers  2-12
Communication Channels  2-14
X Hardware Devices  2-14
Your NCD X terminal and the X Window System offer you a simple way to use a variety of computers and application programs over a network. Depending on what is available on your network, your X terminal makes it easy for you to use different kinds of computers running on a variety of operating systems because the differences will not be apparent to you.

This chapter describes the history of the X Window System and defines the network structure that makes many computers accessible from your terminal.

**Network Computing**

You can best understand the advantage of using X and X terminals to access computers over a network (called network computing) by looking at how people used computers in the past.
One Computer—Many Users

During the 1960s, computer users usually shared resources, with each user accessing the processor serially in a computing model called batch processing. (See Figure 2-1.)

![Figure 2-1 Batch Processing Computing Model](image)

During the next decade, time-sharing—many users accessing the same processor simultaneously—became increasingly common. (See Figure 2-2.)

![Figure 2-2 Time-Share Computing Model](image)
One Computer—One User

With the invention of the microprocessor in the 80s, standalone computing—the use of a single processor for each user in the form of personal computers and workstations—solved much of the overcrowding on time-sharing systems. (See Figure 2-3.)

![Figure 2-3 Standalone Computing](image)

Local area network (LAN) technology increased the usefulness of standalone computing. In a computing model sometimes called work group computing, LANs allow users to share files and resources such as printers and file storage devices. (See Figure 2-4.)

![Figure 2-4 Work Group Computing](image)
Network Computing—One Computer per Window

The network computing architecture fostered by the X Window System takes the advantage of LAN computing and increases it by placing processing power, applications, and information wherever it is needed on the network. Network computing gives each X terminal user the power of any or all of the processors on the network. (See Figure 2-5.)

![Network Computing Model](image)

**Figure 2-5 Network Computing Model**

The X window system, running on hosts on a network and on X terminals, gives the X terminal user access to many applications running on computers anywhere on the network. As a result, users have the power of one computer per window.

Network Computing in Practice

Let’s look at what network computing is like in practice. We’ll use the perspective of Jill, a nursing administrator in a small research hospital.

The hospital’s network links all the departments. Included on the network are X terminals, printers, minicomputers, workstations, personal computers (PCs), and a supercomputer.
On her X terminal, Jill often runs applications from several of the computers. She can reach and use as many of these resources (Figure 2-6) as she wants:

- Database applications running on the minicomputer to review patients’ records and to maintain personnel files
- A word processing application running on a workstation to write reports and letters
- A financial reporting application to keep track of her department’s spending and plan the budget
- A database on the minicomputer to collect the data she’s using in her long-term research project
- A program on the supercomputer that she wrote to evaluate her research data
- Clock, calendar, and mail programs running on a workstation

![Figure 2-6 Network Access Via an X Terminal]
On the X terminal display, the output from each process (such as FrameMaker, owned by Frame Technology Corporation) that Jill accesses appears in a window, a discrete area of the display. (See Figure 2-7.)

Figure 2-7 An X Display

Windows can overlap each other. The border area (called a frame) around each window is provided by a client called a window manager. (As mentioned previously, client is the standard word for an application written especially for X.)
The frame has window management tools built into it, such as pulldown menus and toggle buttons. Jill, the nursing administrator, uses the tools to change windows' size, shape, and position. These tools may also provide ways to start and stop applications. (See Figure 2-8.)

Figure 2-8 A Window Manager’s Window Frame

Although the actual contents of each window varies with the application, the window’s size, shape, and location can always be adjusted in the same way.
In this section we’ll look more closely at the X system software and hardware that are involved in an X computing environment.

Characteristics of X

X gives the user many benefits, which are summarized in Table 2-1.

**Table 2-1 Characteristics of X**

<table>
<thead>
<tr>
<th>Benefit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distributed processing</td>
<td>The network’s processing power is distributed throughout the network as it is needed. You can access any computer on the network using the X terminal’s display, keyboard, and mouse.</td>
</tr>
<tr>
<td>Network transparency</td>
<td>The network is transparent. Regardless of where on the network your application resides, it appears to be running on your desktop instead of in another room or building.</td>
</tr>
<tr>
<td>Operating system independence</td>
<td>The operating system is independent of the X software. You can display applications from computers with different operating systems at the same time on your X terminal.</td>
</tr>
<tr>
<td>Computer host transparency</td>
<td>The type of computer host you are connected to is not apparent from your X terminal. Regardless of the computer host, the X software provides a consistent way to connect to it, start and stop applications, and manipulate windows.</td>
</tr>
<tr>
<td>Windows</td>
<td>Each application directs its output to a separate window on your display screen. The window manager software gives each of the windows a frame that you can manipulate with a mouse or keyboard to direct the application’s actions and change the appearance or location of the window.</td>
</tr>
</tbody>
</table>
**X Software Components**

The X computing environment achieves the characteristics listed in Table 2-1 via three components:

- X server software that controls the physical display and input devices (typically the mouse and the keyboard)
- X clients that request that the X server perform operations on windows
- Communication channels implemented in software and hardware that are used by the clients and X server to exchange data and instructions

Figure 2-9 illustrates the relationships among the three components of the X system.

![Figure 2-9 X System Components](image)

Because clients, X servers, and communications software are separate, they can exist on separate processors. This makes it possible for an X terminal—a display monitor and a processor dedicated to running the X server—to provide access to an unlimited array of hosts and applications over a network.
A Closer Look at X Software and Hardware

Servers

An X Server is one kind of server. A server refers to a program that provides services over the network. Some of the NCDware servers and the services they provide are:

- **X server**—connects X terminals to hosts or additional services in a local area network and controls the physical display and input devices (e.g., keyboard) on the user’s desktop.
- **Font Server**—provides convenient application access to fonts, including scalable fonts (described further in “Font Utilities” on page 3-6).
- **XRemote server**—runs X over a serial connection and is available on PROMs, PCMCIA cards, and downloaded from the host (described further in Chapter 8, Using the NCD XRemote Software).

The X server was developed at the Massachusetts Institute of Technology (MIT) in 1984. The most recent version, X11, was released in 1987. X11 is industry-standard windowing software.

X server software performs actions such as creating and removing windows and placing text and graphics in them for client programs that request them. Basic X server functions include:

- Allowing clients access to the display
- Interpreting network messages
- Passing user input to the appropriate clients
- Performing two-dimensional and three-dimensional drawing (graphics and text)
- Maintaining complex data structures such as windows, cursors, and fonts
Many of the services provided by the X server are organized in the Console that appears when you press the Setup key.

**Note**  Some NCD keyboards do not have a Setup key. See Table 4-2 for equivalent key combinations.

For example, when you want to connect to a host through a terminal emulator window, you open the Terminals menu in the Console and select New Terminal. The terminal host chooser appears on your screen displaying a list of the available hosts to connect to. If you want a Telnet session and you select an appropriate host, the X server requests a login connection to the selected Telnet host.

The X server provides other services without any explicit action on your part. For example, when an application needs to display a font, the X server requests the font from the Font Server.

**Clients**

Clients are X application programs that request the X server to perform actions on the X display. Clients can run on a remote machine across a network or they can run as local clients on the X terminal processors. A small part of the client program is dedicated to communication with the X server.

In addition to the X server software, most implementations of the X computing environment include programs to provide various utilities to the X system. Some examples are:

- Display managers, which manage login processing
- Terminal emulators, which allow you to run programs that do not have windowing capabilities
Window Managers

A window manager is a special client that controls the appearance and operation of the frame that surrounds the application windows. (See Figure 2-8.) By using the mouse or keyboard to manipulate the control devices available on the frame (such as scroll bars and toggle and selection buttons), the user controls the interaction and layout of the windows on the display. Often window managers supply a menu for starting new client applications.

Although the window manager dictates the appearance and utility of the frame surrounding the window, the application controls what appears inside the frame of the window through its requests to the X server.

Several different window managers may be available, but only one window manager can run on a display at a time.

NCD supplies a local window manager, ncdwm, that runs on the NCD X terminal with the X server. The local window manager is beneficial because its response is quicker than a host-based window manager. (The next chapters describe ncdwm and the concept of local clients, such as a local window manager, in detail.)

Other common window managers are listed in Table 2-2.
### Table 2-2 Common Window Managers

<table>
<thead>
<tr>
<th>Window Manager</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mwm</td>
<td>Included with the Open Software Foundation/Motif (OSF/Motif) X software. Similar to ncdwm.</td>
</tr>
<tr>
<td>olwm</td>
<td>Manages windows for OpenWindows using Sun Microsystem's OPEN LOOK graphical user interface.</td>
</tr>
<tr>
<td>DECwindows Motif</td>
<td>Based on OSF/Motif, it manages windows for DECwindows applications. Digital’s latest user interface for an X environment.</td>
</tr>
<tr>
<td>Window Manager</td>
<td></td>
</tr>
<tr>
<td>twm</td>
<td>Distributed by MIT with the standard X distribution.</td>
</tr>
</tbody>
</table>

For more information about using window managers, see Chapter 7, Using the NCD Local Window Manager, and Chapter 9, Common GUIs on NCD X Terminals.
A Closer Look at X Software and Hardware

**Communication Channels**

When the X server and clients converse across the network, they rely upon communication channels, the third component of the X system software.

Channels for communicating across computer networks are composed of software and hardware. The software and hardware are designed according to protocols (standard rules) for passing messages between different sorts of machines. Many layers of software and hardware protocols are used for a communications job, each one handling specific tasks involved in the communication process.

When using X terminals, the most commonly used protocols for governing the routing of requests around the network are Transmission Control Protocol/Internet Protocol (TCP/IP) and DECnet. The most commonly used protocol for the physical transport of the requests is the Ethernet 802.3 LAN, which can support a variety of physical cable types. TCP/IP can also be used over the Token-Ring 802.5 LAN.

**X Hardware Devices**

Implementations of the X Consortium’s X11 server typically run on workstations and on X terminals. Workstations run the X server software and clients on their own processor. X terminal processors are dedicated to running the X server software alone.

Display devices are available in various sizes and qualities.

NCD X terminals and NCD software are described in detail in the next chapter.
3 Introducing X with NCD

The NCD Family of X Terminals  3-1
NCDware  3-2

    The X Server  3-2
    NCD User Services  3-2
        Local Window Manager and Companion Software  3-4
        Local Terminal Emulator  3-5
        Font Utilities  3-6
        System Administration Utilities  3-6

Common X Clients  3-7
    Online Help  3-7
    Screen Dump Utilities  3-7
    Convenience Utilities  3-8
    Terminal Emulators  3-8
        VT102 (xterm)  3-8
        VT320 (ncdterm)  3-8
        3270  3-8
    Copy and Paste Mechanism  3-9
Network Connectivity 3-10
  LAN Connection 3-10
    Interface Board Requirements 3-10
    Communication Methods 3-11
  Serial Connection 3-11
  Parallel Connection 3-11
X-Compatible Software and Hardware 3-12
3 Introducing X with NCD

This chapter introduces NCD’s family of X terminals and X server software. If you want to know more about the details of your particular system, refer to these sources:

- *NCDware 3.2 Advanced User’s Guide for UNIX Systems*
- *NCDware 3.2 Advanced User’s Guide for VMS Systems*
- Your system administrator

The NCD Family of X Terminals

Your NCD X terminal is part of a family designed to offer a range of features. NCD X terminals usually include:

- A display monitor—receives the output from most applications and makes it visible to the user
- An X terminal base—contains the processors that run the NCD X server software
- A keyboard and mouse—the input devices for your X terminal (Usually your applications take their input from instructions and data that you pass to them through these devices.)
NCDware, the X server software provided with your NCD X terminal, is an implementation of the X Consortium’s X11R5 server that has been optimized for NCD hardware.

This section describes the NCD X server, client software, and networking software. It also includes information on how to find out about X-compatible application software available from other software vendors.

The X Server

NCD’s X server is available in the following methods:

- Downloaded from a host when you turn on your X terminal
- Downloaded from a PCMCIA card in your NCD X terminal base when you turn on your X terminal
- Installed as programmable read-only memory chips (PROMs) in your NCD X terminal base

Each server is optimized specifically for the intended hardware model, so you must use the server intended for your NCD X terminal model. NCD server optimizations enhance X’s performance on NCD hardware.

NCD User Services

X provides the basic components of a graphical window system. It is easiest to use, however, with the graphical user interface (GUI) that is included. A GUI is a set of applications and utilities that aid in the interaction between the user and the computer hardware and software. For example, a GUI can help in tasks such as setting up your system to your liking, managing the windows on the display, and connecting to hosts and applications.
NCD User Services is a major component of the NCDware GUI. They are a set of configuration and management tools that can be accessed through the Console that appears when you press the Setup key. (See Figure 3-1.)

Note Some NCD keyboards do not have a Setup key. See Table 4-2 for equivalent key combinations.

![Figure 3-1 The Console](image)

NCD User Services utilities can also be accessed through a remote configuration command language, used primarily by system administrators.

NCD User Services (the Console) provides access to a variety of NCD utilities that allow you and your system administrator to manage your X session, network access, and terminal environment, including:

- Customizing your environment
- Logging in and logging out
- Connecting to hosts and running applications
- Running NCD utility programs, including the local window manager
- Examining statistics that describe the performance of your terminal and the network

NCD User Services includes local clients that run on the NCD X terminal. They are introduced in the following sections and described in detail in Chapter 6, Using the NCD User Services and Chapter 7, Using the NCD Local Window Manager.
Local Window Manager and Companion Software

The NCD window manager *ncdwm* and the companion program *ncdrunwm* work together as window management and host/application startup utilities.

**Note** If your work environment includes NCD X terminals running NCDware released before version 3.2, *ncdrunwm* may invoke an older version of the companion program, *ncdlaunchd*. The functionality of *ncdlaunchd* is similar to that of *ncdrunwm*.

*ncdwm* provides the window frames used to change the size and location of windows. The local window manager looks and functions like the OSF/Motif window manager, but, unlike the Motif window manager, it can run directly on the NCD X terminal's processor instead of on a host computer on the network. (*ncdwm* can also run as a host-based client.)

A major benefit of a local window manager is that it responds more quickly than host-based window managers to window operation requests. In addition, it also allows you to use the NCD X terminal in non-X environments.

The companion program *ncdrunwm* runs on the host computer from which the X server is downloaded. *ncdrunwm* provides an easy way to connect to other hosts, applications, and clients through a root menu. The root menu is a menu that appears when you click a mouse button while the pointer is on the root window. (See Figure 3-2.)

```
Hosts  ->
Applications ->
Utilities  ->
Games  ->
Log Off  ->
```

**Figure 3-2 An Example of a Root Menu**

Your system administrator can set up the root menu to offer the items you need. “Starting Clients” on page 7-4 describes the default root menu and how to use it.
Local Terminal Emulator

The NCD local terminal emulator is a client that allows you to connect to a host and run non-X programs. The local terminal emulator runs on the local processor on your NCD X terminal, instead of running on a host computer. It is beneficial because it allows you to connect directly to non-X applications through windows that mimic the function and usage of a VT320 terminal, including support for color. The local terminal emulator can also reduce host processing and memory load.

You can have as many as 16 local terminal emulator windows open at once on your terminal, depending on available memory.

NCDware’s local terminal emulators connect to hosts using the protocols listed in Table 3-1.

Table 3-1 Protocols Used to Connect to Hosts

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TELNET</td>
<td>A Telnet connection using TCP/IP. TELNET is a simple remote terminal protocol.</td>
</tr>
<tr>
<td>LAT</td>
<td>A Local Area Transport (LAT) connection to a host providing LAT services. LAT is a Digital Equipment Corporation (DEC) communications protocol.</td>
</tr>
<tr>
<td>CTERM</td>
<td>A Command Terminal Protocol (CTerm) connection to a host using DECnet/NCDnet. (An NCD terminal requires a license and an NCDnet address to participate on a DECnet network.)</td>
</tr>
<tr>
<td>Serial</td>
<td>A local or remote serial connection to the NCD RS-232 C serial port. NCD X terminals have up to three serial ports, so up to three local serial clients (or dialer clients) can be open at once.</td>
</tr>
</tbody>
</table>

To use the local terminal emulator, see “Connecting to Hosts” on page 6-15 and “Using a Terminal Emulator Window” on page 6-20.
Font Utilities

X terminals are configured to download fonts from a host by default. NCDware includes utilities for converting fonts to formats that NCD X terminals can use.

"Font Options" on page 6-39 describes how to add fonts to and delete them from your X terminal’s font path.

The NCD Font Server, an enhanced version of the X11R5 font server designed and developed at NCD for the X Consortium, centralizes font management for all display types. It runs on any appropriate host on the network and provides scalable fonts so that the bitmaps for every font size do not need to be stored on the Font Server.


System Administration Utilities

NCDware includes a variety of utilities that simplify network administration through centralized management:

- Centralized configuration utilities
- Implementation of Simple Network Management Protocol (SNMP)
- Remote reset utility
- X Display Manager (XDM)

These NCD User Services’ features are designed for system administrators and advanced users.
Common X Clients

Many common X utility programs are part of the MIT X11 distribution and, consequently, are part of NCDware. This section introduces some of the common clients.

The clients described in this section are commonly available to users whose servers are downloaded from hosts running the UNIX operating system. If your servers are downloaded from a VMS host, check with your system administrator to find out which applications and utilities are available to you.

For additional information about standard X utilities, see the X guides listed in “Additional Documents” on page vii.

Online Help

The host-based xman program is a simple facility for access to system documentation, often called man pages (abbreviation for manual reader) in a UNIX environment.

In VMS environments, information on system commands is available through the VMS help facility and Bookreader files. Most of the NCDware 3.2 Advanced User’s Guide for VMS Systems and man pages on NCD clients are included in the Bookreader files.

Screen Dump Utilities

xwd is a host-based utility for copying the contents of the display screen into a file.

xwud is a utility for displaying the contents of a window dump file on the display.

xpr is a utility to format and print a file that was created with xwd. The DECwindows client uses a print screen utility.
Common X Clients

Convenience Utilities

Some standard host-based X utilities that provide a convenient work environment include:

- `xclock`—A clock utility that can appear as analog or digital
- `xcalc`—A calculator utility
- `xbiff`—A utility that displays a mailbox on which the highlighting changes and a flag goes up to announce new mail

The DECwindows client provides many of these utilities.

Terminal Emulators

NCDware allows you to use three terminal emulators.

**VT102 (xterm)**

The standard host-based X11 utility, called `xterm`, is a terminal emulator client available from MIT. It allows you to run application programs that are not X-compatible from a window on your NCD X terminal.

This utility is called `DECterm` in the DECwindows environment and `command tool/shell tool` in the OpenWindows environment.

The application program behaves as though it were a VT102 terminal, while the window provides additional utilities, such as a scroll bar and a copy/paste mechanism. Detailed information on `xterm` is included in the standard X references cited in “Additional Documents” on page vii.

**VT320 (ncdterm)**

A VT320 local terminal emulator allows you to run application programs that behave as though they were running on a VT320 terminal. Refer to “Using a Terminal Emulator Window” on page 6-20 for detailed information about this terminal emulator.

**3270**

A 3270 local terminal emulator allows you to run application programs that behave as though they were running on a 3270
terminal. Only the -3s X server includes support for the 3270 local terminal emulator. Refer to *Using the 3270 Terminal Emulator* for detailed information about this terminal emulator.

**Copy and Paste Mechanism**

X software provides a mechanism that is implemented in many X application programs for copying/pasting text between windows. The exact usage varies from application to application, but most work as follows:

1. Press and drag the left mouse button to highlight text. This action is based on the position of the pointer, which follows the mouse’s movement, not the position of the cursor.

2. Click the right mouse button to extend the highlighted portion to another pointer location.

3. Click the middle mouse button to paste a copy of the highlighted text at the position of the cursor, not the pointer.
Network Connectivity

NCD X terminals provide multi-vendor connectivity via Ethernet, Token-Ring, and serial network communications interfaces. A sample network is illustrated in Figure 3-3.

![Figure 3-3 Multi-Vendor Connectivity](image)

LAN Connection

Local area network (LAN) connections for specific NCD X terminals vary, depending on which interface board you have.

**Interface Board Requirements**

- If you have a Communications Interface Module, your X terminal uses a thin Ethernet connector, a twisted-pair Ethernet connector, or an Attachment Unit Interface (AUI) connector.
- If you have an ESP (Ethernet/Serial/PCMCIA) board, your X terminal uses an Attachment Unit Interface (AUI) connector, and two additional serial ports.
Network Connectivity

- If you have a TRP (Token-Ring/PCMCIA) board, your X terminal uses a DE 9-pin connector with a Type 1 cable or an RJ-45 connector with a Type 3 cable.
- If you have an ECX terminal, your terminal uses a twisted-pair Ethernet connector or an Attachment Unit Interface (AUI) connector, and two serial ports.

Communication Methods

NCD X terminals can communicate over a LAN in various ways:

- Over Ethernet using TCP/IP or DECnet/NCDnet protocols. TCP/IP and DECnet can be used concurrently.
- Over Ethernet using the LAT protocol, typically supported by DEC hosts.
- Over Token-Ring using TCP/IP.
- Over RS-232 C cables connected to the serial port using XRemote/TCP or XRemote/Serial.
- Using Network File System (NFS) for booting, file access, fonts, configuration, and diagnostics.

Serial Connection

NCD X terminals can have up to three serial ports with an RS-232 C connector. The ports are used for:

- Local or remote serial connections
- XRemote, the X server optimized for serial connection. For information about XRemote, see Chapter 8, Using the NCD XRemote Software.
- A printer or any serial input/output device

Parallel Connection

ECX terminals include an industry-standard Centronics-compatible parallel port. The parallel port supports output only. For this release, you can attach a printer to an ECX terminal’s parallel port, but you cannot attach other parallel devices (such as floppy drives, CD-ROM drives, or SCSI converters). The other
parallel devices require special host software that is not currently available.

X-Compatible Software and Hardware

Many familiar software applications are available in X-compatible versions and the range of compatible programs is expanding. NCD publishes the EXPORT Catalog, which has a:

- Comprehensive list of currently available applications that were either written for or optimized for X systems. The list includes these categories:

  - Accounting
  - Applications system
  - Artificial intelligence
  - Civil engineering
  - Connectivity
  - Database
  - Earth resources
  - Electronic engineering
  - Electronic publishing
  - Finance
  - Image processing
  - Inquiry management
  - Manufacturing
  - Mathematics and statistics
  - Mechanical engineering
  - Network management
  - Office automation
  - Project management
  - Software engineering
  - System software
  - User interface
  - Vertical applications

- List of X hardware products that work with UNIX systems
- Bibliography of X-related publications
4 NCD X Terminal Interface Basics

Using the Mouse 4-2
  Guiding the Mouse 4-3
  The Pointer 4-3
  Controlling Pointer Motion 4-4
  Mouse Actions 4-4
  Mouse-Button Mapping 4-5

Using the Keyboard 4-5
  Keyboard Groups 4-6
  Security Keyboard 4-6
  Configuring the Keyboard 4-6
  Keyboard Input Keys 4-7
  Using the Setup Key 4-8

Using Windows Management Tools 4-8
  Focus Policy 4-9
  Closing an X Window 4-10
  Using Windows with Window Managers 4-11
    Adjusting Position 4-12
    Adjusting Size and Shape 4-12
    Iconifying and Deiconifying 4-13
Using Motif-Style Graphical Tools  4-14
   Menu Bar Tools  4-14
   Button Tools  4-16
   Slider and Textual Tools  4-18
This chapter describes the tools that are common to most NCD X terminal users:

- The mouse (or trackball)
- The keyboard
- Window management tools
- Motif-style graphical tools

If you want to know more about how your particular system has been or needs to be set up, refer to these sources:

- NCDware 3.2 Advanced User’s Guide for UNIX Systems
- NCDware 3.2 Advanced User’s Guide for VMS Systems
- Your system administrator
Using the Mouse

This section describes basic mouse usage. The mouse is a way for you to pass information to your applications. (See Figure 4-1.) The window controls and menus that you manipulate with the mouse vary with the window manager, but the mouse actions are essentially the same.

![Mouse]

**Figure 4-1 Mouse**

**Note** You can use a trackball instead of a mouse. (See Figure 4-2.) A trackball is similar to a mouse, except that the device remains stationary while you use the top-side buttons and ball to pass information to the X server.

![Trackball]

**Figure 4-2 Trackball**
Using the Mouse

Use the mouse to:

- Select the window displaying the client that is to receive your input
- Manipulate different sorts of window control tools on window frames

The mouse is a small, two- or three-button device that you guide along a smooth surface (preferably a mouse pad). The mouse is connected by a cable to the base of your NCD X terminal. Movements of the mouse along the surface and pressure on the buttons on top of the mouse pass to the X server for processing.

Guiding the Mouse

To use the mouse, try this exercise:

1. Place your hand over the mouse, with the cord pointing away from you.
2. Glide the mouse over the surface. As you move the mouse, a pointer on your display screen moves proportionally.
3. Lift the mouse off the surface. Notice that this does not affect the location of the pointer. Replace the mouse on the surface.
4. If you run out of room on the surface when moving the mouse, lift the mouse and replace it to finish your move.

The Pointer

The pointer is a graphical representation of the location on the display screen to which you are sending input. The appearance of the pointer varies with the type of window manager you are using and the location of the pointer on the screen.

For example, if you are using ncdwm, when you perform operations with windows such as selecting an active window, the pointer is shaped like an arrow. But when you place the pointer on the root window, it is an X shape.

For more information about pointers, see “ncdwm Pointers” on page 7-11 and “Components of the OpenWindows GUI” on page 9-4.
Using the Mouse

Controlling Pointer Motion

The Console's Change User Preferences item (accessed from the Console’s Setup menu) includes a utility to enable you to increase the speed at which the pointer moves across the screen relative to the motion of the mouse. This is useful if you are using a large display screen and need to move the mouse across large portions of it. For more information about changing mouse speed, see “Pointing Devices Options” on page 6-34.

Mouse Actions

Table 4-1 describes commonly used mouse actions.

Note The button you activate depends on what you want to do and which client or window manager you are using.

Table 4-1 Mouse Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Specifies an area of the display screen to receive input.</td>
<td>Move the mouse so that the pointer is on the area you want to affect and quickly press and release a mouse button.</td>
</tr>
<tr>
<td>Double Click</td>
<td>Specifies an area on which an action is to apply or applies an action.</td>
<td>Click twice quickly on a mouse button.</td>
</tr>
<tr>
<td>Press</td>
<td>Used for some operations, such as selecting from pulldown menus.</td>
<td>Press on a mouse button and hold it down briefly before releasing it. (Press is also used to describe keyboard activity, as in “Press the F1 key.”)</td>
</tr>
<tr>
<td>Drag</td>
<td>Used for some operations, such as highlighting some text or moving a window.</td>
<td>Press on the mouse button, and while holding the button down, move the mouse. Release the button to complete the action.</td>
</tr>
<tr>
<td>Release</td>
<td>Completes a mouse action.</td>
<td>Remove your finger from the depressed mouse button.</td>
</tr>
</tbody>
</table>
Mouse-Button Mapping

The standard mapping of the three-button mouse is:

- Left button (also called physical button 1) as logical button 1
- Middle button (also called physical button 2) as logical button 2
- Right button (also called physical button 3) as logical button 3

This mapping is preferred by right-handed people.

The Console’s Change User Preferences item (accessed from the Setup menu) includes a utility that you can use to change the logical mapping of the mouse-button functions. For more information about changing mouse-button mapping, see "Pointing Devices Options" on page 6-34.

Note All references to mouse buttons in this document assume that the default (right-handed, three-button) mouse mapping is in effect. Left-handed mapping is the reverse of the default: the left button is logical button 3, the middle button is logical button 2, and the right button is logical button 1.

Using the Keyboard

This section describes basic keyboard usage. The keyboard is one device that you can use to pass instructions and data to your applications. (See Figure 4-3.)

Figure 4-3 Keyboard
Using the Keyboard

Keyboard Groups

NCD offers five different groups of keyboards:

- N-97/N-Kana—97-key UNIX-style keyboards in English and Japanese Kana
- N-101/N-102—101-key IBM PS/2-style keyboards in English, European, and Japanese Kana languages
- N-107—107-key Sun Type 4-Compatible keyboards in English
- N-108/N-108LK—108-key DEC-Compatible (VT220-style) keyboards in English and European languages
- N-122—122-key 3270-Compatible keyboards in English
- N-123—123-key Sun Type 5-Compatible keyboards in English

Security Keyboard

An optional security keyboard allows system administrators to control use of some commands and utilities.

Configuring the Keyboard

When you boot your NCD X terminal, the X server automatically recognizes which group your keyboard belongs to. However, it does not automatically determine the model of keyboard in the group unless you are using the default, which is the US model. If you are using either a non-US model or a model that is not NCD PS/2-compatible, your system administrator configures the keyboard by identifying the model for the X server.

You can reassign some key functions and keyboard LED functions, or assign functions to user-defined function keys. See “Keyboard Options” on page 6-31 for more information.
Keyboard Input Keys

Keyboards are divided into several distinct groups of keys:

- The main area contains the alphanumeric keys, punctuation keys, and keys that control special functions like Shift or Enter.
- Across the top, above the main area, a series of function keys may appear.
- In addition there may be a numeric/application keypad, cursor (arrow) keys, and edit keys.

NCD keyboard layouts are illustrated in *NCDware 3.2 Reference Manual*.

In general, if you type a key, the input is the character that appears on the key's legend (the symbol printed on the keycap).

Most keycaps have just one alphabetic character on them. Pressing such a key produces a lowercase character. Pressing the key with the Shift key depressed produces the same character in uppercase.

Some keycaps have two legends per key. Pressing the key by itself results in the character shown in the bottom legend. Pressing the key while the Shift key is depressed results in the character shown in the upper legend.

Some keyboards include keys with three legends per key. The third character is produced using the combination of Alt/Graph and the key. (Alt/Graph is the label on the right Alt key on some European-style keyboards.)

On the N-107 Sun Type 4-Compatible keyboard, users can access the third and fourth legends by pressing Alt/Graph + *key* and Alt/Graph + Shift + *key*, respectively.
Using Windows Management Tools

Using the Setup Key

Most NCD keyboards have a Setup key that you use to access the Console. However, for the keyboards that do not include a Setup key, see Table 4-2 for equivalent key combinations.

Table 4-2 Setup Key Equivalent Combinations

<table>
<thead>
<tr>
<th>Keyboard</th>
<th>Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>N-107 Sun Type 4-Compatible</td>
<td>Press Alt/Graph and Help/Setup simultaneously. (These keys have blue letters.)</td>
</tr>
<tr>
<td>N-108LK</td>
<td>Press Alt and F3 simultaneously.</td>
</tr>
<tr>
<td>N-122 3270-Compatible</td>
<td>Press Alt and the key-pad’s / simultaneously.</td>
</tr>
</tbody>
</table>

If you would like to specify an alternative key combination to use instead of the Setup key, change the Console Key Sequence field as instructed in “Console and Utilities Options” on page 6-44.

Using Windows Management Tools

Windows are areas of the display screen to which a specific client’s input and output are directed. Windows are defined by frames, usually rectangular, that are characteristic to the type of window manager you are using. (One client that is not rectangular is oclock, a clock program that appears as a round-faced clock.)

The background display on which windows appear is called the root window, or the background window. The windows displayed on the root window are called children of the root window. When the pointer is on the root window, it appears as an X.
Focus Policy

Window managers provide a mechanism to select, or focus on, a specific window for input. Two basic types of selection are click-to-focus and pointer focus. Click-to-focus requires that you place the mouse pointer on the window to which you want your input directed, then click a mouse button to focus the input there. A variation of click-to-focus is called explicit focus. Explicit focus is just like click-to-focus, except in that a newly opened window is not automatically the active window.

Pointer focus allows you to shift focus from one window to another simply by moving the mouse pointer (without clicking) to the desired client window. However, to bring the window to the front, you must click on the border of the window.

When you direct focus to a window, it becomes the active window. ncdwm indicates which window is active by the shading or color of the window frame. If you are using a monochrome monitor, the active window frame is a different shade than the others.
(See Figure 4-4, in which the active window is indicated by the darker window frame.)

Figure 4-4 Window Manager Indicating the Active Window

Like ncdwm, most window managers provide both focus methods so that you can choose the one you prefer. With ncdwm, click-to-focus is the default method. If you want a different focus method than the one you currently have, ask your system administrator to change it.

Closing an X Window

When you close an X window, the client exits unless it is running in more than one window. To close a window, most window managers allow you to:

- Double click on a window frame button
- Select the Close item from a window menu
Using Windows with Window Managers

This section is a general description of the purpose of window managers. For detailed descriptions of how to use specific window managers, see the description of *ncdwm* in Chapter 7, Using the NCD Local Window Manager, and descriptions of four other window managers in Chapter 9, Common GUIs on NCD X Terminals.

The basic components of window managers are window frame tools used for:

- Displaying client input and output
- Starting and stopping clients
- Changing the size of windows on the display
- Changing the location of windows on the display

Many window managers also provide menu and keyboard methods for accomplishing the same operations as the window frame tools do.
Using Windows Management Tools

Adjusting Position

Using window manager tools, you can arrange windows hierarchically on your display screen, so that they overlay one another and portions of all but the top in a stack are covered by the others. Or you can display them side by side, with each showing entirely.

Window managers provide ways to change both the windows’ placement on the display and their position within a hierarchy. (You can send the top one lower, or to the bottom, or bring a lower one higher, or to the top.) Choose whatever arrangement suits your work habits best, as you do on your own conventional desktop.

Adjusting Size and Shape

Window managers also provide ways to alter the size and shape of windows. With ncdwm, for example, you change the size of a window by dragging the mouse pointer from any one of eight sections of the window frame (the four corners and the four sides, called resize handles) until the frame is the size you desire. The outline of the window follows the movement of the pointer as you drag, showing how the window size and shape is changing. (Some applications may not let you change window size; they will return the window to its original size.)
Iconifying and Deiconifying

When you open a window, a small, rectangular representation of it (called an icon) appears as well. Icons are stacked in a special window called an icon box.

Window managers allow you to move a window (or client) off the root window without closing it. This process is called iconifying a window. When a window is iconified, the client does not stop, but you cannot direct input to it or see the output anymore.

A window that is on the root window, is called deiconified. The window manager provides a mechanism for restoring an iconified window to its larger, deiconified form.

The icon that represents an iconified window appears three-dimensional, whereas the icon of a deiconified window appears flat (Figure 4-6).

Methods of iconifying and deiconifying windows are presented in “Iconifying Windows” on page 7-18 and “Deiconifying Windows” on page 7-20.

![Figure 4-6 Iconified and Deiconified Windows](image)
Using Motif-Style Graphical Tools

This section describes the graphical tools that appear in clients written to follow OSF/Motif style and usage.

The Console, the NCD utility for access to NCD User Services, uses OSF/Motif-style graphical tools. This section uses the Console to illustrate the tools.

Menu Bar Tools

Motif-style menu bar tools are illustrated by the Console features in Figure 4-7.

Figure 4-7 Menu Bar and Related Tools
Table 4-3 summarizes the use of Motif menu bar tools. (See Figure 4-7.)

Table 4-3 Use of Menu Bar Tools

<table>
<thead>
<tr>
<th>Graphical Tool</th>
<th>Description</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Bar</td>
<td>The strip across the top of the window that contains menu buttons.</td>
<td>Click on a button on the menu bar to access clients' main menus.</td>
</tr>
<tr>
<td>Menu Button</td>
<td>A menu name that appears on a menu bar.</td>
<td>Display a menu beneath a menu button by clicking on a menu button with a mouse button.</td>
</tr>
<tr>
<td>Menu or Pulldown Menu</td>
<td>A list of items that appears when you click on a menu button or an option button (see Table 4-4). If a menu item is followed by an ellipsis (…) on its right side, selecting it displays a popup window.</td>
<td>Select an item from the list by clicking on it or by dragging to it and releasing. Make a menu disappear without selecting an item by moving the pointer so that it is off the menu and clicking.</td>
</tr>
<tr>
<td>Popup Window or Dialog Box</td>
<td>A window that appears on the display screen when you click on a menu item that has an ellipsis following it.</td>
<td>Read the information displayed in the popup window or enter information in the text entry fields of the dialog box.</td>
</tr>
</tbody>
</table>
Using Motif-Style Graphical Tools

Button Tools

Several kinds of button-type graphical tools (see Figure 4-8) are used in popup windows (also called dialog boxes).

![Figure 4-8 Motif-Style Buttons in Popup Windows](image-url)

4-16 NCD X Terminal Interface Basics
The purposes and usage of the Motif-style buttons are summarized in Table 4-4.

**Table 4-4 Use of Motif-Style Buttons**

<table>
<thead>
<tr>
<th>Graphical Tool</th>
<th>Description</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button</td>
<td>A rectangular box.</td>
<td>Click on a button to invoke the action specified on the button.</td>
</tr>
<tr>
<td>Toggle Button</td>
<td>A square box to the left of a line of descriptive text.</td>
<td>Click on a toggle button when you want to turn it on—the button turns solid. Click on the toggle button when you want to turn it off—the button becomes an outline.</td>
</tr>
<tr>
<td>Hide Button</td>
<td>A toggle button used to open or close a hide box.</td>
<td>Click on a hide button when you want to reveal its contents—the button turns solid and the contents are revealed. Click on the hide button when you want to hide its contents—the button becomes an outline and the contents are hidden.</td>
</tr>
<tr>
<td>Radio Buttons</td>
<td>Diamond-shaped buttons that appear in a row next to text describing choices you must make. The choice that each button represents is listed above it.</td>
<td>Click on one of the radio buttons to select a limited number of choices among a larger number of options. A previously selected button is deactivated automatically if more than the permitted number of selections would result.</td>
</tr>
<tr>
<td>Option Button</td>
<td>A rectangular button, labeled with its purpose, that has a smaller rectangular dash to the right of the label.</td>
<td>Click on the option button to display a submenu from which you can make a selection by clicking.</td>
</tr>
</tbody>
</table>
Other graphical tools used in Motif-style applications include sliders to select numerical input and text fields and displays. (See Figure 4-9.)

Figure 4-9 Slider and Textual Tools
Using Motif-Style Graphical Tools

Table 4-5 summarizes the purpose and usage of the slider and textual tools. (See Figure 4-9.)

**Table 4-5 Use of Sliders and Textual Tools**

<table>
<thead>
<tr>
<th>Graphical Tool</th>
<th>Description</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>A line of unselectable text in a variable-width font.</td>
<td>Read a label to get information.</td>
</tr>
<tr>
<td>Slider</td>
<td>A rectangular area with a numerical value to its left. Inside the rectangular area is a slider bar that moves as you drag the pointer on it.</td>
<td>Drag the slider bar to change the numerical value displayed next to it in proportion to the movement. Click at either end of the slider to increase the value by one.</td>
</tr>
<tr>
<td>Scroll Bar</td>
<td>A bar that appears along the side or bottom of a List or Text display area. Between the arrows is a slider.</td>
<td>Click with the left mouse button on the stepper arrows of a side scroll bar to scroll through text one line at a time. Press and hold the left mouse button on the stepper arrows to scroll continuously through the text one line at a time. Click with the left mouse button above or below the slider bar to scroll forward or backward one window at a time. Click on the slider bar and drag the slider to scroll through the text. Use the scroll bars along the bottom of text similarly to enable you to see portions of text that are hidden.</td>
</tr>
<tr>
<td>Text Entry</td>
<td>A line of editable text shown in a fixed-width font.</td>
<td>Click in the text entry field, and enter text.</td>
</tr>
</tbody>
</table>
## Using Motif-Style Graphical Tools

### Table 4-5 Use of Sliders and Textual Tools

<table>
<thead>
<tr>
<th>Graphical Tool</th>
<th>Description</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Display</td>
<td>Uneditable text that appears in a fixed-width font. It is computer output.</td>
<td>Read the computer output to get current (or historical) information.</td>
</tr>
<tr>
<td>Hide Box</td>
<td>A rectangular box with a line of text in the upper left corner and a hide button to open and close the hide box.</td>
<td>Click on a hide button when you want to reveal the hide box contents—the button turns solid and the contents are revealed. Click on the hide button when you want to hide the hide box contents—the button becomes an outline and the contents are hidden.</td>
</tr>
<tr>
<td>List</td>
<td>Text lines that usually appear in a variable-width font.</td>
<td>Click on a text line in a list to highlight it.</td>
</tr>
</tbody>
</table>
5 Starting and Ending an X Session

Assumptions 5-2
Powering Up 5-2
Booting 5-3
Logging In 5-4
  Login Chooser 5-5
  Login Banner 5-6
  Startup File 5-6
Logging Out 5-8
  Login Menu 5-8
  Root Menu 5-8
5 Starting and Ending an X Session

This chapter describes how to log in and log out of an X session from an NCD X terminal.

If you want to know more about how your particular system has been or needs to be set up, refer to these sources:

- NCDware 3.2 Advanced User’s Guide for UNIX Systems
- NCDware 3.2 Advanced User’s Guide for VMS Systems
- Your system administrator
- Terminal installation sheet
Assumptions

For you to use the procedures and applications described in this and subsequent chapters, a system administrator must perform the following preliminary steps to set up your NCD X terminal:

- Assemble the terminal
- Install the NCD X server software and fonts on the host
- Install the terminal onto the network
- Configure an X Display Manager (XDM)
- Configure a window manager
- Configure the local terminal emulators

This chapter assumes that you are familiar with the applications you are going to use and with the host operating systems if you are using terminal emulators.

Powering Up

If your NCD X terminal has been set up as described in “Assumptions” on page 5-2, it automatically boots when you turn the power on.

The power switch is in different locations on different NCD X terminal models. Ask your system administrator or see the terminal installation sheet if you do not know where your terminal’s power switch is located.

Note: This description assumes that you are running XDM. There are many X display managers, so the one you are using may not be described here.
Booting

Booting is the process of running power-on diagnostic tests, and loading and executing the X server. These tests verify that the terminal processors’ memory is functioning and place the X server software into memory.

The boot process is performed by PROMs in the terminal base. When the boot process starts, the Boot Monitor PROM version number appears at the top left corner of the display screen, followed by the memory test results. The boot process takes approximately 20 or 30 seconds, depending on how your system is configured.

Output such as the following, including test results and related messages, appears on the display screen as the terminal boots. (This is just a sample; the exact output depends on your software and hardware configuration.)

Boot Monitor V 2.6.0
Testing available memory 8.0 MB
Network controller passed 00:00:A7:11:46:52
TFTP load <ESC> to abort
Searching for IP address...

For additional information about booting and using the Boot Monitor, refer to the NCDware 3.2 Reference Manual.
Logging In

When the boot process is completed, an X-shaped cursor appears on the display screen until it is replaced by a small, watch-shaped cursor. Then the Console and a Login Chooser popup window appear on the display. (See Figure 5-1.)

**Figure 5-1 The X Display After Booting**

**Note** The Console is not accessible until booting is complete. By default, the Console and the Login Chooser appear on the screen after booting. Your system administrator may have configured your software to function differently. For example, you may see a login banner or a terminal emulator window instead of a Login Chooser.
Login Chooser

The Console is a primary way of connecting to host computers and applications and accessing NCD User Services. “The Console” on page 6-2 describes it in detail.

The Login Chooser popup window allows you to choose a primary host computer for your X session and log into the host. The window lists the hosts accessible to you that provide X service.

1. To choose a host from the Default Hosts list, click the left mouse button on the name of the host you want.
   The list is scrollable; if the host you want is not visible, click the left mouse button on the scroll bar’s stepper arrow to display more host options.
   Notice that when you click on a host in the Default Hosts list, its name appears in the Host text entry box. The Network and Type are also automatically inserted.
   You can also request a host by typing its name in the Host text entry box below the list.

2. To establish a connection, click with a mouse button on the OK button at the bottom of the Login Chooser. The X server connects to the host you selected. For most systems, XDM software displays a login banner. (See Figure 5-2.)
   If the host you selected is not available, a message appears in the Message text display box.
   — To abort the request, click on the Abort button.
   — To recheck which hosts are available on the network, click on the Restart button.
   — To cancel the login selection process and close the Login Chooser, click on Cancel.

Note  XDM is invisible to VMS users in the DECwindows environment. For more relevant information, refer to Chapter 9, Common GUIs on NCD X Terminals.
Logging In

Login Banner

You must log into the host just as you would if you were working on any other kind of terminal. By logging in, you identify yourself to the XDM software and the primary host can verify that you are an authorized user.

Login procedures vary, depending on how your system administrator has customized the software. Most login procedures provide a login banner (Figure 5-2) that prompts you to:

1. At the Login prompt (Login:), type your username (also called a login name) and press the Return key.
2. At the Password prompt (Password:), type your password and press the Return key. Your password does not appear on the screen.

Welcome to Octopus

Login: |
Password: |

Figure 5-2 An XDM Login Banner

Startup File

After you’ve logged in, XDM looks into a startup file in your home directory. The startup file, which your system administrator creates, lists clients that XDM starts automatically each time you begin an X session. The name of your startup file (or files) depends on which software you are using and how system administration configured your system.
Logging In

For users whose primary host is running the UNIX operating system, one such startup file is called a .xsession file. For users whose primary host is running the VMS operating system, the startup file might be LOGIN.COM and/or DECWSXDEFAULTS.DAT.

After accessing your startup file, XDM starts the window manager and clients that are listed in your startup file. These might include, for example, ncdwm, ncdrunwm, an xterm terminal emulator, and voice mail flag. (See Figure 5-3.)

**Figure 5-3 Typical Display After Login**

When you see a screen similar to that in Figure 5-3, the X server is running, the X session has started, and the X terminal is ready to provide access to the hosts and clients.
Logging Out

Like the procedures for logging in, logout procedures also depend on the software running on your system and how your system administrator has customized your environment.

Login Menu

The Console’s Login menu has a Logout item you can use to log out. (Using the Console to start and end sessions is described in more detail in “Starting, Suspending, and Ending X Sessions” on page 6-8.)

Root Menu

Your system administrator might configure a root menu for you to use for accessing hosts and applications and for logging out. Display root menus by clicking a mouse button while the X cursor is on the root (background) window. (The root window is described in more detail in “Using Windows Management Tools” on page 4-8.) Your system administrator determines which root menus appear when you click each mouse button.

To log out from a root menu:

1. Place the pointer on the root window.
2. Click a mouse button. (Your system administrator determines which mouse button provides the root menu.)
3. Place the pointer on the Logout item, and click the left mouse button.

When you log out, a cautionary popup window appears for you to confirm that you wish to log out. After clicking on Yes, your X session is completed and, assuming the default startup configuration, the Console and Login Chooser appear again, ready to begin another X session.
6 Using the NCD User Services

The Console 6-2
   Using the Setup Key 6-2
   Accessing the Menus 6-2
   Displaying X Server Messages 6-6
      Console Messages Hide Box 6-6
      X Server Messages 6-7
      Font Messages 6-7
Starting, Suspending, and Ending X Sessions 6-8
   Logging In 6-8
   Locking the Screen 6-8
   Setting Automatic Lock Screen 6-9
   Logging Out 6-10
   Setting Automatic Logout 6-11
   Rebooting 6-12
Starting the Local Window Manager 6-13
Connecting to Hosts 6-15
   Opening a Terminal Host Chooser 6-15
      Selecting New LAT 6-16
      Selecting New Serial or New Dialer 6-16
Console and Utilities Options  6-44
Audio Options  6-45
Saving User Preference Changes  6-46
Getting System Information  6-47
  Show Version  6-47
  Show Memory  6-50
  Show X Connections  6-51
  Show Statistics  6-52
6 Using the NCD User Services

NCD User Services is the set of utilities provided with NCDware to simplify NCD X terminal use and management.

This chapter does not describe the advanced user and system administration utilities available through the Console. For information about advanced utilities, refer to the NCDware 3.2 Reference Manual.

Be sure you know what you are doing before you change any settings or parameters, especially those that are not described in Getting Started. Your changes may have unexpected, undesirable results!

If you want to know more about how your particular system has been or needs to be set up, refer to these sources:

- NCDware 3.2 Advanced User’s Guide for UNIX Systems
- NCDware 3.2 Advanced User’s Guide for VMS Systems
- Your system administrator
The Console

NCD User Services utilities are accessed through a window titled NCD User Services: Console. (See Figure 6-1.) We call this the Console.

![Figure 6-1 The Console](image)

Using the Setup Key

Your system administrator may have set up your terminal to display the Console automatically after booting.

If the Console doesn’t appear when you boot:

- Display it by pressing the Setup key. For the keyboards that do not include a Setup key, see Table 4-2 for equivalent key combinations.
- Hide it by pressing the Setup key again. The Setup key acts as a toggle.

Accessing the Menus

The Console’s menu bar contains the menu buttons that you can click on to display the main menus.

The main menus on the menu bar of the Console offer a variety of clients, utilities, and configuration parameters. Table 6-1 summarizes the tools available through each menu. The following section describes how to use many of them.

Your system administrator can control the items that are available from your Console menus. For example, if you do not need to perform system maintenance, you do not need access to system administration utilities.
Most users have partial menu access, which allows them to use the menus described in this section. Partial access may also include access to menu items that are not described in this section. Menu items to which you do not have access may appear grayed out.

Table 6-1 Console Pulldown Menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Purpose</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Console</strong></td>
<td>Provides tools to set options related to the terminal and Console use, including utilities that:</td>
<td>If you have not installed optional software and hardware, some items in the Console menu appear grayed out and cannot be selected.</td>
</tr>
<tr>
<td></td>
<td>❑ Delete all output from the message area in the Console</td>
<td></td>
</tr>
<tr>
<td></td>
<td>❑ Recall messages that were cleared from the Console message area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>❑ Cancel persistent font requests to the NCD Font Server (if installed)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>❑ Stop the bell ringing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>❑ Cancel a serial connection</td>
<td></td>
</tr>
<tr>
<td></td>
<td>❑ Reboot the X server</td>
<td></td>
</tr>
<tr>
<td></td>
<td>❑ Close (hide) the Console</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Offers utilities for logging in and logging out.</td>
<td></td>
</tr>
<tr>
<td><strong>Login</strong></td>
<td>Offers access to the local client terminal emulators through Login Choosers for each type of host connection.</td>
<td>The Minimal X server does not include the New Dialer local client.</td>
</tr>
<tr>
<td><strong>Terminals</strong></td>
<td>Offers access to the local client terminal emulators through Login Choosers for each type of host connection.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If an NCDnet address is not assigned, the New CTerm option appears grayed out and cannot be selected.</td>
<td></td>
</tr>
</tbody>
</table>
## Table 6-1 Console Pulldown Menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Purpose</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>WindowMgr</td>
<td>Provides a utility to start and stop the <code>nctwm</code> or <code>mwm</code> local window managers.</td>
<td>The Minimal X server does not include the Motif Window Manager (<code>mwm</code>) local client. <code>mwm</code> is available only with the <code>mwm</code> or DPS/<code>mwm</code> server. <code>mwm</code> requires a license.</td>
</tr>
<tr>
<td>NCD Window Manager...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Motif Window Manager..</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Utilities</td>
<td>Provides tools for:</td>
<td>The Minimal X server does not include the Test Network local client.</td>
</tr>
<tr>
<td>Refresh Screen</td>
<td>- Redrawing the screen</td>
<td></td>
</tr>
<tr>
<td>Blank Screen</td>
<td>- Invoking the screen saver</td>
<td></td>
</tr>
<tr>
<td>Lock Screen</td>
<td>- Locking the screen to prevent unauthorized usage</td>
<td></td>
</tr>
<tr>
<td>Rescan Font Path</td>
<td>- Rescanning the font path</td>
<td></td>
</tr>
<tr>
<td>Test Network...</td>
<td>- Testing network access</td>
<td></td>
</tr>
<tr>
<td>Setup</td>
<td>Provides tools to define many X terminal and network parameters.</td>
<td></td>
</tr>
<tr>
<td>Change Quick Setup...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Setup Parameters...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change User Preferences...</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

These tools are primarily used by advanced users and system administrators. Your system administrator may limit access to some of the advanced Setup menu tools. The tools you will probably use most often are accessed through the Change User Preferences item, which allows you to customize your work environment. Refer to “Changing User Preferences” on page 6-27 for details on this item.
Table 6-1  Console Pulldown Menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Purpose</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statistics</td>
<td>Offers utilities you can use to get information about your X terminal,</td>
<td>The Minimal X server does not include the local clients Show Memory,</td>
</tr>
<tr>
<td>Show Memory</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show X Connections</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Statistics</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Displaying X Server Messages

A process in the X server monitors the X server’s activities and issues messages about what is going on. The messages are collected and stored in an internal buffer and displayed in the Console Messages hide box.

Console Messages Hide Box

Below the menu bar is the Console Messages hide box. To access the Console messages:

- Click on the Console Messages hide button to open the Console’s message area. (See Figure 6-2.)
- Resize the Console to display as much message area as you need.

![Figure 6-2 The Console with Messages](image)

- Adjust the Console message area’s scroll bars to redisplay output that has scrolled by and no longer fits in the message area.
- Click again on the Console Messages hide button to close the Console’s message area.

Note  Once you’ve opened the Console Messages hide box, the message area remains open—even if you remove the Console from the display and then redisplay it—until you click on the hide button again to close it.
**X Server Messages**

The Console’s message area displays X server messages, such as codes and descriptions identifying errors, in four categories (see Table 6-2).

**Table 6-2 Types of X Server Messages**

<table>
<thead>
<tr>
<th>Category</th>
<th>Sample Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Informational</td>
<td>%CONFIGD-I-IPADDR, IP address for this unit: 192.43.154.123</td>
</tr>
<tr>
<td>Warning</td>
<td>%CONFIGD-W-BADPASSWD, incorrect password entered</td>
</tr>
<tr>
<td>Error</td>
<td>%CONFIGD-E-GATEWAYBADNET, gateway 89.0.0.1 is not on local net</td>
</tr>
<tr>
<td>Fatal</td>
<td>%CONFIGD-F-INITUI, unable to initialize user interface</td>
</tr>
</tbody>
</table>

**Note** The *NCDware 3.2 Reference Manual* provides a list of X server messages with instructions for how to respond to the message.

**Font Messages**

You can also get font diagnostic information in the message area by requesting extended font diagnostics. Font diagnostics include information about where the X server is looking for font directories and where it finds them.

Do not request extended font diagnostics unless you are troubleshooting font problems. The additional diagnostic output can be extensive, obscuring important system messages.

To request extended font diagnostics from the Console:

1. Open the Fonts hide box (Console ⇒ Setup ⇒ Change User Preferences ⇒ Fonts).
2. Click on the Show Extended Font Diagnostics toggle button.
3. Click on the Apply button.
Starting, Suspending, and Ending X Sessions

This section describes how to use the Console to start, suspend, and end X sessions.

The Login menu and the Terminals menu provide access to tools for starting and ending X sessions. The Utilities menu provides tools for suspending an X session. Depending on your software and hardware configuration, you may have additional methods available. Ask your system administrator about them.

Logging In

“Logging In” on page 5-4 described logging in using the Login Chooser popup window that appears automatically after booting.

If you find that the Login Chooser does not appear automatically after the terminal boots, you can display it manually:

1. Click on the Login menu button on the Console.
2. Click on the Login New X Session item.
3. Select a host and log in as described in “Login Chooser” on page 5-5.

You can also log into a host by starting a local client terminal emulator, as described in “Connecting to Hosts” on page 6-15.

Locking the Screen

If you want to ensure that no one can access your display, but you don’t want to end your X session, temporarily suspend the session by locking the display screen so that it cannot be used:

1. Click on the Utilities menu on the Console menu.
2. Click on the Lock Screen item. The screen blanks, and the Console displays a popup window that prompts you for a password. (See Figure 6-3.)
3. Type a password.
4. Press the Return key or click on OK.
5. Type the password a second time, as you are prompted by the display. The display states "Screen Locked."

![Lock Screen Popup Window](image)

**Figure 6-3 The Lock Screen Popup Window**

To unlock the screen and resume your X session:
1. Type the password into the popup window.
2. Press the Return key or click on OK.

**Setting Automatic Lock Screen**

You can set your terminal to lock the screen automatically if you leave it idle for a specified period.

1. Click on the Setup menu button.
2. Click on the Change User Preferences item.
3. Click on the Console and Utilities hide box.
4. In the Automatic Lock Screen After text entry field, enter how many minutes of inactivity you want to allow before the screen automatically locks.
5. In the Lock Screen Default Password text entry field, enter the password you want to use to unlock the screen after the screen automatically locks. An asterisk appears for every character you type.
6. Click on the Apply button. The Lock Screen Default Password text entry field changes to 15 asterisks to disguise the length of your password.

When you leave the terminal idle for the specified number of minutes, a popup window appears, offering you the opportunity to unlock the screen.
Starting, Suspending, and Ending X Sessions

**Note** Unless you ask your system administrator to save your changes, they are reset to the default settings when you log out or boot the terminal. (See “Saving User Preference Changes” on page 6-46.)

To unlock the screen and resume your X session:

1. Type the password into the popup window.
2. Press the Return key or click on OK.

**Logging Out**

To log out:

1. Click on the Login menu button.
2. Click on the Logout item.
3. A popup window appears asking you to confirm that you want to halt the session. (See Figure 6-4.)
   - Click on Yes to log out. The X session ends, the display blanks, then the Console and the Login Chooser appear. You can start another session by choosing a host and logging in again.
   - Click on No to abort the logout process. The current X session resumes.
   - Click on Show to display the Show Connections popup window, which lists the current X connections (local and host-based clients and applications).

**Note** You can access the Show Connections popup window at any time during an X session by selecting the Show X Connections item from the Console’s Statistics menu. (The Show Connections window is not available with the Minimal X server.)
Setting Automatic Logout

You can configure your X server to log out automatically after a specified period of inactivity. Set up the automatic logout facility as follows:

1. Click on the Setup menu button.
2. Click on the Change User Preferences item.
3. Click on the Console and Utilities hide box.
4. In the Automatic Logout After text entry field, enter how many minutes of inactivity you want to allow before the session automatically logs out.
5. In the Automatic Logout Cancel Delay text entry field, enter the number of seconds of delay you want to allow for canceling the automatic logout.
6. Click on the Apply button.

When you leave the terminal idle for the specified number of minutes, a popup window appears, offering you the opportunity to cancel the logout.

— Click on No to stop the logout.
— Click on Yes to confirm the logout. This is the default action.
— Click on Show to get a list of the current clients.

Note  Unless you ask your system administrator to save your changes, they are reset to the default settings when you log out or boot the terminal. (See “Saving User Preference Changes” on page 6-46.)
Rebooting

If you need to reboot your X terminal:

1. Click on the Console menu button.
2. Click on the Reboot item. A popup window appears, prompting you to confirm that you want to boot the terminal.
   - Click OK to confirm. The display becomes blank, then the boot process begins shutting down all of the clients.
   - Click Cancel to abort the reboot request and resume the current X session.
Starting the Local Window Manager

This section describes how to use the Console to start *ncdwm*, the local window manager.

Once you’ve logged in, you may want to start a window manager if it did not start automatically. When no window manager is running (Figure 6-5), the hierarchy, location, size, and focus of a window are not changeable, and the X display looks like this:

- All windows are deiconified
- The icon box does not appear
- Title bars do not appear
- Window frames are thin lines with no built-in tools

![Figure 6-5 An X Display Without a Window Manager](image)
Starting the Local Window Manager

To start *ncdwm*, the local window manager:

1. Click on the WindowMgr menu button.
2. Click on the NCD Window Manager toggle button. The *ncdwm* window manager starts and the characteristic frames appear around all clients except for clients like xphone, which system administration configured to come up without frames. (See Figure 6-6.)

![Figure 6-6 An X Display with ncdwm Running](image)

Any clients that you start while the window manager is running have window manager window frames, unless your system administrator has configured them otherwise.

For information about using *ncdwm*, see Chapter 7, Using the NCD Local Window Manager.
Connecting to Hosts

This section describes how to use the Console to connect to hosts. If you have enough memory in your terminal, you can display up to 16 terminal emulator windows at the same time.

The Serial or Dialer connection is used primarily for connecting to a host via a modem. For information about using a modem with your X terminal, see Chapter 8, Using the NCD XRemote Software.

Your Terminal Host Chooser may list local services (Config, Diag, and File) that you do not need. These are used primarily by system administration.

Opening a Terminal Host Chooser

To log into a host by a Telnet, LAT, CTerm, or serial connection, first you must open a Terminal Host Chooser, as instructed in this section. (See Figure 6-7.)

![Figure 6-7 The Terminal Host Chooser](image)

**Note**  
CTerm requires an NCDnet license and address.
Connecting to Hosts

1. Click on the Terminals menu button.
2. Click on an item in the Terminals menu.
   - If you want to display all possible host connections on your network, including Telnet, LAT, CTerm, and serial, select the New Terminals item. A Terminal Host Chooser appears with a list of default host connections available on your network.
   - If you want to display only a certain kind of host connection, select one of the other items—New Telnet, New LAT, New CTerm, New Serial, or New Dialer. Normally, a Terminal Host Chooser appears with a list of default host connections available on your network.

Another way to display the Terminal Host Chooser is by selecting the Start Terminal item in the default ncdwm root menu. This method is described in “Starting Clients” on page 7-4.

Selecting New LAT

When you select New LAT or New Terminal, only one line appears in the Terminal Host Chooser for each LAT service, even if the service is available on more than one host. The host connection represented by that line is selected to balance the current load on the hosts offering the service.

However, you can display all nodes offering a particular service by selecting that service and then clicking the Show Node List button, as instructed in “Selecting a Host From the Terminal Host Chooser” on page 6-17.

Selecting New Serial or New Dialer

When you select New Serial or New Dialer and your terminal has only one serial port, a serial terminal emulator window appears. If this is the case, the remainder of the “Connecting to Hosts” procedure does not apply to you. Go to “Using a Terminal Emulator Window” on page 6-20.

If the serial port is not configured for terminal emulation (Console ⇒ Setup ⇒ Change Setup Parameters ⇒ Serial ⇒ Serial Interfaces Table ⇒ Port Use at Boot ⇒ terminal), and you select
New Serial or New Dialer, an error message appears in the Console messages hide box, and the attempt to connect aborts.

**Selecting a Host From the Terminal Host Chooser**

One or more hosts may appear in the Terminal Host Chooser.

1. Select a host using the following methods:
   - If the name of the host you want appears in the Default Hosts list, click on it.
   - If it is not in the Default Hosts list, type the hostname or address of the host you want into the Host text entry field.
   - To update the list of available network hosts, click on the Update button.
   - To sort the Default Hosts list by name or by network, use the Sort menu on the Terminal Host Chooser's menu bar.
   - To select the types of connections to display, use the View menu.

2. If you want LAT service, you can *either* allow LAT to select a default LAT host node offering the service you want:
   - Click on a LAT item that appears in the Terminal Host Chooser. The Host: field changes to Service: and the words *Node (optional)* and *Port (optional)* appear under the field as reminders that you can specify the node and port as well as the service name.

   *or* specify a particular LAT host node offering the service you want:
   a. Click on a LAT item that appears in the Terminal Host Chooser.
   b. Click on the Show Node List toggle button to see a list of all hosts offering that service.
   c. Click on a LAT node. The *Host*: field changes to *Service*: and the words *Node (optional)* and *Port (optional)* appear under the field as reminders that you can specify the node and port as well as the service name.
   d. Click on the OK button.
e. Click on the Show Node List toggle button again if you want to return to the listing of all available LAT services.

3. Verify that the correct network appears on the Net option button.
   a. If the wrong network appears on the Net option button, click on the button to display your options.
   b. Click on the name of the network you want to use.

4. If a Password text entry field appears on the Terminal Host Chooser, click in the field and type your password.

5. Click OK to invoke the connection you have specified. (See the example Telnet client in Figure 6-8.)
   — The Terminal Host Chooser disappears.
   — The terminal emulator window appears.
   — A host login prompt appears.

![Figure 6-8 A Telnet Terminal Emulator Window](image)
Logging Into a Host

Log into your selected host as follows:

1. Type your login name and your password as you are prompted by the host.

2. If you want to start an X client from the terminal emulator window (rather than from the root menu), you may need to set your DISPLAY variable to correctly direct process output to your X terminal display.

In the following commands, `display` is the TCP/IP address or TCP/IP name (such as 192.43.154.205 or mar335) of the X terminal

— If you are logged into a UNIX host, at the prompt type one of these commands:

%% `setenv DISPLAY display:0` (for C shell)

%% `$ DISPLAY=display:0; export DISPLAY` (for Bourne shell)

— If your primary host is a VMS system, use the SET DISPLAY command to set your terminal’s display:

%% `$ SET DISPLAY /CREATE/NODE=display/TRANSPORT=TCP/IP/SERVER=0`

— If you do not know your terminal’s TCP/IP address or TCP/IP name, see the Show Version popup window (explained in “Show Version” on page 6-47).
Using a Terminal Emulator Window

This section describes the VT320 terminal emulator features accessible from the terminal emulator window.

**Note**  The VT320 terminal emulator, including command-line options and resource usage, is described in detail in the *ncdterm* (1) man page in the NCDware 3.2 Reference Manual.

Once you've logged into a host as described in “Connecting to Hosts” on page 6-15, the terminal emulator window displays the VT320 terminal emulator window (See Figure 6-9).

![Figure 6-9 A VT320 Terminal Emulator Window](image)

**Terminal Emulator Features**

The VT320 terminal emulator offers the same characteristics as traditional terminals. Like a traditional terminal, you can display 24 or 25 lines of text in 80 or 132 columns, but you can also resize the window to display fewer or more rows (changing the height) or columns (changing the width).
The VT320 terminal emulator also provides additional features not found on traditional terminals, including:

- Rectangular cut and paste mechanism
- Scroll bar
- Menu bar

**Rectangular Cut and Paste Mechanism**

You can select, cut, and paste arbitrary rectangular sections of text in a terminal emulator window. This is useful if you want to copy a column of listed information.

- To start the rectangular selection, press Shift and the left mouse button. The cursor changes to a plus sign (+).
- To extend the selection, press the right mouse button (without the Shift key). The cursor again changes to a plus sign in the corner of the selection nearest the cursor, allowing you to extend the selection.
- To paste the selection, place the pointer where you want the text, and press the middle mouse button.

Ask your system administrator if you need to change the way each line in a rectangular selection ends. The default method inserts a carriage return followed by a line feed.

**Scroll Bar**

Use the scroll bar on the side of the terminal emulator window to review information that has passed out of viewing range during your terminal emulator session. (See Figure 6-9.) The Motif-style scroll bar is described in Table 4-5.

**Menu Bar**

Several menus are accessible from the terminal emulator’s menu bar: File, Options, Fonts, Cursors. The Dialer client includes an additional Communications menu.
Using a Terminal Emulator Window

Note  A solid toggle button indicates that an option is turned on. An outlined toggle button indicates that an option is turned off.

File Menu
Table 6-3 summarizes the action of each item in the File menu.

Table 6-3 The Terminal Emulator File Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Redraw</td>
<td>Redraws the contents of the display window.</td>
</tr>
<tr>
<td>Soft Reset</td>
<td>Resets the terminal to the default state.</td>
</tr>
<tr>
<td>Hard Reset</td>
<td>Does a soft reset, deletes all content, clears selection.</td>
</tr>
<tr>
<td>Close Connection</td>
<td>Closes the current session. In addition, for a serial session resets</td>
</tr>
<tr>
<td></td>
<td>the serial connection to terminal mode.</td>
</tr>
<tr>
<td>Start Debugging Log</td>
<td>Writes the contents of the session to a log file. This function</td>
</tr>
<tr>
<td></td>
<td>requires special set up to execute correctly. For more information,</td>
</tr>
<tr>
<td></td>
<td>see the <code>ncdterm (1)</code> man page in the <code>NCDware 3.2 Reference Manual</code>.</td>
</tr>
<tr>
<td>Print on Serial Line 1</td>
<td>Defines where a job will be printed.</td>
</tr>
<tr>
<td>Print on Serial Line 2</td>
<td>Each available option includes a toggle button. Only one toggle button can be selected at a time.</td>
</tr>
<tr>
<td>Print on Serial Line 3</td>
<td>If there is no ESP board, this option is grayed out.</td>
</tr>
<tr>
<td>Print on Remote Unit</td>
<td>If the associated resources are undefined, this option is grayed out.</td>
</tr>
<tr>
<td>Print on Parallel Line</td>
<td>If your terminal does not support a parallel port, this option is grayed out.</td>
</tr>
<tr>
<td>Print Screen</td>
<td>Prints the contents of the display window.</td>
</tr>
</tbody>
</table>
## Table 6-3 The Terminal Emulator File Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Log Buffer</td>
<td>Prints the contents of the log buffer (the input and output you can see by scrolling). Printing starts at the top visible line through the end of the buffer.</td>
</tr>
<tr>
<td>Send Break</td>
<td>Sends a break across the connection. Some modems require this before they can release the connection.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits from the session. For the Dialer and Serial clients only, this item leaves the connection in its current state.</td>
</tr>
</tbody>
</table>

### Options Menu

The Options menu offers a variety of terminal mode settings. Table 6-4 summarizes the Options menu modes.

## Table 6-4 The Terminal Emulator Options Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jump Scroll</td>
<td>Enables the terminal emulator to add lines to the screen quickly.</td>
</tr>
<tr>
<td>Reverse Video</td>
<td>Reverses the display's foreground and background characteristics (for example, if your X terminal is displaying dark characters on a light background, reverse video displays light characters on a dark background).</td>
</tr>
<tr>
<td>Visual Bell</td>
<td>Specifies that flashing is used instead of an audible bell.</td>
</tr>
<tr>
<td>Auto Wraparound</td>
<td>Specifies that the character typed after the cursor reaches the right border of the page automatically appears on the next line. By default, autowrap is active. If autowrap is turned off, that character replaces the character at the end of the line.</td>
</tr>
</tbody>
</table>
### Table 6-4 The Terminal Emulator Options Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reverse Wraparound</td>
<td>Allows the cursor to wrap from the leftmost column on the line to the rightmost column of the previous line, thereby allowing you to backspace to the previous line.</td>
</tr>
<tr>
<td>Auto Linefeed</td>
<td>Generates a linefeed automatically. For use with programs that generate carriage returns without dropping down a line on the screen.</td>
</tr>
<tr>
<td>Application Cursor Mode</td>
<td>Generates ANSI escape sequences rather than standard cursor movements when you use arrow keys.</td>
</tr>
<tr>
<td>Application Keypad Mode</td>
<td>Generates control functions rather than numeric characters when you use the keypad.</td>
</tr>
<tr>
<td>Local Flow Control</td>
<td>Provides quicker response to flow control characters (such as Control-S). If disabled, flow control characters are passed to the host.</td>
</tr>
<tr>
<td>Allow 80/132 Switching</td>
<td>Permits (by default) or does not permit the application running in the terminal emulator window to display in the 132-column format as needed.</td>
</tr>
<tr>
<td>80/132 Font Switching</td>
<td>Permits (by default) or does not permit the application running in the terminal emulator window to display output in a condensed font when the 132-column format is in use.</td>
</tr>
<tr>
<td>Clear Screen with Blanks</td>
<td>Clears the screen by inserting a screenful of blank lines. Saves the previous display but uses more of the scrolling buffer. If disabled, clears the screen by erasing what is visible in the window.</td>
</tr>
<tr>
<td>Curses Emulation</td>
<td>Emulates a bug in the UNIX curses screen-handling package.</td>
</tr>
</tbody>
</table>
Using a Terminal Emulator Window

Table 6-4 The Terminal Emulator Options Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Margin Bell</td>
<td>Rings a bell when the cursor reaches the margin.</td>
</tr>
<tr>
<td>Strip Parity</td>
<td>Strips parity bit from any data sent from the host so that the terminal emulator looks only at 7-bit bytes. The default is false for all but the Dialer client, which defaults to true.</td>
</tr>
<tr>
<td>Grab Keyboard Input</td>
<td>Directs all keyboard input to the terminal emulator window. Prevents another user from intercepting your input.</td>
</tr>
<tr>
<td>ISO Latin 1 Font</td>
<td>Enables use of the ISO Latin Alphabet supplemental character set, which includes letters with accents and diacritical marks required in many European languages.</td>
</tr>
<tr>
<td>Blink Cursor</td>
<td>Specifies whether the cursor should blink.</td>
</tr>
<tr>
<td>Visible Status Line</td>
<td>Displays a 25th line at the bottom of the window, used by applications to display status information.</td>
</tr>
<tr>
<td>Log Output To File</td>
<td>Logs output to the file opened under the File menu. If no file is available for output logging, the item is grayed out in the Options menu.</td>
</tr>
</tbody>
</table>

Fonts Menu
The Fonts menu allows you to change the terminal emulator’s display font. The choices are:

- Default (14 point)
- Small (10.5 point)
- Large (14 point)
- Jumbo (18 point)

The font you choose for a terminal emulator window is important. It controls the size of the characters you see as well as whether
Using a Terminal Emulator Window

certain terminal emulation features appear to work. As a rule, if you do not know which font to choose, use the default font.

To change the font size:

1. Click on the Fonts menu in the terminal emulator window.
2. Click on the toggle button of the size you prefer. The window size changes automatically to accommodate the new font size.

Note: Changing the font size results in a resized window, but changing the window size through the window manager does not result in a change of font size.

Cursors Menu
The Cursors menu allows you to change the terminal emulator’s cursor by selecting one of the descriptions in the menu. The choices are:

- Solid Block
- Hollow Block
- Underline
- Bright Underline
- Hatched
- Bright Hatched
- Diagonal Lines
- Framed
- Invisible

Communications Menu
The Communications Menu appears only in the Dialer client (used for XRemote) as a convenience in converting the connection to SLIP mode and in stopping PPP/SLIP. Without the Communications menu, you have to go through the Setup client (Console => Setup => Change Setup Parameters) to stop PPP/SLIP. If your XRemote session hangs, you can select Serial from the Communications menu to return to the original Terminal mode.

The Communications Menu includes the following list of items. Select only one at a time.

- PPP—Point-to-Point Protocol
- SLIP—Serial Line Internet Protocol
- XRemote—NCD’s software for running X over a serial connection
- Serial—regular terminal mode
Changing User Preferences

This section describes how to use the Console to customize your work environment.

The Setup menu’s Change User Preferences item offers utilities to customize many aspects of your work environment, including:

- Keyboard, such as the function of keyboard lights (LEDs)
- Color or shade of the display screen’s background
- Font path

Figure 6-10 shows the NCD User Services: User Preferences window.

**Note** The Power Management hide box appears only for NCD X terminals that are VESA-compliant. See “Power Management Options” on page 6-38.
Changing User Preferences

Figure 6-10 User Preferences Popup Window
Two main menus are accessible from the User Preferences window menu bar: File and Sections.

**File Menu**

Table 6-5 summarizes the action of each of the items in the File menu.

**Table 6-5 The User Preferences File Menu**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save to File</td>
<td>Saves all changes of the user preferences to a file with a complete pathname so that changes can be stored for longer than the current session. Refer to “Saving User Preference Changes” on page 6-46 and consult your system administrator.</td>
</tr>
<tr>
<td>Read from File</td>
<td>Allows you to read a file of previously saved values into the current User Preferences window.</td>
</tr>
<tr>
<td>Connect to New Unit</td>
<td>Accepts a password and connects you to a different terminal. For use by system administrators.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the User Preferences window.</td>
</tr>
</tbody>
</table>

**Sections Menu**

The Sections menu offers menu access to each major category in the User Preferences window. Use the Sections menu as follows:

- To open a specific section, click on the Sections menu and click on the section you want to open.
- To open all sections, click on the Sections menu and click on Show All.
- To hide (close) all sections, click on the Sections menu and click on Hide All.
Customize your work environment by using the User Preferences window. Specify your preferences as directed in the remainder of this section, then make one of the following choices:

— Click on the Apply button at the bottom of the window to apply your preferences to the current X session.

**Note** Even if you apply your changes properly, all changes will be lost when you log out or boot the terminal. To keep your changes beyond the current session, ask your system administrator for help. (See “Saving User Preference Changes” on page 6-46.)

— Click on the Defaults button to resume the default settings.
— Click on the Restart button on the bottom of the window if you want to go back to the previous configuration without applying your changes.
— Click on Cancel to abort the changes without applying them. The Change User Preferences window disappears.

As you redefine the user preferences, system messages related to your changes appear in the Console’s messages area on the bottom of the window.
Changing User Preferences

Keyboard Options

Click on the Keyboard hide button in the User Preferences window to display the Keyboard hide box. (See Figure 6-11.)

![Keyboard Preferences Table]

**Figure 6-11 Keyboard Preferences**

You can change the following keyboard features from the Keyboard hide box.

- Function-key mapping is either UNIX or VMS style.
  - The Function Key Style option button in the top right corner allows you to change the style of function-key mapping for your keyboard.
  - To change the function-key mapping, click on the Function Key Style option button and choose your style of key mapping.

- Keyboard autorepeat is a keyboard feature that causes continued repetition of a keystroke when you hold the key down.
  - Enable or disable keyboard autorepeat by clicking on the Enable Keyboard Autorepeat toggle button.
  - Drag the Autorepeat Begin After slider to specify how long (from 0 milliseconds [msec.] to 1,000 msecs.) a key must be held down before the autorepeat function takes effect. The value in milliseconds is displayed to the left of the slider.
  - Drag the Autorepeat Rate slider to specify the rate of keystroke repetition (from 2 repetitions per second to 30 repetitions per second).

- Keyclick volume is the volume of the sound that occurs when you press a keyboard key. You can specify Keyclick Volume as a percentage of the default volume.
Changing User Preferences

Drag the Keyclick Volume slider to change the percentage value.

Most NCD keyboards have LEDs. Change the LED usage using the LED radio button matrix.

The possible LED functions are listed in Table 6-6.

Table 6-6 Keyboard LED Functions

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1, X2, X3, X4</td>
<td>Undefined in NCDware; used by X clients. Lights the specified LED according to defined values.</td>
</tr>
<tr>
<td>Net</td>
<td>Lights the specified LED when the terminal receives network traffic.</td>
</tr>
<tr>
<td>Warn</td>
<td>Lights the specified LED when the terminal begins to run low on memory.</td>
</tr>
<tr>
<td>Ctrl</td>
<td>Lights the specified LED when the keyboard Ctrl key is pressed.</td>
</tr>
<tr>
<td>Shift</td>
<td>Lights the specified LED when the keyboard Shift key is pressed.</td>
</tr>
<tr>
<td>Caps</td>
<td>Lights the specified LED when the keyboard Caps Lock key is toggled on.</td>
</tr>
<tr>
<td>Num</td>
<td>Lights the specified LED when the keyboard Num Lock key is toggled on.</td>
</tr>
<tr>
<td>Mod1, Mod2, Mod3, Mod4, Mod5</td>
<td>User-defined in NCDware. Lights the specified LED when the keyboard Modn (Modifier) key is pressed. Mod keys are usually assigned to Alt, Ctrl, Shift, and Caps Lock, and Option keys. For more information about reassigning keys, see NCDware 3.2 Advanced User’s Guide for UNIX Systems or NCDware 3.2 Advanced User’s Guide for VMS Systems.</td>
</tr>
</tbody>
</table>
Bell Options

Click on the Bell hide button on the User Preferences window to display the Bell hide box. (See Figure 6-12.)

![Bell Options](image)

**Figure 6-12 Bell Preferences**

The bell audibly announces events (such as the arrival of new mail) or problems (such as an attempt to scroll past the end of a document).

Enable or disable the bell by clicking on the Enable Bell toggle button, which is by default enabled.

You can change the following bell features from the Bell hide box. When you change the bell setting values, it beeps at the new setting to let you know what it sounds like.

- Bell volume: drag the Bell Base Volume slider to adjust the percentage of the default bell volume.
- Bell pitch: drag the Bell Pitch slider to choose a pitch of between 0 hertz (Hz) and 3,000 Hz.
- Bell duration: drag the Bell Duration slider to adjust how long the bell sounds, from 0 msec. to 1,800 msec.
- Ring Bell: click on the Ring Bell button to test the bell sound without changing any values.
Changing User Preferences

Pointing Devices Options

Click on the Pointing Devices hide button in the User Preferences window to display the hide box for adjusting a mouse or a trackball. (See Figure 6-13.)

<table>
<thead>
<tr>
<th>Pointing Devices</th>
<th>Mouse</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold Distance (pixels)</td>
<td>1</td>
</tr>
<tr>
<td>Acceleration Ratio (percent)</td>
<td>300</td>
</tr>
<tr>
<td>Button Arrangement</td>
<td>Right-Handed</td>
</tr>
</tbody>
</table>

Figure 6-13 Pointing Devices Preferences

You can change the following features from the Pointing Devices hide box:

- Acceleration Ratio sets how quickly the pointer moves across the screen relative to the motion of your hand. The value used is a percentage that multiplies pointer motion. Increasing pointer speed is useful if you are using a large display screen and need to move the pointer across large portions of it quickly.

For example, if you set acceleration to 300 percent, then the pointer moves across 3 times the number of pixels that your pointing device covers in any motion.

To change the acceleration from the system default, drag the Acceleration Ratio slider to a new value.

- Setting the acceleration ratio higher than the default sometimes makes it difficult to accomplish fine movements with the mouse or trackball because the pointer moves too quickly across the display screen.

To alleviate this problem, drag the Threshold Distance slider to a new value (from 1 pixel to 20 pixels). Threshold Distance is the number of pixels over which the pointer moves at the default speed before the Acceleration value comes into effect.

For example, if you want to move the pointer at 8 pixel increments, you could set threshold at 12. Then while you move the pointer the 8 or so pixels for fine positioning, it moves at the slower default pace, allowing you to position the pointer carefully. When you move it more than 12 pixels, however, the
Changing User Preferences

Acceleration Ratio value takes effect and moves it across the screen 3 times more quickly than your hand’s motion. An example of a standard setting is Acceleration at 300 and Threshold at 1. These are the default values.

Button Arrangement: choose right-handed or left-handed mapping by clicking on the preferred setting in the Button Arrangement option button. (For information about standard and left-handed button mapping, see “Mouse-Button Mapping” on page 4-5.)
Changing User Preferences

Screen Background Options

Click on the Screen Background hide button in the User Preferences window to display the Screen Background hide box. (See Figure 6-14.)

<table>
<thead>
<tr>
<th>Screen Background Type</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td></td>
</tr>
<tr>
<td>Solid Color</td>
<td>#01B3c6</td>
</tr>
<tr>
<td>Bitmap File</td>
<td></td>
</tr>
<tr>
<td>Bitmap Foreground Color</td>
<td>black</td>
</tr>
<tr>
<td>Bitmap Background Color</td>
<td>white</td>
</tr>
</tbody>
</table>

Figure 6-14 Screen Background Preferences

You can change the screen background features from the Screen Background hide box. The screen backgrounds available to you depend on the type of NCD X terminal you are using and the software installed. Change your background as follows:

- To get a gray mesh pattern, click on the Default setting in the Screen Background Type option box.
- If you have an X terminal that supports color, click on the Solid Color setting in the Screen Background Type option box. Type the name of the color you want in the Solid Color text entry field. The color must be specified as in X’s predefined list of colors in:
  
  `/usr/lib/X11/ncd/rgb.txt` or `NCD_ROOT: [FONTS]RGB.TXT`

  You can also specify RGB levels directly using the hexadecimal `#rrggbb` notation.

- To display the contents of a bitmap file, click on the Bitmap setting in the Screen Background Type option box.
  Type the full pathname of the file in the Bitmap File text entry field. If the file is not found, ask your system administrator to mount the directory that stores the file to your X terminal.
  Choose bitmap background and foreground colors by specifying the colors as in X’s predefined list of colors in:

  `/usr/lib/X11/ncd/rgb.txt` or `NCD_ROOT: [FONTS]RGB.TXT`

  Type the background and foreground color specifications in the Bitmap Foreground Color and Bitmap Background Color text entry fields.
Screen Saver Options

Click on the Screen Saver hide button in the User Preferences window to display the Screen Saver hide box.

The screen saver utility displays a random pattern on the display screen after a specified number of seconds of screen inactivity. Screen savers prevent the burn-in effect that can occur if the same image remains on the screen for a very long time. (See Figure 6-15.)

---

**Figure 6-15 Screen Saver Preferences**

You can change the following screen saver features from the Screen Saver hide box:

- **Enable Screen Saver**: click on the toggle button to enable or disable the screen saver.
- **Allow Exposures After Screen Saver**: click on the toggle button to enable or disable this feature. If enabled, the X server discards the window contents while the screen saver is activated. The window contents must then be redrawn by the client when the display becomes active again.
- **Save Screen After**: drag the slider to specify a period of time (from 0 seconds to 3,000 seconds) that the display can remain inactive before the screen saver begins.
- **Change Screen Saver After**: drag the slider to specify a period of time (from 0 seconds to 3,000 seconds) before the screen saver changes the pattern to avoid burn-in.
- **Screen Saver Style**: specify the background to use by clicking on the preferred setting in the Screen Saver Style option box.
  - Blank displays a scattering of stars
  - X Logo displays an X-pattern that moves across the display
  - Bitmap displays a bitmap file to use. Type the name of the bitmap file into the Screen Saver Bitmap File text entry field. VMS users must type in the complete file pathname.
Changing User Preferences

Power Management Options

Click on the Power Management hide button in the User Preferences window to display the Power Management hide box. (See Figure 6-16.)

<table>
<thead>
<tr>
<th>Power Management</th>
<th>Enable VESA Monitor Power Management</th>
<th>Standby After (minutes)</th>
<th>Suspend After (minutes)</th>
<th>Powerdown After (minutes)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>20</td>
<td>40</td>
<td>60</td>
</tr>
</tbody>
</table>

Figure 6-16 Power Management Preferences

The U.S. EPA (Environmental Protection Agency) has instituted the Energy Star Computers program which promotes the use of energy-efficient equipment. Desktop computers, monitors, and printers purchased by the federal government must comply with the guidelines set forth in this program. To meet the EPA’s Energy Star requirements, computer equipment must enter a low-power state when inactive. In the low-power state, the equipment must consume no more than 30 watts of power. To bring the equipment back to full power, the user presses a keyboard key or moves the mouse. NCD has implemented the EPA’s Energy Star requirements in NCDware.

Warning

Power management should only be enabled on monitors that are VESA- (Video Electronics Standards Association) compliant. Using this feature on non-VESA-compliant equipment subjects the user to the serious risk of personal injury or permanent damage to the equipment. VESA-compliant equipment is clearly labeled. If you are unsure whether your equipment is VESA-compliant, do not use this feature until you have consulted your monitor documentation.
Changing User Preferences

You can change the following power management features from the Power Management hide box:

- Enable VESA Monitor Power Management: click on the toggle button to enable or disable the power management feature.
- Standby After: drag the slider to specify how long (from 0 to 240 minutes, default 20) that the terminal remains idle before the transition to the standby state.
- Suspend After: drag the slider to specify how long (from 0 to 240 minutes, default 40) that the terminal remains idle before the transition to the suspend state.
- Powerdown After: drag the slider to specify how long (from 0 to 240 minutes, default 60) that the terminal remains idle before the transition to the powerdown state.

Font Options

Click on the Fonts hide button in the User Preferences window to display the Fonts hide box. (See Figure 6-17.)

![Font Preferences](image.png)

**Figure 6-17 Font Preferences**

You can change font paths using the Font Path Entry list and text entry field.

**Note** Be careful when setting the font path for your X terminal. The number of font directories and the order in which they appear affects X server performance, memory consumption, and appearance of clients.

The Font Path Entry list includes the font paths available for your current X session.
Changing User Preferences

To delete a font directory:
  a. Click on the directory you want to delete in the Font Path Entry list.
  b. Click on the Delete button and on the Apply button.
  c. Select Console ⇒ Utilities ⇒ Rescan Font Path for the new path to take effect.

To add a font directory:
  a. In the Font Path Entry list, determine where the new font directory should appear, and click on the current directory below that. The Font Path Entry field appears.
  b. Click on the New button. A nil line appears in the Font Path Entry list, above the directory you highlighted in Step a.
  c. Click on the nil line. The nil line appears in the Font Path Entry text entry field.
  d. Delete the word nil by clicking in the text entry field and backspacing through the word.
  e. Type the name of the font directory that you wish to add to the font path and press the Return key. VMS users must type in the complete file pathname. The new directory appears in the Font Path Entry list in place of the nil entry.
  f. Click on the Apply button.
  g. Select Console ⇒ Utilities ⇒ Rescan Font Path for the new path to take effect.

To save your changes to the font path for future X sessions, ask your system administrator to save the settings in an appropriate configuration file.

To see extensive diagnostic information about font access (such as notices of fonts being opened and Font Server activity), turn on the Show Extended Font Diagnostics toggle button. The diagnostic output appears in the Console’s message area.

Note: Do not display the extended font diagnostics unless you are trying to solve font problems. The output is extensive, and might obscure other important messages.
Changing User Preferences

X, Graphics, and SIE Options

Click on the X, Graphics, and SIE hide button in the User Preferences window to display the hide box. (See Figure 6-18.)

The X, Graphics, and SIE (Simple Imaging Extension) settings allow you to specify X settings related to use of graphics applications with X. In particular, SIE enhances the image display capabilities of NCO terminals for clients written with SIE library routines. SIE offers image compression, pan, zoom, and 90-degree rotation.

**Note** If you are running the Minimal X server, this hide box is called X and Graphics. It does not include SIE options.

![X, Graphics, and SIE Preferences](image)

**Figure 6-18** X, Graphics, and SIE Preferences

You can change the following features from the X, Graphics, and SIE hide box:

- **Enable Benchmark Optimizations**: click on this toggle to enable or disable this feature. When enabled, some graphics operations are optimized for benchmarks.

- **Enable Graphics Optimizations**: click on this toggle to enable or disable this feature. When enabled, some graphics operations are optimized for speed with a possible loss in accuracy.

- **Screen Resolution**: drag the slider to specify a resolution in dots per inch (from 1 to 512; 100 is default).

- **Use Backing Store**: If enabled, an off-screen image of a concealed window (or portion of a window) is stored in local memory to reduce the time it takes to redraw concealed windows when they are exposed. If disabled, any displayed data that is concealed by another window is discarded and the client must redraw it.
Use of backing store can involve a trade-off between performance and memory usage. Choose one of these three settings by clicking on the preferred setting in the Use Backing Store option box:

- When Mapped: the X server can use backing store for all mapped (displayed) windows, even if the client has not requested the feature.
- By Request: the X server can honor requests for backing store from clients requesting this feature. By Request is the default.
- Disabled: the X server does not honor any requests for backing store from clients.

☐ SIE Sampling Method: specifies the sampling method to use when scaling. An option box includes four settings:

- Nearest Neighbor (default): uses a scaling algorithm in which each destination pixel is reverse-mapped into the source image space, and the source pixel nearest that point is used to determine whether the resultant pixel is on or off.
- Any Neighbor: looks at the four closest pixels and turns on the destination pixel if any one of those four is on.
- Bilinear Interp: performs a weighted average of the four closest pixels, and turns on the destination pixel if the result is above an assigned contrast threshold. A slider allows you to set the contrast threshold value.
- 4x4 Area: looks at the sixteen closest pixels, and turns on the destination pixel if the sum of those pixel values is above an assigned contrast threshold. A slider allows you to set the contrast threshold value.

☐ SIE Contrast Threshold: for the Bilinear Interp and 4x4 Area sampling methods, specifies the contrast value (percentage) used when scaling. 50 is the default.
Changing User Preferences

Compatibility Options

Click on the Compatibility hide button in the User Preferences window to display the Compatibility hide box. The compatibility settings control X features that can affect the performance of clients on your NCD X terminal. (See Figure 6-19.)

<table>
<thead>
<tr>
<th>Compatibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permit Old X Bugs</td>
</tr>
<tr>
<td>Be Compatible With Old DECwindows Vendor String</td>
</tr>
<tr>
<td>Be Compatible With Old DECwindows Keyboards</td>
</tr>
<tr>
<td>Be Compatible With Old DECwindows Images</td>
</tr>
</tbody>
</table>

Figure 6-19 Compatibility Preferences

You can change the following features from the Compatibility hide box. In VMS environments, these values are set on by default. If the values are not on, ask your system administrator to turn them on. Certain DECwindows applications do not work correctly if these values are not turned on.

Click on the toggle buttons for these features to enable or disable them.

- Permit Old X Bugs: If enabled (the default), allows transmissions from clients that do not comply with the current X standard.
- Be Compatible with Old DECwindows Vendor String: If enabled, controls the vendor string returned by the X server to X clients that request it.
- Be Compatible with Old DECwindows Keyboards: If enabled, changes the presentation of modifier keys to clients to accommodate DECwindows modifier key interpretation on NCD X terminals.
- Be Compatible with Old DECwindows Images: If enabled, allows DECwindows applications to display images using the correct byte ordering on NCD X terminals.
Changing User Preferences

Console and Utilities Options

Click on the Console and Utilities hide button in the User Preferences window to display the Console and Utilities hide box. The Console and Utilities hide box settings control the automatic logout, local screen, and screen saver utilities, as well as display of time stamps in the Console's message area. (See Figure 6-20.)

<table>
<thead>
<tr>
<th>Console and Utilities Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Console Key Sequence</td>
</tr>
<tr>
<td>Automatic Logout After (minutes)</td>
</tr>
<tr>
<td>Automatic Logout Cancel Delay (seconds)</td>
</tr>
<tr>
<td>Automatic Lock Screen After (minutes)</td>
</tr>
<tr>
<td>Lock Screen Default Password</td>
</tr>
<tr>
<td>Delay When Blanking Screen (milliseconds)</td>
</tr>
<tr>
<td>Show Console Message Timestamps</td>
</tr>
</tbody>
</table>

Figure 6-20 Console and Utilities Preferences

- Console Key Sequence: allows you to specify an alternative key sequence for accessing the Console. To use this feature, type in ModifierList-Key, where ModifierList is any number of modifiers (such as Ctrl, Shift, or Alt) separated by hyphens, and Key is one alphanumeric or function key (such as F4, g, or 9). Some valid examples are:
  - Shift-F9
  - Ctrl-Alt-Shift-a

- Settings for automatically logging out and locking the screen are described in detail in “Setting Automatic Lock Screen” on page 6-9 and “Setting Automatic Logout” on page 6-11.

- Delay When Blanking Screen: in the text entry field, type how long a delay you want (in milliseconds) from the time you select the Blank Screen utility until the screen actually blanks.

- Show Console Message Time Stamps: enable this toggle button if you need to diagnose problems.
Audio Options

Click on the Audio hide button in the User Preferences window to display the Audio hide box. The Audio hide box setting controls the Maximum Gain, which defines the maximum volume for audio clients. (See Figure 6-21.)

<table>
<thead>
<tr>
<th>Maximum Gain (percent)</th>
<th>100</th>
</tr>
</thead>
</table>

Figure 6-21 Audio Preferences

Note If you are running the Minimal X server, this hide box is not available.
Changing User Preferences

Saving User Preference Changes

Parameters governing user preferences (and any other parameters set through the Console) can be set by your system administrator using the remote configuration facility. If you want the settings you’ve defined using Console menus to remain as you have specified for future X sessions, ask your system administrator for help as instructed in the following procedure, or refer to the following sources:

- NCDware 3.2 Reference Manual
- NCDware 3.2 Advanced User’s Guide for UNIX Systems
- NCDware 3.2 Advanced User’s Guide for VMS Systems

1. Open the User Preferences window (Console => Setup => Change User Preferences) and change the User Preferences as desired.

2. Click on the File menu from the User Preferences window menu bar and pull down to Save to File.

3. In the popup window, enter the name of the file in which the preferences should reside on the host system. Include the complete pathname (usually your login directory).

4. Ask your system administrator to:
   - Have this file loaded into the initial remote configuration file that is read by the terminal at boot time
   - Change the Xsession startup file to run ncdloadprefs at each new login

After your system administrator makes the changes, each time you log in, the preferences you specified automatically load into the terminal, appear in the User Preferences window, and customize your work environment.
Getting System Information

This section describes how to use the Console to get information about the NCD X terminal, X server, and the network using the Console's Statistics menu.

Figure 6-22 shows the Statistics menu.

Show Version

The Show Version item displays a popup window containing information about the X terminal and X software. (See Figure 6-23.)

If you have a Token-Ring system, the screen is somewhat different:

- **Built in Ethernet** changes to **Built in Token Ring**.
- **Current Ethernet** changes to **Current Token Ring**.

Figure 6-23 The Show Version Popup Window for Ethernet
Getting System Information

You can select text in this window to copy into another window.

- To select an entire row of text, click the left mouse button on the desired row.
- To select all of the text in the window, click the right mouse button on the text.

Table 6-7 explains the information displayed in the Show Version popup window.

Table 6-7  Contents of the Show Version Window

<table>
<thead>
<tr>
<th>Name</th>
<th>Information Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>The NCD X terminal model</td>
</tr>
<tr>
<td>NCDware</td>
<td>Software revision number and X server version, which is indicated by an underscore code:</td>
</tr>
<tr>
<td></td>
<td>none ⇒ Minimal</td>
</tr>
<tr>
<td></td>
<td>_s ⇒ Standard</td>
</tr>
<tr>
<td></td>
<td>_ds ⇒ Standard + DPS(^1)</td>
</tr>
<tr>
<td></td>
<td>_dms ⇒ Standard + DPS + mwm(^1)</td>
</tr>
<tr>
<td></td>
<td>_ms ⇒ Standard + mwm</td>
</tr>
<tr>
<td></td>
<td>_ps ⇒ Standard + PEX(^1)</td>
</tr>
<tr>
<td></td>
<td>_rs ⇒ Standard + XRemote-only</td>
</tr>
<tr>
<td></td>
<td>_3s ⇒ Standard + 3270 emulation(^2)</td>
</tr>
</tbody>
</table>

\(^1\) This server’s features are discussed in *NCDware 3.2 Advanced User’s Guide for UNIX Systems* and in *NCDware 3.2 Advanced User’s Guide for VMS Systems*.

\(^2\) This server’s features are discussed in *Using the 3270 Terminal Emulator*.

| Boot Monitor  | Boot Monitor software revision number                                                  |
| Screen        | Type of display                                                                        |
| Resolution    | Screen resolution and dpi (dots per inch)                                             |
| Keyboard      | The keyboard family name                                                               |

6-48 Using the NCD User Services
<table>
<thead>
<tr>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>Amount of memory installed (depending on the terminal, may indicate data memory and code memory)</td>
</tr>
<tr>
<td>Licensable Features</td>
<td>Software that must be licensed before you may use it, such as NCDnet, mwm, XRemote</td>
</tr>
<tr>
<td>Bundled Features</td>
<td>Software that is included in the server without an additional license</td>
</tr>
<tr>
<td>Built in Ethernet or Token-Ring</td>
<td>Default physical network address of the Ethernet or Token-Ring node</td>
</tr>
<tr>
<td>Current Ethernet or Token-Ring</td>
<td>Current physical network address of the Ethernet or Token-Ring node</td>
</tr>
<tr>
<td>TCP/IP Name</td>
<td>Name assigned to the X terminal for use in Internet communications</td>
</tr>
<tr>
<td>TCP/IP Address</td>
<td>Internet Protocol address, a number assigned to the X terminal for use in Internet communications</td>
</tr>
<tr>
<td>TCP/IP Netmask</td>
<td>Identification number used in Internet routing</td>
</tr>
<tr>
<td>NCDnet Name</td>
<td>Name assigned to an X terminal for use in DECnet communications</td>
</tr>
<tr>
<td>NCDnet Address</td>
<td>Number assigned to the X terminal for use in DECnet communications</td>
</tr>
<tr>
<td>Booted From</td>
<td>Host from which the X server was downloaded</td>
</tr>
<tr>
<td>X Session Host</td>
<td>Host that ran the login process</td>
</tr>
</tbody>
</table>
Getting System Information

Show Memory

The Show Memory item displays a popup window containing a histogram representation of the amount of free data memory. (See Figure 6-24.)

**Note** If you are running the Minimal X server, this window is not available.

Below the histogram, the window includes the:

- Amount of total installed memory
- Amount of free memory
- Size of the largest free memory block

The Update button adds to the histogram by showing an updated reading of free memory.

The Restart button starts the histogram again with an updated reading of free memory.

![Figure 6-24 The Show Memory Popup Window](image)

Figure 6-24 The Show Memory Popup Window
Show X Connections

The Show X Connections item displays a popup window that lists all active X connections and the terminal resources used by these connections. (See Figure 6-25.)

**Note** If you are running the Minimal X server, this window is not available.

Specific information for each client includes the:

- Client’s name
- Client’s host
- Type of authorization used
- X window identification number (XID)
- Windows created by the client
- Pixmaps (off-screen drawing areas)
- Graphics context information
- Number of fonts in use
- Cursors created by the client
- Allocated color cells
- Color maps

![Image of the Show X Connections Popup Window](image.png)

*Figure 6-25 The Show X Connections Popup Window*
Getting System Information

Show Statistics

The Show Statistics item displays a detailed description of system and network statistics that are primarily useful to system administrators and advanced users. (See Figure 6-26.)

Note If you are running the Minimal X server, this window is not available.

Figure 6-26 The Show Statistics Popup Window
7 Using the NCD Local Window Manager

Introducing \textit{ncdwm} 7-2
- Running \textit{ncdwm} 7-3
  - Starting \textit{ncdwm} 7-3
  - Restarting \textit{ncdwm} 7-4
  - Stopping \textit{ncdwm} 7-4
- Starting Clients 7-4
  - Via the Default Root Menu 7-4
  - Via a Customized Root Menu 7-5
\textit{ncdwm} Windows 7-8
\textit{ncdwm} Focus Policy 7-10
\textit{ncdwm} Pointers 7-11

Using the \textit{ncdwm} Window 7-12
- Using the Window Menu or Keystroke Combinations 7-13
- Using Mouse to Manipulate Windows 7-15
  - Moving Windows 7-15
  - Changing a Window's Hierarchical Position 7-16
  - Changing Window Size 7-17
- Iconifying Windows 7-18
Deiconifying Windows  7-20
Closing Windows and Icons  7-20
Advanced \textit{ncdwm} Features  7-21
This chapter describes how to use NCD's local window manager, \textit{ncdwm}.

If you are using another window manager besides \textit{ncdwm}—such as host-based OSF/Motif, OpenWindows, or DECwindows window managers—see Chapter 9, Common GUIs on NCD X Terminals.

The usage instructions for \textit{ncdwm} also apply to \textit{mwm}, a local client version of OSF/Motif 1.2.2. Comments on any differences between the two window managers are provided in this chapter as necessary. However, where \textit{ncdwm} and \textit{mwm} are identical, only \textit{ncdwm} is mentioned.

If you want to know more about how your particular system has been set up, refer to these sources:

- \textit{NCDware 3.2 Advanced User's Guide for UNIX Systems}
- \textit{NCDware 3.2 Advanced User's Guide for VMS Systems}
- Your system administrator
Introducing ncdwm

ncdwm, the NCD local window manager, is similar in its style, function, and usage to the OSF/Motif window manager (mwm).

Note  The mwm client requires a license.

NCD's ncdwm provides unlicensed OPEN LOOK support and a subset of the standard OSF/Motif 1.2.2 functionality at a reduced cost and with less memory usage. In order to provide these advantages, ncdwm modifies or excludes some mwm features:

-mwm provides...
- Full keyboard traversal
- Full Motif resource configurability
- Modifiable key accelerators
- All Motif f.launcher functions
- International text support (e.g., non-European)

-ncdwm provides...
- Partial traversal ability via the Alt/Tab key combination
- A small set of most-frequently-used resources
- Non-modifiable key accelerators
- Frequently-used Motif f. launcher functions

NCD's window manager executes in either of these ways:

- As a host-based client (as conventional window managers do)
- As a local client on the NCD X terminal processor

As a local client, ncdwm manages window activities for local clients as well as for host-based clients. It is a useful tool for computing environments in which host-based window managers are unavailable or host resources are already stretched. ncdwm is 10 times smaller than a host-based window manager—approximately 100 kilobytes compared to 1 megabyte for some host-based window managers.

ncdrunwm, the companion program to ncdwm, starts clients requested using ncdwm's root menu. ncdrunwm executes on the
host processor, allowing application startup to occur on the host, where the user has already been authenticated by logging in.

**Running ncdwm**

You can start up and stop `ncdwm` in several ways, which are explained in the following sections.

**Starting ncdwm**

Ideally, your system administrator has set up your startup files so that the local window manager starts automatically when you log in. If the window manager starts automatically, all your windows are already framed by `ncdwm`'s Motif-style frames when they appear on the display.

You can also start `ncdwm` using the Console’s WindowMgr menu:

1. Click on the WindowMgr menu button.
2. Click on the NCD Window Manager toggle button (For `mwm`, use the Motif Window Manager toggle button). The `ncdwm` window manager starts and the characteristic frames appear around all the clients.

Several other methods are available to start `ncdwm` (the `-mwm` option starts `mwm` instead of the default `ncdwm`):

- From a host running the UNIX operating system, in a terminal emulator window, type `ncdrunwm -d displayname:0`, where `displayname` specifies the X terminal display on which the window manager should be started.

- From a host running the VMS operating system, either:
  - Add the `NCDRUNWM` command to the DECwindows Session Manager’s Customize menu dialog box and then invoke it through the Automatic Startup feature (described in “Using the Local Window Manager” on page 9-22)

  or

  - Invoke the `NCDRUNWM` command from the DCL prompt

- By using remote configuration

If you start `ncdwm` from the Console or by using one of the other methods, the window frames of the clients that are already

---

Using the NCD Local Window Manager 7-3
Introducing ncdwm

running change to ncdwm frames. Any subsequent clients you start appear with ncdwm frames.

**Restarting ncdwm**

To restart ncdwm while it is running, press the Enter key on the keypad while holding down the Ctrl and Alt keys. For other methods of restarting ncdwm, see your system administrator.

**Stopping ncdwm**

To stop ncdwm while it is running, click on the NCD Window Manager toggle button in the Console’s WindowMgr menu. For other methods of stopping ncdwm, see your system administrator.

**Starting Clients**

To start clients by using ncdwm, you can use the default ncdwm root menu or a customized root menu. (You can also use the Console’s Terminals menu to start clients. See “Connecting to Hosts” on page 6-15.)

**Via the Default Root Menu**

The default root menu is a rectangular box containing a list of local clients that execute when you select them with your mouse.

**Note** By default, any mouse button displays the default ncdwm root menu. However, your system administrator may have customized your software to display other root menus.

To start clients via the default ncdwm root menu:

1. Place the pointer anywhere on the root window.
2. Click a mouse button. The menu appears on the root window and remains there until you select one of the menu items or click a mouse button on the root window. (See Figure 7-1.)
Introducing ncdwm

**Note**  The Minimal X server’s default root menu does not include the Show Memory and Show X Connections clients.

<table>
<thead>
<tr>
<th>Local Clients</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Console</td>
</tr>
<tr>
<td>Start Terminal</td>
</tr>
<tr>
<td>Show Version</td>
</tr>
<tr>
<td>Show Memory</td>
</tr>
<tr>
<td>Show X Connections</td>
</tr>
<tr>
<td>Lock Screen</td>
</tr>
<tr>
<td>Setup User Preferences</td>
</tr>
<tr>
<td>Login</td>
</tr>
<tr>
<td>Logout</td>
</tr>
<tr>
<td>Exit NCDwm</td>
</tr>
</tbody>
</table>

**Figure 7-1** The Default Root Menu

3. To connect to a host, select the Start Terminal item and log into a host, as described in “Logging In” on page 5-4.

**Via a Customized Root Menu**

Commonly, system administrators customize root menus to contain items that invoke the commands needed to connect to hosts and start other applications, as well as starting local clients. The items listed in your root menu depend on how your system administrator has configured your system and your network. Usually the root menu lists hosts and applications to which you have access and an item to log off.

To start clients via the customized root menu:

1. Place the pointer anywhere on the root window.
2. Click a mouse button. The customized menu appears on the root window and remains there until you select one of the menu items or click a mouse button on the root window. (See Figure 7-1.)
Introducing ncdwm

Once you select an item from the root menu or a submenu, the menu and its submenu disappear. *ncdrunwm* connects to the host or starts the application you selected.

For example, in Figure 7-2, the user selected a host named octopus. The selection resulted in a terminal emulator connection to the host computer called octopus.

A window containing the octopus output appears. At the same time, an icon representing the window appears in the icon box along the right side of the screen (see Figure 7-2). (The icon box may not appear on your display, depending on how your system has been configured.)

![Figure 7-2 A Window and Icon](image)

When you start a new client, *ncdwm* places a new window on top of those already running, leaving a portion of the lower windows in view. By default, the active window is the newest window.
Introducing ncdwm

Notice that the frame of the active window (the anemone window) is a different shade from the others. (See Figure 7-3.)

Figure 7-3 Adding Windows
Introducing ncdwm

ncdwm Windows

This section examines the structure of the ncdwm window and how you can use it to manage windows.

When ncdwm is running, each client window is framed with the ncdwm frame. (See Figure 7-4).

![Figure 7-4 ncdwm Window](image)

The symbol % inside the window frame in Figure 7-4 is a UNIX prompt, an example of output from a process displaying in the window. When you direct input by typing or using the mouse in a window, the input appears in the window, too.
Introducing ncdwm

The top bar of the window frame is called the title bar. It contains a title area in the center, which usually contains the name of the client, application, or host. (In Figure 7-4, the name of the host, octopus, is in the title area.)

Use tools on the title bar to perform window manager functions. Tools are shown in Figure 7-4 and summarized in Table 7-1.

Table 7-1 Window Manager Tools

<table>
<thead>
<tr>
<th>Tool</th>
<th>Action</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window menu button</td>
<td>Click</td>
<td>Displays a menu of window operations. (See Figure 7-6.)</td>
</tr>
<tr>
<td></td>
<td>Double click</td>
<td>Closes the window; in some cases, it stops the application.</td>
</tr>
<tr>
<td>Title bar</td>
<td>Click</td>
<td>Raises the window above or below other windows.</td>
</tr>
<tr>
<td></td>
<td>Drag</td>
<td>Moves the window.</td>
</tr>
<tr>
<td>Minimize button</td>
<td>Click</td>
<td>Iconifies the window.</td>
</tr>
<tr>
<td>Maximize button</td>
<td>Click</td>
<td>Enlarges the window to a full screen or restores it to its original size if it has been enlarged.</td>
</tr>
<tr>
<td>Resize handles</td>
<td>Drag</td>
<td>Changes window size.</td>
</tr>
</tbody>
</table>

"Using the ncdwm Window" on page 7-12 describes in detail how to use the tools listed in Table 7-1.

The ncdwm frame has four sides and four corners. The sides and corners are called resize handles. Each resize handle represents a movable portion of the frame that you can use to change the size of the window. (See Figure 7-5. "Using the ncdwm Window" on page 7-12 describes how to use resize handles to change window size.
Introducing ncdwm

ncdwm Focus Policy

Now that you know how to start several clients running in windows on your display, you need to know how to direct your mouse and keyboard input to a window, making it the active window.

The default ncdwm focus policy is click-to-focus. As explained earlier, click-to-focus means that to select a window to be the active window, you position the pointer on it and click the left mouse button. If you open a new window, however, the new window automatically becomes the active window.

ncdwm also supports pointer and explicit focus. With pointer focus, the window under the pointer tip automatically becomes the active window, regardless of whether you click, even if it is not on the top. Explicit focus is just like click-to-focus, except in that a newly opened window is not automatically the active window.

For information about changing the focus policy from the default, see your system administrator or the ncdwm man page in the NCDware 3.2 Reference Manual. You can tell which window has input focus by the color or shading of the frame. The frame of the active window is a different shade than the others.
**ncdwm Pointers**

Depending on the operation *ncdwm* is performing, the mouse pointer takes on different appearances, summarized in Table 7-2.

**Table 7-2  *ncdwm* Pointers**

<table>
<thead>
<tr>
<th>Pointer</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="arrow.png" alt="Arrow" /></td>
<td>Arrow pointer</td>
<td>The usual appearance when the pointer is on a window.</td>
</tr>
<tr>
<td><img src="root.png" alt="Root" /></td>
<td>Root pointer</td>
<td>Appears when the pointer is on the root window. When you have a root pointer, pressing a mouse button displays the root menu.</td>
</tr>
<tr>
<td><img src="crossed-arrow.png" alt="Crossed-arrow" /></td>
<td>Crossed-arrow pointer</td>
<td>Appears when a window is being moved.</td>
</tr>
<tr>
<td><img src="resizing.png" alt="Resizing" /></td>
<td>Resizing arrows</td>
<td>Appear when a window's size is being altered.</td>
</tr>
<tr>
<td><img src="watch.png" alt="Watch" /></td>
<td>Watch pointer</td>
<td>Appears when the X server is connecting to a host or performing a similar X server function; you must wait for it to finish, and for another pointer to appear, before you can use the mouse.</td>
</tr>
</tbody>
</table>
Using the ncdwm Window

ncdwm provides many ways for you to use the ncdwm frame and keyboard tools, including the Window menu items, keystroke combinations, and mouse-driven manipulation of window frames. These three methods are functionally equivalent.

However, an experienced user might be more comfortable using the Window menu or keystroke combinations (described in Table 7-3). A user who relies on the mouse when using applications might prefer the mouse-driven manipulation discussed in the following sections, page 7-15 to page 7-20.

Note All descriptions of ncdwm usage assume that the default click-to-focus policy is in effect. If you are using pointer focus or explicit focus, some of the window manager features work differently than described in the following sections.
Using the Window Menu or Keystroke Combinations

The Window menu (Figure 7-6) lists mouse-selectable action items and equivalent keystroke combinations.

![Window Menu](image)

Figure 7-6 Window Menu

Table 7-3 summarizes items in the Window menu.

Note For the equivalent keystrokes to take effect, you must click the window or icon that you want to manipulate.
# Using the ncdwm Window

## Table 7-3 Window Menu Items

<table>
<thead>
<tr>
<th>Window Menu Item</th>
<th>Keyboard Equivalent</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore</td>
<td>Alt + F5</td>
<td>Undoes your last manipulation (moving, resizing, or deiconifying) of the window.</td>
</tr>
<tr>
<td>Move</td>
<td>Alt + F7</td>
<td>The window follows the mouse pointer. Click a mouse button to release the window where you want it.</td>
</tr>
<tr>
<td>Size</td>
<td>Alt + F8</td>
<td>Move the pointer over the frame border or corner that you want to adjust. Move the resizing arrow until the window outline is the right size. Click a mouse button to keep the window in its resized shape or press Escape to abort the action.</td>
</tr>
<tr>
<td>Minimize</td>
<td>Alt + F9</td>
<td>The window disappears from the screen, and the icon representing it in the icon box changes from a flat appearance to three-dimensional.</td>
</tr>
<tr>
<td>Maximize</td>
<td>Alt + F10</td>
<td>The icon changes to a flat appearance as the window appears on the screen.</td>
</tr>
<tr>
<td>Lower</td>
<td>Alt + F3 (Not available with N-108 keyboard.)</td>
<td>The window goes to the lowest position on the root window, and input is focused to it.</td>
</tr>
<tr>
<td>Close</td>
<td>Alt + F4</td>
<td>The window and its icon (or the iconified window) disappear from the screen and the client exits (unless it is running in another window or icon).</td>
</tr>
<tr>
<td>Pack Icons</td>
<td>Shift + Alt + F7</td>
<td>Rearranges the icons in the icon box to remove empty spaces. (for icon box only)</td>
</tr>
</tbody>
</table>
Using Mouse to Manipulate Windows

Other mouse-driven methods of using the same options listed in the Window menu are described in the following sections.

Moving Windows

*nclwm* allows you to move windows around on the display screen using the mouse and title bar (Table 7-4).

Table 7-4 Moving Windows: Use the Mouse and Title Bar

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Place the pointer on the title bar of the window.</td>
<td>The pointer becomes a crossed-arrow.</td>
</tr>
<tr>
<td>2. Press the left mouse button.</td>
<td>The window outline appears and moves with the pointer.</td>
</tr>
<tr>
<td>3. Hold down the left mouse button and drag to where you want the window to appear.</td>
<td></td>
</tr>
<tr>
<td>4. When the window outline is in the position you want, release the mouse button.</td>
<td>The outline disappears and the window appears in its new position.</td>
</tr>
</tbody>
</table>
Changing a Window’s Hierarchical Position

ncdwm offers many ways to alter the windows’ order when they overlap each other on the display. You can change the hierarchical position of all windows on your display screen except for the root window. The root window always remains the lowest, the background upon which ncdwm displays the others.

ncdwm allows you to change a window’s hierarchy:

- Use the mouse (Table 7-5)
- Use the Alt key and mouse (Table 7-6)

Table 7-5 Raising or Lowering a Window: Use the Mouse

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Place the pointer on the window frame of the window.</td>
<td>Do not put the pointer on buttons, menus, or resize handles.</td>
</tr>
<tr>
<td>2. Click the left mouse button to raise a window, or click the right mouse button to lower it.</td>
<td>The window goes to the top or bottom position, and input is focused to it.</td>
</tr>
</tbody>
</table>

Table 7-6 Lowering a Window: Use the Alt Key and Mouse

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Position the pointer in the window you want to place beneath the others.</td>
<td>Use this method to change windows’ hierarchical position without changing the input focus that existed before the change.</td>
</tr>
<tr>
<td>2. Hold down the Alt key and click the right mouse button.</td>
<td>The window goes to the bottom, but input remains focused where it was before the position change.</td>
</tr>
</tbody>
</table>
Changing Window Size

*ncdwm* allows you to change the size of a window. (Also see the next section, “Iconifying Windows” on page 7-18.)

- Use the mouse and window frame (Table 7-7)
- Use the Maximize button (Table 7-8)

**Table 7-7 Changing Window Size: Use the Window Frame**

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Place the pointer on one of the eight resize handles on the window frame.</td>
<td>The pointer becomes a resizing arrow.</td>
</tr>
<tr>
<td>2. Press the left mouse button and drag.</td>
<td>A small box appears indicating the total size of the window (in units determined by the client). An outline of the window appears.</td>
</tr>
<tr>
<td>3. Release the mouse button when the outline is the size you want the window to be.</td>
<td>The outline and small box disappear, and the window size changes to the size you specified.</td>
</tr>
</tbody>
</table>

**Table 7-8 Changing Window Size: Use the Maximize Button**

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Place the pointer on the Maximize button (Figure 7-7).</td>
<td>The Maximize button is the large button in the upper right corner of the window frame.</td>
</tr>
<tr>
<td>2. Click a mouse button.</td>
<td>The Maximize button looks indented. The window expands to its maximum size, usually the entire display area.</td>
</tr>
<tr>
<td>3. Click again on the Maximize button.</td>
<td>The window shrinks to its original size.</td>
</tr>
</tbody>
</table>
Using the ncdwm Window

**Iconifying Windows**

An icon is a small representation of a window. When you open a window, an icon representing it appears on the side of the display screen. By default, icons appear in a window called an icon box.

When a window is iconified, it disappears from the screen and its icon’s appearance in the icon box changes. Icons of windows that are visible on the screen appear flat; those representing iconified windows appear three-dimensional. (See Figure 7-7.) Any processes running in the window continue. You cannot direct input to an iconified window.

![Figure 7-7 Icons in the Icon Box](image)

The icon box is a window like other *ncdwm* windows. It differs in the following ways:

- As you add and delete icons during an X session, spaces may remain in the icon box where icons have been deleted. Pack Icons—a Window menu item available only for the icon box—reshuffles the icons to remove empty spaces.

- The icon box has a scroll bar across the bottom to allow you to scroll through the icons when there are too many to be seen in the window at once.
ncdwm allows you to iconify windows:

- Use the Minimize button (Table 7-9)
- Use the Alt key and mouse (Table 7-10)

**Table 7-9 Iconifying a Window: Use the Minimize Button**

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Place the pointer on the Minimize button.</td>
<td>The Minimize button is the small button in the upper right corner of the window frame.</td>
</tr>
<tr>
<td>2. Click a mouse button.</td>
<td>The window disappears from the screen, and the icon representing it in the icon box looks three-dimensional.</td>
</tr>
</tbody>
</table>

**Table 7-10 Iconifying a Window: Use the Alt Key and Mouse**

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Place the pointer on the window you want to iconify.</td>
<td>The window disappears from the screen, and the icon representing it in the icon box looks three-dimensional.</td>
</tr>
<tr>
<td>2. While pressing Alt, click the middle mouse button.</td>
<td></td>
</tr>
</tbody>
</table>

Using the ncdwm Window

Deiconifying Windows

`ncdwm` allows you to restore an iconified window to the display screen (deiconify a window) using the mouse (Table 7-11).

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Place the pointer on the icon you want to restore to a window.</td>
<td>The window appears in the same size and position as before it was iconified.</td>
</tr>
<tr>
<td>2. Double click with the left mouse button or click with the middle mouse button.</td>
<td></td>
</tr>
</tbody>
</table>

Table 7-11 Deiconifying a Window: Use the Mouse

Closing Windows and Icons

When you close a window and its icon, you remove it from the display screen and icon box. If a client is running in only one window, then closing the window also closes the client connection. `ncdwm` allows you to close windows using the Window menu button (Table 7-12).

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Place the pointer on the dash-shaped Window menu button of the window that you want to close.</td>
<td>The window and its icon disappear from the screen and the client exits (unless it is running in another window or icon).</td>
</tr>
<tr>
<td>2. Double click with the left mouse button.</td>
<td></td>
</tr>
</tbody>
</table>

Table 7-12 Closing Windows: Use the Window Menu Button
Advanced *ncdwm* Features

Once you have become an experienced *ncdwm* user, you may decide you want to change aspects of the window manager’s behavior or window appearance. *ncdwm* affords lots of opportunity for customization via the X mechanism, called resource setting, that is used for passing default settings to clients.

For more information about resource setting, see the X guides cited in “Additional Documents” on p. vii. For information about the resources used in *ncdwm*, see the *ncdwm* man page in the *NCDware 3.2 Reference Manual*. 

8 Using the NCD XRemote Software

Assumptions 8-2
XRemote and Related Software and Hardware 8-3
  XRemote Software Components 8-4
  Transport Protocols 8-4
  Modems 8-4
  Cables 8-4
  Serial Ports 8-5
    Equipment to be Connected 8-5
    Cable Types 8-6
      Connecting a DTE to a DCE 8-6
      Connecting a DTE to a DTE 8-6
    Connector Genders 8-6
Before Running XRemote 8-7
  Setting Up a Modem 8-7
  Setting Up a U.S. Robotics Modem 8-8
  Setting Up a Direct Host Connection 8-11
Deciding Which Protocol to Use 8-12
Using XRemote  8-13

Connecting to XRemote—TCP/IP Over PPP or SLIP  8-13
  Start PPP or SLIP  8-13
  Start XRemote for PPP or SLIP  8-14
  Log Into the Host For PPP or SLIP  8-15

Connecting to XRemote—TCP/IP Over Ethernet or Token-Ring  8-17
  Log Into the Host For Ethernet or Token-Ring  8-17
  Start XRemote for Ethernet or Token-Ring  8-17

Connecting to XRemote—XRemote/Serial  8-18
  Start XRemote For XRemote/Serial  8-18
  Log Into the Host For XRemote/Serial  8-19
    For UNIX  8-19
    For VMS  8-19

Ending an XRemote Session  8-20
  For UNIX  8-20
  For VMS  8-21

Checking XRemote Diagnostics  8-22
Using the NCD XRemote Software

NCD's XRemote software enables an NCD X terminal connected to a host via a serial connection to be as capable as a terminal connected to an Ethernet or Token-Ring network. XRemote provides a fully functional X environment and offers the versatility and convenience of using X in remote locations. Once logged in, you can run the same X clients remotely that you are used to running on X terminals over a local network.

This chapter explains how to use NCD's XRemote software to log into remote hosts over modems or into local hosts that are directly connected.

**Note** If you are running a Minimal X server, this chapter does not apply to you. The Minimal X server does not include NCD's XRemote software.

This chapter includes the following information:

- List of what your system administrator needs to do for you
- Description of software and hardware used in XRemote
- Instructions for setting up a modem or a direct host connection
- Criteria for deciding which transport protocol to use
- Instructions for starting and ending XRemote sessions

If you want to know more about XRemote, refer to these sources:

- *NCDware 3.2 Advanced User's Guide for UNIX Systems*
- *NCDware 3.2 Advanced User's Guide for VMS Systems*
- Your system administrator
Assumptions

Before you attempt to connect to a host using XRemote software, ask your system administrator to do the items listed in Table 8-1.

### Table 8-1 Tasks for Your System Administrator

<table>
<thead>
<tr>
<th>For Any X Terminal User</th>
<th>For a UNIX System User</th>
<th>For a VMS System User</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Provide an XRemote-capable X server directly in your terminal (on a PCMCIA card or in PROM) if you plan to use XRemote from a remote site. (A downloaded server does not work from a remote site.)</td>
<td>- Prepare UNIX hosts for XRemote.</td>
<td>- Prepare VMS hosts for XRemote.</td>
</tr>
<tr>
<td>- Configure your setup parameters so that you can connect to a host using XRemote/TCP or XRemote/Serial. The parameters must be compatible with your modem’s capabilities.</td>
<td>- Revise your PATH environment variable to include the directory in which xinitremote and Xremote reside.</td>
<td>- Define the logical name containing a list of transport modules.</td>
</tr>
<tr>
<td>- Verify that you have an XRemote license and an XRemote-capable X server.</td>
<td>- Add a startup file to your home directory. The file can be .xinitremotec, .xinitrc, or a file referenced by the environment variable XINITRC. The startup file can start clients automatically when you log in.</td>
<td>- Configure the XRemote terminal to access fonts properly.</td>
</tr>
<tr>
<td>- Provide a modem with cables and a modem user’s manual.</td>
<td>- Make sure your font paths are correct.</td>
<td></td>
</tr>
<tr>
<td>- Make sure the host-side modem complements the settings of the remote modem (if necessary).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- If the NCD terminal was previously on a network and will use an XRemote-only server, reset the NVRAM to factory defaults.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
This section describes the software and hardware requirements for XRemote operation. XRemote software components include an XRemote-capable X server and a host-resident helper program. Communication protocol software is also required. Hardware components include the modem, cabling, and serial ports on an X terminal.

A complete XRemote system is illustrated in the context of a local area network in Figure 8-1.

Figure 8-1 A Local Area Network With XRemote
XRemote and Related Software and Hardware

XRemote Software Components

XRemote consists of two parts:

- An XRemote-capable X server (in PROMs, on a PCMCIA card, or downloaded) is responsible for managing local processes and handling communications with the host over a serial connection.

- The host-resident helper program is provided on the NCDware distribution media. Your system administrator must include the location of XRemote software in your search path. The helper process allows the X terminal to communicate with other hosts (including other X terminals) on the network.

Transport Protocols

XRemote supports two transport protocols:

- TCP/IP, which can run over PPP (Point-to-Point Protocol), SLIP (Serial Line Internet Protocol), Ethernet, or Token-Ring interfaces. We call this operating mode XRemote/TCP.

  **Note**  NCD does not support XRemote/TCP for VMS.

- A proprietary, non-networked protocol designed for use over serial connections. We call this operating mode XRemote/Serial.

Modems

Some modems are better suited for use with XRemote than others. Ask your system administrator for an appropriate model.

Cables

To directly connect your X terminal to a local host over a serial line, you need a serial cable long enough to reach the host.

To connect your X terminal to a modem, you need a short serial cable to connect to the modem. These cables are not provided with XRemote, but some modems include this cable. For cable details, see “Setting Up a Modem” on page 8-7 and “Setting Up a Direct Host Connection” on page 8-11.
Serial Ports

All NCD X terminals include a serial port (labeled AUXILIARY). Depending on the type of interface board that is installed in your terminal, you may have up to two additional serial ports, as shown in Figure 8-2.

![Figure 8-2 Serial Ports on NCD Terminals](image)

Serial 3 (ESP board port B with Y-cable) Serial 2 (ESP board port A with Y-cable or regular cable) Serial 1 (AUXILIARY port)

**Figure 8-2 Serial Ports on NCD Terminals**

Before connecting cables to the serial port(s), consider what equipment you are connecting, which cables you need, and which gender the connector requires.

**Equipment to be Connected**

The serial port on your X terminal (the AUXILIARY connector) has a standard RS-232 C interface. The serial port can be connected to two different kinds of equipment, as shown in Figure 8-3.

![Figure 8-3 Groups of Equipment: DCE and DTE](image)

**Figure 8-3 Groups of Equipment: DCE and DTE**

Depending on the equipment being connected to, different pin connection schemes are required in the interconnecting cables.
**Cable Types**

All NCD X terminals have an AUXILIARY port, which uses a regular serial cable, as indicated in Figure 8-2.

However, X terminals that include an ESP (Ethernet/Serial/PCMCIa) interface board have an extra serial port. A serial Y-cable can take advantage of this extra port, connecting an X terminal to up to two other pieces of equipment.

**Connecting a DTE to a DCE**
The serial cable with straight-through pin-to-pin connections is needed to connect a DTE to a DCE—for example, an X terminal to a modem.

**Connecting a DTE to a DTE**
A null modem cable is needed to connect a DTE to a DTE—for example, an X terminal to a printer or an X terminal to a host computer. (A serial cable can be converted to a null modem cable by using a null modem adapter.)

**Connector Genders**

Be aware of the connector genders. The X terminal serial port is a DB-25 (25 pin) female connector, except for ECX and MCX family terminals. The ECX and MCX base serial port is a DB-9 male connector. If your cable’s gender is incorrect, adapters are available to modify your cable.

- Most modem connections require a male-to-male cable.
- DEC systems and terminal servers use male connectors.
- Sun systems require a male-to-male null modem cable.

Before Running XRemote

- If you have a U.S. Robotics modem, follow the procedure in “Setting Up a U.S. Robotics Modem” on page 8-8.
- If you have a different modem, follow the procedure in “Setting Up a Modem” on page 8-7.

**Note** If you want more suggestions for specific modems, ask your local sales representative for the X Remote Technical Note or send an email request to info@ncd.com.

- If you want to connect to your host directly, follow the procedure in “Setting Up a Direct Host Connection” on page 8-11.

### Setting Up a Modem

Refer to your modem’s user manual, which includes:

- Directions for unpacking and setup.
- Instructions for enabling/disabling modem control signals that are referred to in steps 3 through 5 of this procedure.

Set up your modem as follows:

1. Connect one end of a serial cable to a serial port on your X terminal.

   **Note** To connect to the serial port on an ESP board, you may wish to use the special Y-cable described in hardware installation booklets and the ESP board installation sheet.

2. Connect the other end of the serial cable to your modem.

   The serial cable must be a standard RS-232 C cable. Most modems have female connectors. The AUXILIARY connector on your NCD X terminal is also female (except for the MCX and ECX bases), so your cable must have a male connector on each end. Refer to the pinout diagrams in your hardware installation documentation.
Before Running XRemote

3. Configure the modem to ignore DTR signals.
4. Disable any compression algorithms used by the modem. These algorithms delay XRemote transmissions and degrade performance. Consult your modem's user manual for instructions on disabling compression and error correction such as Microcom Networking Protocol (MNP).
5. Disable XON/XOFF flow control for the modem. If you want to use flow control, enable hardware flow control using RTS/CTS.
6. Verify that both the terminal and modem are configured for 8 data bits, 1 stop bit, and no parity. The terminal parameters are set in your Serial parameters hide box (Console ⇒ Setup ⇒ Change Setup Parameters ⇒ Serial). (See Figure 8-4.)
7. Look at how the handshake parameters (for setting flow control) are set in your Serial parameters hide box (Console ⇒ Setup ⇒ Change Setup Parameters ⇒ Serial). (See Figure 8-4.)
8. Configure the modem to match those parameters.

![Figure 8-4 Checking X Terminal Parameters](image)

Setting Up a U.S. Robotics Modem

The U.S. Robotics Courier HST Dual Standard modem meets all XRemote requirements. Use this procedure as an example for configuring a U.S. Robotics modem for use with XRemote.

To ensure that XRemote works correctly, both the remote and host-side modems must be set properly. Ask your system administrator to set up the host-side modem.
Before Running XRemote

For the modem at the remote site:

1. Set up your modem following the instructions in the U.S. Robotics modem user’s manual.
2. Open a Dialer client (Console ⇒ Terminals ⇒ New Dialer).
3. In the Dialer client window, type the commands that are listed in Table 8-2.

   **Note** You do not have to type these commands every time. The command `AT&W` allows you to save the modem settings.

Table 8-2 Modem Configuration Settings

<table>
<thead>
<tr>
<th>Type This Command...</th>
<th>Modem Displays...</th>
<th>Result of Your Action Is...</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>AT&amp;A3 &lt;Return&gt;</code></td>
<td>OK</td>
<td>Displays error code indicators (HST, LAPM, MNP, SYNC, or NONE) and data compression type (V42BIS or MNP5)</td>
</tr>
<tr>
<td><code>AT&amp;B1 &lt;Return&gt;</code></td>
<td>OK</td>
<td>DTE/DCE data rate remains fixed at the DTE setting</td>
</tr>
<tr>
<td><code>AT&amp;H3 &lt;Return&gt;</code></td>
<td>OK</td>
<td>Sets modem software and hardware flow control for compatibility with non-XRemote uses of the remote- and/or host-side modem</td>
</tr>
<tr>
<td><code>AT&amp;M0 &lt;Return&gt;</code></td>
<td>OK</td>
<td>Normal asynchronous mode, with no error control</td>
</tr>
<tr>
<td><code>AT&amp;N0 &lt;Return&gt;</code> or <code>AT&amp;N6 &lt;Return&gt;</code></td>
<td>OK</td>
<td>Sets the baud rate to default (normal connection operations) or 9600</td>
</tr>
<tr>
<td><code>AT&amp;W &lt;Return&gt;</code></td>
<td>OK</td>
<td>Saves these modem settings to NVRAM so that you don’t have to re-enter these commands each time you use XRemote</td>
</tr>
</tbody>
</table>
4. Type **ATDT**`phonenumber`, with the remote host’s phone number. For example: **ATDT**12125551132

If you need to dial 9 to get an outside line, insert a comma after the 9. For example, **ATDT**9, 12125551132 instructs the modem to pause after dialing the 9 until it hears the second dial tone. This prevents a miscommunication.

After you enter the ATDT command, the modem displays one of the messages listed in Table 8-3.

**Table 8-3 Modem Messages When Attempting to Connect**

<table>
<thead>
<tr>
<th>Message</th>
<th>Status</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>RING CONNECT 9600/ V32/NONE</td>
<td>You are connected. The modem displays the host's login banner.</td>
<td>If the login banner does not appear, press Return.</td>
</tr>
<tr>
<td>BUSY</td>
<td>The line is busy.</td>
<td>Repeat your attempt to connect later.</td>
</tr>
</tbody>
</table>

5. When your host displays the login banner, log in and run the startup command, such as **xinitremote**. The use of this command is described in the following sections:

— “Log Into the Host For PPP or SLIP” on page 8-15
— “Start XRemote for Ethernet or Token-Ring” on page 8-17
— “Log Into the Host For XRemote/Serial” on page 8-19
Setting Up a Direct Host Connection

XRemote can be used to connect an NCD X terminal directly to a local host over a serial cable.

- If you are connecting to a DCE (Data Communications Equipment) host, see the previous section, “Setting Up a Modem” on page 8-7.
- If you are connecting to a DTE device (such as a local host or a terminal switch box), use a null modem cable. Refer to the pinout diagrams in your hardware installation document.

To set up a direct serial connection:

1. Connect one end of the cable to the AUXILIARY connector or serial port (ESP boards only) on the base unit of your X terminal.
2. Connect the other end of the cable to your local host or terminal switch box.
3. Use the documentation for your host or terminal switch box to configure its serial port for 8 data bits, 1 stop bit, and no parity.
4. Verify that the parameters in the Serial parameters hide box (Console ⇒ Setup ⇒ Change Setup Parameters ⇒ Serial) match the serial configuration defined in Step 3. (See Figure 8-5.) If the configuration does not match, notify your system administrator.

Parameters to check

Move the scroll bar to see the parameters

Figure 8-5 Checking X Terminal Serial Parameters
Deciding Which Protocol to Use

If the NCD X terminal is not physically on the same local area network (LAN) as the host(s), but is instead connected via routers and/or bridges that communicate across relatively slow connections, then it may be advantageous to use XRemote over the Ethernet or Token-Ring. See “Connecting to XRemote—TCP/IP Over Ethernet or Token-Ring” on page 8-17.

If the host(s) are accessible from the NCD X terminal via serial connections only (either directly connected or via a modem), then choose between XRemote/TCP over PPP/SLIP or XRemote/Serial. Use Table 8-4 to determine which protocol is best for your situation.

Table 8-4 Characteristics of Protocols Used With XRemote

<table>
<thead>
<tr>
<th>PPP (page 8-13)</th>
<th>SLIP (page 8-13)</th>
<th>XRemote/Serial (page 8-18)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supports UNIX systems.</td>
<td>Supports UNIX and VMS systems.</td>
<td></td>
</tr>
<tr>
<td>PPP packets are autodetected.</td>
<td>SLIP packets cannot be autodetected.</td>
<td>Packets are autodetected.</td>
</tr>
<tr>
<td>Provides a slower performance than XRemote/Serial.</td>
<td>Provides a faster performance than PPP or SLIP.</td>
<td></td>
</tr>
<tr>
<td>Allows you to use a local printer.</td>
<td>Cannot use a local printer.</td>
<td></td>
</tr>
<tr>
<td>Allows remote configuration of your X terminal.</td>
<td>Cannot use a Telnet session.</td>
<td></td>
</tr>
<tr>
<td>PPP and SLIP are more difficult to manage.</td>
<td>Simpler, more easily managed protocol.</td>
<td></td>
</tr>
<tr>
<td>(See your protocol manual for commands and additional considerations.)</td>
<td></td>
<td>Use if the host does not have PPP.</td>
</tr>
</tbody>
</table>
Using XRemote

This section provides the procedures used to connect, configure, run, and end an XRemote session for the following XRemote communication types:

- TCP/IP over PPP or SLIP (available for UNIX systems only)
- TCP/IP over Ethernet or Token-Ring (available for UNIX systems only)
- XRemote/Serial (available for UNIX or VMS systems)

**Note** Your system administrator may set up XRemote to connect in a different way than is described here. Refer to your system administrator if you need help connecting over XRemote.

The Console grants you access to the set of configuration and management tools needed to use XRemote. Press the Setup key to display the Console. If your NCD keyboard does not have a Setup key, see Table 4-2 for equivalent key combinations.

**Connecting to XRemote—TCP/IP Over PPP or SLIP**

**Note** If you are working from a VMS host, this section does not apply to you. NCD does not support XRemote/TCP for VMS. Refer to “Connecting to XRemote—XRemote/Serial” on page 8-18.

**Start PPP or SLIP**

1. Open the Dialer client (Console ⇒ Terminals ⇒ New Dialer).

**Note** You can also use the Serial client (Console ⇒ Terminals ⇒ New Serial). However, it does not include the Dialer client’s Communications menu for convenience in starting SLIP (to convert the line to SLIP mode) and stopping PPP/SLIP. Without the Communications menu,
you have to go through the Setup client to stop PPP/SLIP.

2. If a Dialer Port Chooser appears, you have more than one serial port. In the chooser, highlight the number of the serial port that you want to use, and confirm by clicking OK. Serial ports are discussed in NCDware 3.2 Advanced User’s Guide for UNIX Systems.

3. Confirm that Strip Parity in the Options menu is turned on if the host you’ve dialed up is using 7-bit characters, the most likely situation. The default value is true (on) for the Dialer client (but it is false for the Serial client).

4. Depending on your configuration, you may need to type a modem command to set the baud rate, dial a phone number, and/or log into a system.

5. If PPP or SLIP does not start automatically, type the command defined by your system administration to start PPP or SLIP.

6. For SLIP, select SLIP from the Communications menu in the Dialer client to convert the line to SLIP mode.
   For PPP, this step may not be necessary because PPP packets are autodetected. If the remote host does not initiate the negotiation, select PPP from the Communications menu.

7. When PPP starts, the Dialer client (or Serial client) is iconified and these messages appear in the Messages area of the Console:

   %NCDTERM-I-MISC Switching to PPP Mode...
   %PPPD-I-UP, Port n: local = x.x.x.x, remote = x.x.x.x

   Jot down your assigned local address. You may need it later.

---

**Start XRemote for PPP or SLIP**

1. Open the Terminal Host Chooser (Console ⇒ Terminals ⇒ New Terminal or New Telnet).

2. Click in the host field of the Terminal Host Chooser.

3. Define which host will run the XRemote helper program.
To run the XRemote helper from the same host that initiated PPP, type the IP address \((\text{remote} = n.n.n.n)\) that is displayed in the Message area of the Console. (See Figure 8-6.)

To run the XRemote helper from a different host (for example, if you initiated PPP or SLIP from a router), refer to the \textit{NCDware 3.2 Advanced User's Guide for UNIX Systems}.

4. Select OK.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{figure8-6.png}
\caption{NCD Terminal Host Chooser}
\end{figure}

\textbf{Log Into the Host For PPP or SLIP}

Your X terminal may have two IP addresses now:

- How it is recognized over the PPP or SLIP connection (for PPP, the connection is displayed in the Message area of the Console:
  \texttt{local} = \textit{n.n.n.n})
- How it is recognized over Ethernet or Token-Ring (if it has a network connection)

Log into the host as follows:

1. If a login banner appears, type your login name and password.
Using XRemote

2. If you are not sure what your local IP address or hostname is, use the UNIX command `who am i`. For example, the following command reveals that the hostname is ncdpp3:

```
% who am i
octopus!sam  ttyp0  Aug 17 09:34   (ncdpp3)
```

3. To start XRemote:
   - In the terminal emulator window, type:
     ```
xinitremote -- -inet display:0 &
```
   - or
   - Set your DISPLAY environment variable:
     ```
setenv DISPLAY display:0
DISPLAY=display:0; export DISPLAY
```
     and then type:
     ```
xinitremote -- -inet &
```

**Note**  
`display` is the IP address or hostname of your X terminal over the PPP or SLIP connection. Using the example in Step 2, `display` would be ncdpp3.

For UNIX, `xinitremote` starts the clients and the XRemote helper.
Your home directory may contain two shell scripts for customizing XRemote:
- `.xservremoterc`, which specifies the server to run.
- `.xinitremoterc`, which specifies the X clients to run. By default, `xinitremote` starts the XRemote server and one `xterm`.

If you can’t execute `xinitremote`, your system administrator must add it to your search path. Usually XRemote resides in the directory `/usr/local/bin/X11`.
If you have no startup files, an `xterm` window appears.
Using XRemote

Connecting to XRemote—TCP/IP Over Ethernet or Token-Ring

**Note** If you are working from a VMS host, this section does not apply to you. NCD does not support XRemote/TCP for VMS. Refer to "Connecting to XRemote—XRemote/Serial" on page 8-18.

**Log Into the Host For Ethernet or Token-Ring**

Log into the host as follows:

1. Select a Telnet connection (Console ⇒ Terminals ⇒ New Telnet).
2. Select a host from the Terminal Host Chooser.
3. In the Terminal Emulator window, type your login name and password.
4. If you are not sure what your local IP address or hostname is, use the UNIX command `who am i`. For example, the following command reveals that the hostname is ncdu123:

   ```
   % who am i
   octopus!sam ttyp0 Aug 17 09:34 (ncdu123)
   ```

**Start XRemote for Ethernet or Token-Ring**

Start XRemote as follows:

- In the terminal emulator window, type:

  ```
  xinitremote -- -inet display:0 &
  ```
  or

- Set your DISPLAY environment variable:

  ```
  setenv DISPLAY display:0
  DISPLAY=display:0; export DISPLAY
  ```
  and then type:

  ```
  xinitremote -- -inet &
  ```

**Note** `display` is the IP address or hostname of your X terminal over the Ethernet or Token-Ring connection. Using the example in Step 4 of "Log Into the Host For Ethernet or Token-Ring", `display` is ncdu123.
For UNIX, *xinitremote* starts the clients and the XRemote helper. A user's home directory may contain two shell scripts for customizing XRemote:

- `.xservremoterc`, which specifies the server to run.
- `.xinitremoterc`, which specifies the X clients to run. By default, *xinitremote* starts the XRemote server and one *xterm*.

If you can’t execute *xinitremote*, your system administrator must add it to your search path. Usually XRemote resides in the directory `/usr/bin/X11/Xremote`.

If you have no startup files, an *xterm* window appears.

**Connecting to XRemote—XRemote/Serial**

For VMS users who want to use the NCD local window manager instead of the default DECwindows window manager, refer to “Using the Local Window Manager” on page 9-22.

**Start XRemote For XRemote/Serial**

1. Open the Dialer client (Console ⇒ Terminals ⇒ New Dialer).

   **Note** The Serial client (Console ⇒ Terminals ⇒ New Serial) also allows you to start XRemote.

2. If a Dialer Port Chooser appears, you have more than one serial port. In the chooser, highlight the number of the serial port that you want to use, and confirm by clicking OK. Serial ports are discussed in *NCDware 3.2 Advanced User’s Guide for UNIX Systems* and *NCDware 3.2 Advanced User’s Guide for VMS Systems*.

3. Confirm that Strip Parity in the Options menu is turned on if the host you’ve dialed up is using 7-bit characters, the most likely situation. The default value is true (on) for the Dialer client (but it is false for the Serial client).

4. Depending on your configuration, you may need to type a modem command to set the baud rate, dial a phone number, and/or log into a system.
Log Into the Host For XRemote/Serial

1. If a login banner appears, type your login name and password.

2. In the Dialer client window, type:

   % xinitremote

   *xinitremote* starts the helper program called *Xremote* then looks for and executes the *.xinitremoterc* file or other startup file. The Dialer client (or Serial client) iconifies.

For UNIX

*xinitremote* starts the clients and the XRemote helper. Your home directory may contain two shell scripts for customizing XRemote:

- *.xservremoterc*, which specifies the server to run.
- *.xinitremoterc*, which specifies the X clients to run. By default, *xinitremote* starts the XRemote server and one *xterm*.

If you can’t execute *xinitremote*, your system administrator must add it to your search path. Usually XRemote resides in the directory */usr/local/bin/X11*. If you do not have any startup files, an *xterm* window appears.

For VMS

Invoking the *XINITREMOTE* command announces the XRemote version along with the XRemote helper server number that is established. The *XINITREMOTE* command clears the screen and establishes your DECwindows environment.

The helper program looks for a special XRemote environment. If the environment is not found, a normal DECwindows environment starts. Any customization you do in DECwindows (for example, to minimize host involvement and downloading) is saved as a special XRemote environment that doesn’t affect your normal Ethernet-based DECwindows environment.
Ending an XRemote Session

Depending on whether you are working from a UNIX or VMS platform, you end an XRemote session differently.

For UNIX

1. Terminate the first XRemote client to end the XRemote session and close all of the XRemote client windows.
2. If you started XRemote with the Serial client and you are running PPP or SLIP, make sure *terminal* is listed in the *Current Port Use* field of the Serial Interface Table (Console => Setup => Change Setup Parameters => Serial), and select the Apply button.
3. If you started XRemote with the Dialer client, deiconify the Dialer.
   - If you are running XRemote/TCP and started PPP or SLIP with the Dialer client, select Serial from the Communications menu, then wait a few seconds. See Figure 8-7.
   - If you are running XRemote/Serial, your serial connection is in XRemote mode. While in this mode, anything you type into the Dialer client window is ignored. However, when you end an XRemote session normally (by terminating the first client) the serial connection automatically returns to the original Terminal mode. Select Serial from...
the Communications menu if your XRemote session hangs. (See Figure 8-7.)

4. Type the escape sequence to hang up. For most modems, the command is `+++ath`. Other modems require you to send a break signal (`Dialer-n ⇒ File ⇒ Send Break`).

**For VMS**

The standard VMS Session Manager provides a pulldown menu that is used to terminate the XRemote session.
Checking XRemote Diagnostics

Your X terminal allows you to display diagnostic messages:

1. Press the Setup key to invoke the Console. If your NCD keyboard does not have a Setup key, see Table 4-2 for equivalent key combinations.
2. Select the Messages hide box to display all diagnostic messages.
3. Note any errors reported in the Messages window, and report them to your system administrator if the problem is not resolved.
9 Common GUls on NCD X Terminals

OpenWindows Environment on NCD X Terminals  9-2
  Logging Into the OpenWindows Environment  9-2
Components of the OpenWindows GUI  9-4
  Mouse  9-4
  Pointer  9-4
  Workspace  9-4
  Window Management  9-5
  Focus Policy  9-7
  Cursor  9-7
  Additional OpenWindows Utilities  9-7
  Online Documentation  9-8
Tips for Running OpenWindows Clients  9-8
  Fonts  9-8
  Remapping the Keyboard  9-9
  Shell Tool and Command Tool Prompts  9-9
  Screen Resolutions  9-9
  Using Save Workspace  9-9

DECwindows Environment on NCD X Terminals  9-10
  Logging Into the DECwindows Environment  9-10
  DECwindows Access Control  9-13
Components of the DECwindows GUI 9-13

Window Manager 9-13
  Workspace Menu 9-15
  Focus Policy 9-15
  Pointer 9-16
  Types of Menus 9-16
  Dialog Box Mechanisms 9-17
  Scroll Bar Features 9-17

Session Manager 9-18

Starting the Local Terminal Emulators 9-19
  Defining and Adding an Item to the Item Names Box 9-19
  Adding an Item to the Applications Menu 9-21

Using the Local Window Manager 9-22
  Turning Off the DECwindows Window Manager 9-22
  Starting ncdwm For the Current Session Only 9-23
  Automating ncdwm to Start For Every Session 9-24

Tips for Running DECwindows Clients 9-25
  Use the DECwindows Compatibility Parameters 9-25
  Turn Off the Blinking Cursor 9-25
  Incorrect Font Loading 9-26

OSF/Motif Environment on NCD X Terminals 9-27
  Logging Into the OSF/Motif Environment 9-27
  Changing to mwm from ncdwm 9-27
  Disabling Backing Store 9-28
This chapter introduces three GUIs (graphical user interfaces) on NCD X terminals:

- Sun Microsystem’s OpenWindows
- Digital Equipment Corporation’s DECwindows
- Open System Foundation’s Motif

It includes a brief introduction to each of the GUIs and tips for improving their performance on NCD X terminals.

**Note** The host-based window managers discussed in this chapter are alternatives to `ncdwm`. A local client version of OSF/Motif (`mwm`) is available as well. The usage instructions for `ncdwm` discussed in Chapter 7 also apply to local `mwm`.

If you want to know more about your particular system’s GUI configuration, refer to these sources:

- *NCDware 3.2 Advanced User’s Guide for UNIX Systems*
- *NCDware 3.2 Advanced User’s Guide for VMS Systems*
- Your system administrator
OpenWindows Environment on NCD X Terminals

OpenWindows is a user environment based on the Sun OPEN LOOK graphical user interface (olwm). For detailed information about using OpenWindows, ask your system administrator for Sun OpenWindows documentation, such as OpenWindows Version 3 User’s Guide or OpenWindows Version 3 DeskSet Reference Guide.

NCDware is compatible with OpenWindows Version 2 and OpenWindows Version 3.

Logging Into the OpenWindows Environment

If your X terminal has been configured to allow it, you can log into use OpenWindows directly from the XDM login banner, exactly as described in “Logging In” on page 5-4.

Configuring your system to use OpenWindows when you log in from the XDM banner involves customizing several of the files that control your X session.

When you have logged in, the X server starts up with olwm (instead of ncdwm) and whatever applications and utilities are indicated in your .xsession file. (See Figure 9-1.)

Common startup applications might include:

- The File Manager (Sun Microsystems Computer Corporation owns File Manager V3), a file and directory management tool
- A command tool, a scrolling window-based shell environment
- The NCD Console
If your software is not configured to start OpenWindows immediately when you log in, you can start it yourself after logging into a host on which the OpenWindows software has been installed:

1. If the NCD local window manager is running when you log in, use the Console’s WindowMgr menu to turn off the local window manager.
2. Open a terminal emulator window.
3. In the window, type:
   
   \%
   olwm &

   The characteristic OpenWindows frames appear around the windows.
OpenWindows Environment on NCD X Terminals

Components of the OpenWindows GUI

This section introduces the components of the OpenWindows GUI.

Mouse

In the OpenWindows environment, the mouse operates similarly to its use in ncdwm. In OpenWindows, however, the buttons are described by function instead of by logical or physical numbers.

- The left button is the SELECT button
- The middle button is the ADJUST button
- The right button is the MENU button

Pointer

In the OpenWindows environment, the pointer appears in several forms, described in Table 9-1.

Table 9-1 Pointers in OpenWindows

<table>
<thead>
<tr>
<th>Pointer</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clock</td>
<td>System cannot accept input</td>
</tr>
<tr>
<td>Basic arrow</td>
<td>On the background window</td>
</tr>
<tr>
<td>Arrow with small square attached</td>
<td>Dragging an item</td>
</tr>
<tr>
<td>Arrow with square containing text</td>
<td>Dragging a portion of text</td>
</tr>
<tr>
<td>Arrow with two small squares</td>
<td>Copying an item by dragging</td>
</tr>
</tbody>
</table>

Workspace

In the OpenWindows environment, the root window is called the Workspace.
Window Management

In the OpenWindows environment, applications display their output in the OpenWindows windows, which contain graphical mechanisms to perform the window management functions described in “Window Managers” on page 2-12. (See Figure 9-2; Calendar Manager V3 is owned by Sun Microsystems Computer Corporation).

Figure 9-2 An OpenWindows Window

The frame surrounding an OpenWindows window is called the window border. The window has a header across the top that contains a title area and a button used to obtain a Window menu. Beneath the header is an area called the control area. Depending upon the application appearing in the window, the control area may contain buttons used to display additional menus or other control mechanisms. The area in which input and output appear is called the window pane.

The Window menu contains options for manipulating windows, including:

- Closing
- Moving
- Changing size
- Changing hierarchical position
- Refreshing the display
- Quitting the application
Table 9-2 summarizes the window management functionality provided on an OpenWindows window.

### Table 9-2  OpenWindows Window Management Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the Window menu</td>
<td>Put the pointer on the header or border and click the MENU button.</td>
</tr>
<tr>
<td>Moving windows on the Workspace</td>
<td>1. Position the pointer on the window border.</td>
</tr>
<tr>
<td></td>
<td>2. Press the SELECT button and drag the window to the desired location.</td>
</tr>
<tr>
<td></td>
<td>3. When the window is where you want it, release the SELECT button.</td>
</tr>
<tr>
<td>Moving a window to the back of a</td>
<td>1. Put the pointer on the header of the window you want to lower.</td>
</tr>
<tr>
<td>stack of windows</td>
<td>2. Click the MENU button to open the Window menu.</td>
</tr>
<tr>
<td></td>
<td>3. Position the pointer over the Back menu item.</td>
</tr>
<tr>
<td></td>
<td>4. Release the MENU button.</td>
</tr>
<tr>
<td>Changing window size</td>
<td>1. Position the pointer on one of the window corners.</td>
</tr>
<tr>
<td></td>
<td>2. Press the SELECT button and drag the corner until the window is the size you want it to be.</td>
</tr>
<tr>
<td></td>
<td>3. Release the SELECT button.</td>
</tr>
<tr>
<td>Closing windows</td>
<td>Click on the Window menu’s Close item.</td>
</tr>
<tr>
<td>Quitting applications</td>
<td>Click on the Window menu’s Quit item.</td>
</tr>
</tbody>
</table>
Focus Policy

The OpenWindows environment provides the same two basic input focus methods as ncdwm and OSF/Motif: click-to-focus and pointer focus. In OpenWindows, the default click-to-focus policy is called *click SELECT mode*. In click SELECT mode, you use the SELECT mouse button to indicate the active window.

Pointer focus policy is called *move pointer mode* in OpenWindows.

Cursor

The OpenWindows cursor appears in a different shape depending on whether its window is inactive or active:

- A small triangle in an active window
- A small diamond in an inactive window

Additional OpenWindows Utilities

OpenWindows DeskSet is a set of applications and utility programs that may be installed with OpenWindows. They include:

- Shell tools and command tools (command interpreter windows).
  - Shell tools scroll forward;
  - command tools scroll forward and backward.
- A file directory management tool
- A text editor
- A clock
- A calendar
- A printing tool
- A mail tool

DeskSet applications are accessed through the Workspace menu, which appears when you place the pointer on the Workspace and click the MENU button.
OpenWindows Environment on NCD X Terminals

Online Documentation

OpenWindows contains two types of online documentation: spot help and handbooks.

Spot help popup windows contain brief descriptions of window mechanisms. To display spot help:

1. Place the pointer on the window area that you want information about.
2. Press the Help key on your keyboard. (You can remap an NCD terminal’s function key to act as the Help key. See “Remapping the Keyboard” on page 9-9.)

Handbooks, including the tutorial-style “Desktop Intro,” describe how to use the DeskSet applications and the components of the OpenWindows environment.

- To display “Desktop Intro,” select the Desktop Intro item from the Workspace menu, which is accessed by placing the pointer on the Workspace and clicking the MENU button.
- To display the other handbooks, choose the Help item from the Workspace menu.

Tips for Running OpenWindows Clients

This section includes tips for getting the best performance from OpenWindows running on your NCD X terminal.

Fonts

OpenWindows displays best on your NCD X terminal if you set the 75 dpi fonts in front of the 100 dpi fonts in the font path. (The default font path has the 100 dpi fonts first.) To change the font path, use the Change User Preferences popup window, accessed from the Console’s Setup menu. (Console ⇒ Setup ⇒ Change User Preferences ⇒ Fonts). For detailed information about changing fonts, see “Font Options” on page 6-39.
Remapping the Keyboard

NCD's N-123 Sun Type 5-Compatible keyboards and N-107 Sun Type 4-Compatible keyboards have Help, Copy, Paste, and Cut keys that do not appear on NCD's other keyboards. Your system administrator can remap the function keys of NCD's other keyboards to include the Sun special keys. Remapping is accomplished by altering two files, .xmodmaprc.sun and .xsession.

The remapped keys are:

F5  Help
F6  Copy
F7  Paste
F8  Cut

Shell Tool and Command Tool Prompts

If you do not have a SunOs prompt when you invoke a shell tool or a command tool, ask your system administrator to make sure that the commands to invoke the prompts are prefaced with the bug-fix /usr/etc/setsid -b.

Screen Resolutions

The Sun Microsystems screen resolution differs from NCD X terminal monitors. As a consequence, when you use OpenWindows on an NCD X terminal, icons may appear in the wrong area of the display or not at all. If your icons seem misplaced or are missing, check with your system administrator to see if the necessary filter is in your .xsession file.

Using Save Workspace

The Save Workspace utility, accessed from the Workspace menu's Utilities submenu, saves the display configuration that exists when you invoke it so that the layout of your applications remains the same for the next time you log in.

When you use the Save Workspace utility on an NCD X terminal, the utility does not save local clients.
The DECwindows environment is Digital Equipment Corporation’s X-based graphical user interface to the VMS operating system. The DECwindows client is based on OSF/Motif. NCDware is compatible with all versions of DECwindows clients.

This section introduces the DECwindows Motif interface. It describes some of the varied DECwindows software configurations used on NCD terminals and provides performance tips for running DECwindows clients on your NCD terminal.

In DECwindows applications, mouse buttons are described, using the right-handed, three-button default, as:

- MB1 for the left button (physical or logical button 1)
- MB2 for the middle button (physical or logical button 2)
- MB3 for the right button (physical or logical button 3)

For more information on using DECwindows Motif software, ask your system administrator for:

- *VMS DECwindows Motif User’s Guide* (AA-PGZ5A-TE)
- *VMS DECwindows Motif Applications Guide* (AA-PGZ6A-TE)

### Logging Into the DECwindows Environment

When you turn on your X terminal to use DECwindows clients, which software is immediately accessible to you depends on how your system administrator has configured your system. This section describes some common configurations. If your configuration is not described here, ask your system administrator to tell you about it.

**Note** Before you select a VMS host in the Login Chooser, you must close down all other local clients, including the Console.
When you select a VMS host through the Login Chooser, a DECwindows Start Session dialog box appears for you to use to log in, instead of the XDM login banner. (See Figure 9-3.)

In the Start Session box, log in as follows:

1. At the input cursor in the Username field, type your login name.
2. Press the Tab key or Return key to move to the Password field.
3. Type your password. The password does not appear.
4. Press the Return key or move the pointer to the OK button and click MB1.

If you make a mistake when typing your password, click on the Clear button to erase the data that you typed in the username and password fields, and start again.

By logging in, you identify yourself, and the primary host can verify that you are an authorized user. The login process enables the DECwindows Session Manager to look into a startup file in your home directory.

The startup file, which your system administrator creates, lists clients that the Session Manager is to start automatically each time
you begin an X session. The name of your startup file (or files) might be LOGIN.COM and/or DECW$XDEFAULTS.DAT.

Once a DECwindows application starts, the window manager and clients set up for you by your system administrator appear in windows on your terminal. They might include:

- The DECwindows Motif window manager and a Session Manager, FileView (owned by Digital Equipment Corporation), and a DECTerm terminal emulator. See Figure 9-4, a typical DECwindows Motif display after login.

- The ncdwm local window manager, its companion program ncdrunwm, and a Session Manager.

The Motif window manager and the Session Manager are described later in this subsection. The ncdwm local window manager and ncdrunwm are described in detail in Chapter 7, Using the NCD Local Window Manager.
DECwindows Environment on NCD X Terminals

DECwindows Access Control

When using DECwindows applications, the X server and the DECwindows Session Manager both control client access to the X terminal’s display. The X server controls access to the display through a list of hosts until the DECwindows Session Manager is invoked.

The hosts list is part of the remote configuration file that is loaded during the X terminal’s boot process. The system administrator is responsible for creating and maintaining the hosts list. The hosts list contains the names or addresses of hosts that are authorized to send the DECwindows Start Session process to the X terminal.

The Session Manager provides menus to control the DECwindows environment. Once you log into the VMS host, the Session Manager takes over access control as well. It loads a new access control list from data in a special file. You can use Session Manager menus to modify the access control list by supplying the Session Manager with parameters that describe the hosts you want to authorize or exclude in the Security window.

Components of the DECwindows GUI

This section introduces the DECwindows components of the DECwindows Motif graphical user interface. The DECwindows GUI includes:

- A window manager
- Session Manager, a client used to control the DECwindows session and environment.
- FileView, a client that provides a graphical user interface to the directory and file structure. (DECwindows Motif incorporates FileView as an application within the Session Manager.)
- Assorted additional utilities and applications

Window Manager

In the DECwindows Motif environment, the window manager follows the OSF/Motif window manager style and function. The
windows look and function like other OSF/Motif-style windows. Characteristic features include the window frame, which contains:

- Resize borders
- A title bar, including the window name
- A dash-shaped Window menu button
- A small, square Minimize button
- A larger square Maximize button

Beneath the title bar the DECwindows Motif window contains a menu bar. (See Figure 9-5.)

![Figure 9-5 A DECwindows Motif Window](image-url)
When you use other DECwindows Motif clients such as the Session Manager or Bookreader, characteristic Motif menus, dialog boxes, and scroll bars may appear on the window frame.

Use of the OSF/Motif-style window management mechanisms is described in detail in Chapter 4, NCD X Terminal Interface Basics, and Chapter 7, Using the NCD Local Window Manager.

**Workspace Menu**
The Workspace menu is DECwindows Motif equivalent to the OSF/Motif root menu. It contains the following items:

- Shuffle Up
- Shuffle Down
- Next Window
- Previous Window
- Pack Icons—reshuffles icons in the icon box to remove empty spaces
- Options—contains sub-menus for customizing the DECwindows Motif environment
- Restart
- Help—contains more specific submenus

The Workspace menu differs from the OSF/Motif root menu and the `ncdwm` root menu in that it does not offer a way to start and stop clients. When using DECwindows Motif software, you start and stop clients from the Session Manager. (See “Session Manager” on page 9-18.)

If your system is configured to start up without the Session Manager running, your system administrator may configure `ncdrunwm` to supply a root menu for you to use for client control.

**Focus Policy**
As in other implementations of OSF/Motif, DECwindows Motif’s default input focus policy is click-to-focus (or explicit focus). You can change the focus policy to pointer focus (or implicit focus).
**DECwindows Environment on NCD X Terminals**

**Pointer**
DECwindows Motif pointers are described in Table 9-3. You can specify a different shape for the basic pointer using the Session Manager’s Customize menu.

**Table 9-3 Pointers in DECwindows Motif**

<table>
<thead>
<tr>
<th>Pointer</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow and a text input cursor</td>
<td>Pointing within the workspace or application</td>
</tr>
<tr>
<td>Hourglass and a watch</td>
<td>System is working and cannot accept input</td>
</tr>
<tr>
<td>Crossed-arrow pointer</td>
<td>Moving a window</td>
</tr>
</tbody>
</table>

**Types of Menus**
DECwindows Motif software uses various types of menus in its client windows:

- Pulldown menus list available commands and functions
  Use pulldown menus by pressing MB1 on the name of the menu you want to display, dragging to the item you want to select, then releasing MB1.

- Popup menus duplicate items available in pulldown menus
  Use popup menus by pressing MB3 in the application’s work area, dragging to the menu item you want to select, and releasing MB3.

- Options menus list items available in dialog boxes
  Display the dialog box of an item in an Options menu by pressing MB1 on the desired item. The dialog box appears with additional choices. Select the item you want by dragging to it and releasing the mouse button.

- Submenus are part of pulldown, popup, and options menus
  An arrow appearing to the right of an item in any type of menu indicates that when you choose that item, a submenu appears. Choose from a submenu by pressing MB1 on the submenu heading, dragging to the item you want to select, and releasing the mouse button.
Dialog Box Mechanisms
Some DECwindows Motif clients use dialog boxes to collect input needed to perform a task, such as customizing an application. Any menu item that is followed by an ellipsis (….) displays a dialog box when selected. Dialog boxes use these mechanisms to collect input:

- Text entry boxes
- Radio buttons, diamond-shaped buttons that let you select one among many options
- Check buttons, square-shaped toggle buttons to turn items on and off
- Sliders, to indicate numeric values in a scale
- List boxes, from which you can select items
- Push buttons, including OK, Apply, and Cancel

Scroll Bar Features
Many DECwindows Motif clients appear with Motif-style scroll bars that allow you to look at more text than fits in the window. The scroll bar appears vertically or horizontally in an area called a scroll region. The functional parts of the scroll bar include the following:

- Stepping arrows at either end of the scroll bar
  By clicking MB1 on the stepping arrows, you can scroll one line at a time through the text.
  By pressing and holding MB1 on a stepping arrow, you can scroll continuously, one line at a time, through the text.

- A slider bar between the stepping arrows
  By clicking with MB1 on either side of the slider bar, you can scroll forward or backward one window at a time. (Pressing and holding MB1 allows you to scroll continuously.)

You can go to a particular part of the text by pointing in the area of the scroll region that is proportionate to the area of the text you wish to display and clicking MB2. For example, if you want to display text area that is approximately two-thirds through the text, then click MB2 about two-thirds of the way down the scroll region.
DECwindows Environment on NCD X Terminals

Session Manager

DECwindows utilities are accessed through the Session Manager’s main menus. (See Figure 9-7.) These utilities allow you to customize your sessions, start applications, adjust the desktop environment, and access online help. Some of these menus are referred to in sections “Starting the Local Terminal Emulators” on page 9-19 and “Using the Local Window Manager” on page 9-22.

![Session Manager on OTTER diagram]

Figure 9-6 DECwindows Motif Session Manager
Starting the Local Terminal Emulators

You can start local terminal emulators by using the Console’s Terminals menu. If you prefer to use the Session Manager, you can customize the Applications menu to include the NCD local terminal emulator connections.

Defining and Adding an Item to the Item Names Box

Before you customize the Applications menu, you must define the menu item that invokes what you want and add the menu item to the Item Names list.

1. To define a menu item to invoke what you want (a terminal emulator, in this case) select the Menus item (Session Manager \(\Rightarrow\) Options \(\Rightarrow\) Menus). The Menus dialog box appears. (See Figure 9-7).

![Figure 9-7 DECwindows Menus Dialog Box](image-url)
2. In the text entry box (Figure 9-8), type the name exactly as you want it to appear in the Applications menu. For example, to add a local Telnet terminal emulator, you could type: **Telnet Term Emulator**.

3. In the DCL command entry box (Figure 9-8), type the DCL (Digital Command Language) command you want to be invoked when you select the newly defined menu item. The DCL command for starting local clients is `VUESLIBRARY:VUESNCD_LC.COM clientname`. For example, to invoke a Telnet terminal emulator, type:

   `VUESLIBRARY:VUESNCD_LC.COM TELNET`

   **Note**  
   A list of other client names is provided in the *NCDware 3.2 Advanced User's Guide for VMS Systems*.

   An arrow appears above the DCL command entry box.

4. Click on the arrow. The new menu item is added to the list in the Item Names box.

   **Figure 9-8 Adding an Item to the Item Names Box**

   9-20 Common GUIs on NCD X Terminals
Adding an Item to the Applications Menu

To add the new menu item to the Applications menu, continue to use the Menus dialog box (Session Manager → Options → Menus).

1. Select the Applications menu from the Menu Names list box. The center list box changes to display current Applications menu items. (See Figure 9-9.)

2. Select the newly defined menu item from the Item Names list box. An arrow appears between the Item Names list box and the Applications menu. (See Figure 9-9.)

3. Click on the arrow to add the item to the Applications menu in the center box. (Figure 9-9.)
4. If you want to change the location of the new item in the Applications menu, click on the stepping arrow(s) that appear. (See Figure 9-10.)

5. Click on the OK button or the Apply button to apply the changes to the Session Manager’s menu. (See Figure 9-10.)

6. Save your settings by selecting the Save Session Manager (Session Manager => Options => Save Session Manager).

Using the Local Window Manager

If you prefer, you can use the NCD local window manager, ncdwm, instead of the DECwindows Motif window manager on your NCD X terminal, as follows. Before you start ncdwm, you must first turn off the DECwindows Motif window manager.

Turning Off the DECwindows Window Manager

If you invoked the window manager from the Session Manager’s Applications menu, log out, then log in again. This time, do not invoke the Motif window manager.
If the Motif window manager started automatically for you upon logging in, remove it from the Session Manager’s list of clients to start automatically upon login, as follows. (See Figure 9-11.)

1. Select the Automatic Startup item (Session Manager ⇒ Options ⇒ Automatic Startup). The Automatic Startup dialog box appears.

![Automatic Startup Dialog](image)

**Figure 9-11 Removing a Client from Automatic Startup**

2. Highlight the Window Manager item in the right-side list.
3. Click on the sideways Remove arrow.
4. Click on the OK button to apply your change and exit.
5. Save your settings (Session Manager ⇒ Options ⇒ Save Session Manager).
6. Log out and log in again. The DECwindows Motif window manager is no longer active.

**Starting ncdwm For the Current Session Only**

If you want to use ncdwm on occasion, start ncdwm for the current session only. Click on the NCD Window Manager toggle in the Console’s WindowMgr menu (Console ⇒ WindowMgr ⇒ NCD Window Manager). ncdwm starts up.
Automating \textit{ncdwm} to Start For Every Session

If you want to use \textit{ncdwm} regularly, set up \textit{ncdwm} to start automatically every time you log into a DECwindows session.

1. Create a menu item for \textit{ncdwm} as instructed in “Defining and Adding an Item to the Item Names Box” on page 9-19. The DCL command for starting the local window manager is \texttt{VUE$LIBRARY:VUE$NCD_LC.COM WM}

2. Add the menu item to the Applications menu as instructed in “Adding an Item to the Applications Menu” on page 9-21.

3. Add the new item to the list of clients for automatic startup at login, as follows:
   a. Select the Automatic Startup item (Session Manager $\Rightarrow$ Options $\Rightarrow$ Automatic Startup). The Automatic Startup dialog box appears. (See Figure 9-12.)
   b. Select the local window manager item from the left-side list. A copy of the item appears in the right-side list.
   c. Click on the OK button to apply your change and exit.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{Figure9-12.png}
\caption{Adding \textit{ncdwm} to the Auto Start List}
\end{figure}

4. Save your settings (Session Manager $\Rightarrow$ Options $\Rightarrow$ Save Session Manager).
Tips for Running DECwindows Clients

This section includes tips for getting the best performance from DECwindows clients running on your NCD X terminal.

Use the DECwindows Compatibility Parameters

In the Console’s Change User Preferences window, use the Compatibility hide box to set DECwindows compatibility parameters. (Console ⇒ Setup ⇒ Change User Preferences ⇒ Compatibility)

Verify that the Be Compatible With Old DECwindows Vendor String and the Be Compatible with Old DECwindows Keyboards toggles are turned on. Call your system administrator if these have not been turned on.

Turn Off the Blinking Cursor

Neither the X Window System nor the NCD X server supports blinking cursors except in local terminal emulators. Consequently, the blinking cursors that appear in some DECwindows applications can affect performance because they consume both processor power and memory.

To reduce the effect of a blinking cursor, your system administrator should turn off blinking cursors as follows:

- In DECTerm windows
- On idle X terminal’s login and pause session boxes
- In dialog boxes in the FileView client

This procedure is provided in NCDware 3.2 Advanced User’s Guide for VMS Systems.
Incorrect Font Loading

Sometimes fonts are not loaded correctly when the X terminal boots. You can tell that fonts are incorrectly loaded if the following font problems appear in the Start Sessions dialog box:

☑ The copyright symbol (©) is missing from the Digital Equipment Corporation copyright lines
☑ The lines are not properly centered
☑ The font does not look like the font shown in Figure 9-3

Call your system administrator if your system does not load fonts properly.
OSF/Motif Environment on NCD X Terminals

OSF/Motif (mwm) is a popular user environment developed by the Open Software Foundation. The NCD local window manager, ncdwm, functions like OSF/Motif, but runs on the NCD X terminal instead of on a host computer.

This section contains information to help you use the host-based OSF/Motif software on your X terminal. It does not include a detailed description of how to use mwm tools, however, because OSF/Motif-style tools are described in detail in Chapter 7, Using the NCD Local Window Manager.

The usage instructions for ncdwm apply to the local client version of OSF/Motif 1.2.2 mwm, which provides standard host-based mwm functionality in a terminal-based (local) program.

For more information about OSF/Motif software, see the X Window System User’s Guide (Quercia and O’Reilly), cited in “Additional Documents” on p. vii.

Logging Into the OSF/Motif Environment

Usually you log onto a host running OSF/Motif software from an XDM banner, as described in “Logging In” on page 5-4.

Changing to mwm from ncdwm

If your terminal starts up with ncdwm, you can change to mwm, as follows:

1. In a terminal emulator window, set your DISPLAY environmental variable:
   - `% setenv DISPLAY ncdname` (for C shell users)
   - `or
   - `$ DISPLAY=ncdname:0; export DISPLAY` (for Bourne shell users)

2. Invoke mwm as a background process:
   - `% mwm &`
Disabling Backing Store

Backing store conserves an off-screen image. This increases the speed of redrawing of a window when it is exposed, but also uses memory. To save memory, disable backing store through the Console's Setup menu. (Console ⇒ Setup ⇒ Change User Preferences ⇒ X and Graphics)

☐ Select the Use Backing Store option button, then drag to and click on Disabled.
Glossary
Glossary

This glossary includes simple definitions of the X and NCDware terms used in this manual.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>acceleration</td>
<td>The parameter used to control the proportion of display screen represented by the mouse’s motion across the mouse pad.</td>
</tr>
<tr>
<td>parameter</td>
<td></td>
</tr>
<tr>
<td>access control</td>
<td>The process of restricting host or user access to terminal facilities or data.</td>
</tr>
<tr>
<td>active window</td>
<td>The window to which user input is focused. The active window is distinguished from other windows by different frame color or shading.</td>
</tr>
<tr>
<td>application</td>
<td>A program for a specific purpose, such as accounting or word processing. Applications and other programs written especially for X are called clients.</td>
</tr>
<tr>
<td>architecture</td>
<td>The design and structure of the software and/or hardware components comprising a system.</td>
</tr>
<tr>
<td>background</td>
<td>The solid color or tile pattern that usually underlies the characters or graphics in a window or menu.</td>
</tr>
<tr>
<td>backing store</td>
<td>An off-screen image saved when the window or a portion of a window is obscured.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>bitmap</td>
<td>A sequence of bytes representing a grid of pixels; used to form pointers, icons, and background window patterns.</td>
</tr>
<tr>
<td>boot</td>
<td>In NCD X terminals, the process of testing the terminal’s memory and loading the X software.</td>
</tr>
<tr>
<td>click-to-focus</td>
<td>The focus policy under which directing input to a window (making it the active window) is accomplished by clicking in the window. Click-to-focus is the default under most window managers, including ncdwm. See also focus.</td>
</tr>
<tr>
<td>client</td>
<td>An X Window System application program. Most clients run on a host computer, but some NCD servers include local clients that run on the NCD processor.</td>
</tr>
<tr>
<td>code memory</td>
<td>Terminal memory used for executing the X server in terminals with separate code and data memory. See also data memory.</td>
</tr>
<tr>
<td>Communications</td>
<td>Terminal memory used for executing the X server in terminals with separate code and data memory. See also data memory.</td>
</tr>
<tr>
<td>Communications</td>
<td>A removable printed circuit board in an NCD terminal’s base. Contains the Boot Monitor PROMs, optional server PROMs (on some interface modules), and network connectors. See also TRP interface board, ESP interface board.</td>
</tr>
<tr>
<td>configuration</td>
<td>A compatible assembly of computer hardware and software.</td>
</tr>
<tr>
<td>configure</td>
<td>To select and install compatible hardware and software components for a computer system. Configuring the computer network is a major part of a system administrator’s responsibility.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Console</td>
<td>The window used to access NCD User Services. Provides a hide box for displaying diagnostic messages and a menu bar for accessing other local clients.</td>
</tr>
<tr>
<td>CTERM</td>
<td>Command Terminal Protocol; a DECnet communication protocol.</td>
</tr>
<tr>
<td>CTerm client</td>
<td>A client used to provide VT320 terminal emulation using the CTERM protocol.</td>
</tr>
<tr>
<td>data memory</td>
<td>Memory used mainly by clients in terminals with separate code and data memory. See also code memory.</td>
</tr>
<tr>
<td>DCE</td>
<td>Data Communications Equipment. A device that provides the functions required to establish, maintain, and terminate a data-transmission connection; for example, a modem.</td>
</tr>
<tr>
<td>DEC</td>
<td>Digital Equipment Corporation.</td>
</tr>
<tr>
<td>DECnet</td>
<td>DEC networking software that runs over Ethernet in local- and wide-area networks.</td>
</tr>
<tr>
<td>DECnet address</td>
<td>A network address on DECnet. Consists of an area number and node.</td>
</tr>
<tr>
<td>DECterm</td>
<td>A VT320 (monochrome) terminal emulator or a VT340 (color) terminal emulator.</td>
</tr>
<tr>
<td>DECwindows</td>
<td>DEC's implementation of the X Window System. Based on X Version 11, Release 3, from MIT.</td>
</tr>
<tr>
<td>deiconify</td>
<td>To change an icon back into the window from which it was iconified.</td>
</tr>
<tr>
<td>Glossary</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dialer local client</td>
<td>A local client that provides a VT320 terminal emulator window for connecting to a host through the serial port. Includes options for starting and stopping PPP, SLIP, or XRemote through a Communications menu.</td>
</tr>
<tr>
<td>display</td>
<td>The video screen upon which output and input may appear, driven by a single driver.</td>
</tr>
<tr>
<td>display manager</td>
<td>A client used to start and manage X sessions. See also X Display Manager.</td>
</tr>
<tr>
<td>downloading</td>
<td>The process of transferring files from a host computer to the terminal’s memory.</td>
</tr>
<tr>
<td>dpi</td>
<td>Dots per inch. A measure of screen resolution.</td>
</tr>
<tr>
<td>DTE</td>
<td>Data Terminal Equipment. A device that acts as a data source, data sink, or both.</td>
</tr>
<tr>
<td>ECX</td>
<td>NCD’s Entry-level Color X terminal that accommodates NCD and third-party monitors.</td>
</tr>
<tr>
<td>ESP board</td>
<td>Ethernet/Serial/PCMCIA board. An NCD terminal interface board that incorporates two serial communication channels, an Ethernet interface, and a socket for a PCMCIA card.</td>
</tr>
<tr>
<td>Ethernet</td>
<td>A popular network protocol and a physical channel for transmitting data over coaxial cable, twisted-pair cable, or fiber-optic cable.</td>
</tr>
<tr>
<td>explicit focus</td>
<td>A focus method supported by ncdwm. Under explicit focus, a window becomes active when you click on it. It is different from click-to-focus only in that a newly opened window is not automatically the active window. See also focus.</td>
</tr>
<tr>
<td><strong>Glossary</strong></td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>File Manager</strong></td>
<td>A client used with Sun Microsystem’s OpenWindows to provide graphical file system utilities.</td>
</tr>
<tr>
<td><strong>FileView</strong></td>
<td>A client used with DEC’s DECwindows XUI to provide graphical file system utilities.</td>
</tr>
<tr>
<td><strong>focus</strong></td>
<td>To direct keyboard input to a specific window. The window to which focus is directed is called</td>
</tr>
<tr>
<td></td>
<td>the active window or the focus window. If the window manager is set to have pointer focus,</td>
</tr>
<tr>
<td></td>
<td>keyboard input is directed to the window under the pointer. If it is set to have click-to-focus,</td>
</tr>
<tr>
<td></td>
<td>the input is directed to a window in which you have clicked. See also click-to-focus, pointer</td>
</tr>
<tr>
<td></td>
<td>focus, and explicit focus.</td>
</tr>
<tr>
<td><strong>font</strong></td>
<td>A distinct set of character glyphs, such as 10-point Roman bold.</td>
</tr>
<tr>
<td><strong>font file</strong></td>
<td>A file that contains the definition of a font.</td>
</tr>
<tr>
<td><strong>font path</strong></td>
<td>The specification of the font directories from which to download fonts to an NCD terminal.</td>
</tr>
<tr>
<td><strong>font server</strong></td>
<td>An optional software module that can scale outline fonts and relieve the X server of all tasks</td>
</tr>
<tr>
<td></td>
<td>related to downloading fonts.</td>
</tr>
<tr>
<td><strong>gateway</strong></td>
<td>A computer that attaches to two or more networks and routes packets from one to the other.</td>
</tr>
<tr>
<td><strong>glyph</strong></td>
<td>The pictorial representation of a single character in a specific font. It is represented</td>
</tr>
<tr>
<td></td>
<td>internally by a bitmap.</td>
</tr>
<tr>
<td><strong>graphical user</strong></td>
<td>Software that facilitates the interaction between the computer and the user.</td>
</tr>
<tr>
<td><strong>interface (GUI)</strong></td>
<td></td>
</tr>
</tbody>
</table>
## Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>GUI</td>
<td>See <strong>graphical user interface</strong>.</td>
</tr>
<tr>
<td>helper program</td>
<td>In XRemote, a host-resident program used to facilitate communication between clients and the X server.</td>
</tr>
<tr>
<td>host</td>
<td>An individual device on a network, such as an NCD X terminal or a computer.</td>
</tr>
<tr>
<td>icon</td>
<td>A small symbol that represents a window.</td>
</tr>
<tr>
<td>icon box</td>
<td>A feature of some window managers that allows users to group their icons to save space on the screen.</td>
</tr>
<tr>
<td>iconify</td>
<td>To change a window into a small graphical representation. Processing may occur in an iconified window, but you cannot direct input to it.</td>
</tr>
<tr>
<td>input device</td>
<td>A device used to direct data and instructions to a processor. The keyboard and a mouse are the standard input devices used with the X terminal.</td>
</tr>
<tr>
<td>interface board</td>
<td>The removable printed circuit board in an NCD terminal base. Contains Boot Monitor PROMs and network connectors. May contain either a socket for a PCMCIA card or sockets for X server PROMs. See also Communications Interface Module, ESP board, TRP board.</td>
</tr>
<tr>
<td>Internet</td>
<td>The collection of networks and gateways that use the TCP/IP protocol family and function as a single cooperative network, connecting many businesses, universities, and government facilities.</td>
</tr>
<tr>
<td>LAN</td>
<td>See <strong>local area network</strong>.</td>
</tr>
<tr>
<td>LAT</td>
<td>See <strong>Local Area Transport</strong>.</td>
</tr>
</tbody>
</table>
### Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAT client</td>
<td>A client used for VT320 terminal emulation using the LAT protocol.</td>
</tr>
<tr>
<td>LED</td>
<td>Light-emitting diode. LEDs are built into NCD keyboards and some NCD monitors and bases. The LEDs on NCD keyboards are configurable and used for functions such as displaying network activity and the state of the Caps Lock key.</td>
</tr>
<tr>
<td>local area network (LAN)</td>
<td>A network of computers that are physically close, usually in the same building or group of buildings, connected by high-speed communication software and hardware such as Ethernet or Token-Ring.</td>
</tr>
<tr>
<td>Local Area Transport (LAT)</td>
<td>A DEC communication protocol used in local area networks. LAT is used by NCDware for connecting to non-X applications.</td>
</tr>
<tr>
<td>local client</td>
<td>A client that runs on the NCD X terminal instead of on a host.</td>
</tr>
<tr>
<td>local memory</td>
<td>Terminal memory located on a PCMCIA card.</td>
</tr>
<tr>
<td>local server</td>
<td>A compressed X server that can be booted from local memory.</td>
</tr>
<tr>
<td>local window manager</td>
<td>The <em>ncdwm</em> program; a local client that provides window management tools for an NCD X terminal. (A host-based version is also available.)</td>
</tr>
<tr>
<td>logging in</td>
<td>The process of providing a username and password to a host computer to verify that you are authorized to use the computer.</td>
</tr>
<tr>
<td>logging off</td>
<td>Terminating a session on a host computer.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>login</td>
<td>A user identification word used by a computer system to authenticate users. See also <strong>password</strong>.</td>
</tr>
<tr>
<td>login banner</td>
<td>A banner displayed on the screen to provide a means of entering the username and password for logging in.</td>
</tr>
<tr>
<td>Login Chooser</td>
<td>In NCDware, a popup window that provides a list of accessible hosts and allows selection of a host.</td>
</tr>
<tr>
<td>login host</td>
<td>When using an X terminal, the login host is the host that runs the login process used to begin the X session.</td>
</tr>
<tr>
<td>magic cookie</td>
<td>A secret password used under XDM to control access to a server and protect a user's display from unauthorized access.</td>
</tr>
<tr>
<td>MCX</td>
<td>Modular Color X terminal. A RISC-based NCD terminal that accommodates various NCD and third-party monitors.</td>
</tr>
<tr>
<td>menu</td>
<td>A list of items that can be selected by clicking a mouse button.</td>
</tr>
<tr>
<td>Minimal server</td>
<td>The NCDware X server configuration including all local clients except Test Network, Show Memory, Show Connections, Show Statistics, and <em>mwm</em>. It does not include XRemote, SIE, NCDaudio, or XTrap.</td>
</tr>
<tr>
<td>modem</td>
<td>A device that performs modulation and demodulation, converting digital signals to analog form (and vice versa) for transmission over telephone circuits.</td>
</tr>
<tr>
<td><strong>Glossary</strong></td>
<td></td>
</tr>
<tr>
<td>----------------</td>
<td></td>
</tr>
<tr>
<td><strong>modifier keys</strong></td>
<td>Keys such as Control, Alt, and Shift that modify the actions of other keys. X also supports a set of logical modifier key functions (such as the meta key) that can be mapped to physical keys.</td>
</tr>
<tr>
<td><strong>Motif</strong></td>
<td>See OSF/Motif; mwm.</td>
</tr>
<tr>
<td><strong>mouse</strong></td>
<td>A hand-held input device used with X terminals to direct the movement of the screen pointer.</td>
</tr>
<tr>
<td><strong>mwm local client</strong></td>
<td>A local window manager with the same functionality as the host-based OSF/Motif 1.2.2 window manager; see also ncdrunwm and ncdwm.</td>
</tr>
<tr>
<td><strong>NCD User Services</strong></td>
<td>NCD's set of utilities to access hosts and clients, customize the X environment, and examine network and terminal statistics.</td>
</tr>
<tr>
<td><strong>NCDnet</strong></td>
<td>A software option that allows an NCD terminal to participate fully in a DECnet network as a DECnet phase IV end node. It is the same software as DECnet, but licensed through NCD.</td>
</tr>
<tr>
<td><strong>ncdrunwm</strong></td>
<td>A companion program to ncdwm. ncdrunwm runs on the host, sends a description file to the window manager running inside the terminal, starts applications, and connects to other hosts.</td>
</tr>
<tr>
<td><strong>NCDware</strong></td>
<td>NCD's software for X terminals.</td>
</tr>
<tr>
<td><strong>ncdwm</strong></td>
<td>NCD's local window manager program. See also local window manager.</td>
</tr>
<tr>
<td><strong>network</strong></td>
<td>A collection of computing devices connected by communication hardware and software.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Network File System</td>
<td>A protocol developed by Sun Microsystems that allows a set of computers to access each other's file systems as if they were local; used on NCD units to support font files, the color definition file, and remote configuration files.</td>
</tr>
<tr>
<td>NFS</td>
<td>See Network File System.</td>
</tr>
<tr>
<td>NVRAM</td>
<td>Non-volatile random-access memory used to store parameter settings in NCD terminals when the power is off. NVRAM Version 3 is used with the NCDware X server.</td>
</tr>
<tr>
<td>OPEN LOOK</td>
<td>A graphical user interface specification developed by Sun Microsystems and registered by UNIX Systems Laboratories, Inc.</td>
</tr>
<tr>
<td>OpenWindows</td>
<td>Sun Microsystem's X-based user environment.</td>
</tr>
<tr>
<td>OSF/Motif</td>
<td>Open Software Foundation's graphical user interface; used by the NCD local window manager.</td>
</tr>
<tr>
<td>output device</td>
<td>The device used to receive the output from a processor. The display screen is often the output device used by X terminal users. Another frequently used output device is a printer.</td>
</tr>
<tr>
<td>parallel port</td>
<td>Port available for parallel-line communications on terminals in the ECX family.</td>
</tr>
<tr>
<td>parameter</td>
<td>A definable characteristic of an item, device, or system.</td>
</tr>
<tr>
<td>password</td>
<td>A user-defined word used to authenticate computer system users.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PCMCIA card</td>
<td>Integrated circuit defined by the Personal Computer Memory Card International Association. The card provides local memory for storing a terminal’s X server, fonts, and configuration files.</td>
</tr>
<tr>
<td>pixel</td>
<td>The smallest element of the display grid of a graphics display device. The name comes from an abbreviation of the words picture element.</td>
</tr>
<tr>
<td>Point-to-Point Protocol</td>
<td>See PPP.</td>
</tr>
<tr>
<td>pointer</td>
<td>A device used by the user to communicate with the server. Pointer also refers to the symbol that represents the device’s location on the screen (for example, an X or an arrow shape).</td>
</tr>
<tr>
<td>pointer focus</td>
<td>A focus method supported by ncdwm. Under pointer focus, a window becomes active when you place the pointer on it. See also focus.</td>
</tr>
<tr>
<td>popup window</td>
<td>A window that appears on the screen in response to selecting an item from a menu. It is used to enter information that a client needs to operate. In most applications, items that invoke popup windows are indicated by ellipses (...). Also called a dialog box.</td>
</tr>
<tr>
<td>PPP</td>
<td>Point-to-Point Protocol. A proposed Internet standard for transmitting datagrams over serial links. See also SLIP.</td>
</tr>
<tr>
<td>programmable read-only memory (PROM)</td>
<td>Memory chips used to store the server in PROM-based X terminals; also used to store the booting software in all NCD X terminals.</td>
</tr>
<tr>
<td>PROM</td>
<td>See programmable read-only memory.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>protocol</td>
<td>A formal description of message formats and the rules machines must follow to exchange those messages.</td>
</tr>
<tr>
<td>reboot</td>
<td>See boot.</td>
</tr>
<tr>
<td>remote configuration</td>
<td>A method of configuring an NCD X terminal by downloading a file containing operational parameters from a host computer.</td>
</tr>
<tr>
<td>root menu</td>
<td>In using ncdwm and other GUIs, root menus are menus that are accessed by placing the pointer on the root window and clicking on a mouse button. The system administrator can configure the root menu.</td>
</tr>
<tr>
<td>root window</td>
<td>A window that fills the screen during an X session; all windows opened by clients appear on top of the root window.</td>
</tr>
<tr>
<td>router</td>
<td>The device responsible for deciding which path network traffic should follow. In the Internet, an IP gateway is a router.</td>
</tr>
<tr>
<td>RS-232 C</td>
<td>A industry standard for serial communications connections.</td>
</tr>
<tr>
<td>Serial client</td>
<td>A local client that provides a VT320 terminal emulator window for connecting to a host through the serial port.</td>
</tr>
<tr>
<td>serial communication</td>
<td>A type of data transmission in which data and instructions are sent one after the other over the same wire.</td>
</tr>
<tr>
<td>serial port</td>
<td>Located on all NCD terminals. For attaching a modem, printer, or other serial device.</td>
</tr>
<tr>
<td>server</td>
<td>An X server. (See X server.) Also a device on a network providing a service, such as a boot server or a print server.</td>
</tr>
<tr>
<td>Glossary</td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td></td>
</tr>
<tr>
<td><strong>session</strong></td>
<td>See X session.</td>
</tr>
<tr>
<td><strong>Session Manager</strong></td>
<td>The DECwindows client used to control DECwindows sessions.</td>
</tr>
<tr>
<td><strong>Setup key</strong></td>
<td>The key or combination of keys used to display the Console. See also Setup key combination.</td>
</tr>
<tr>
<td><strong>Setup key combination</strong></td>
<td>On keyboards that do not have a Setup key, a combination of keys may be used instead to invoke the Console.</td>
</tr>
<tr>
<td><strong>shell</strong></td>
<td>Also called a command interpreter. The user types commands at a prompt, and the commands are accepted and passed to the operating system for execution. On an X terminal, a shell is often accessed through an xterm terminal emulator.</td>
</tr>
<tr>
<td><strong>SLIP</strong></td>
<td>Serial Line Internet Protocol. A defacto standard protocol for transmitting IP datagrams over serial links. See also PPP.</td>
</tr>
<tr>
<td><strong>Standard server</strong></td>
<td>The NCDware server configuration including all local clients (except mwm), XRemote, NCDaudio, XTrap, and SIE.</td>
</tr>
<tr>
<td><strong>SunOS</strong></td>
<td>Sun Microsystem’s implementation of the UNIX operating system.</td>
</tr>
<tr>
<td><strong>system administrator</strong></td>
<td>An individual responsible for managing the computers and network at a computer site.</td>
</tr>
<tr>
<td><strong>TELNET</strong></td>
<td>The Internet standard protocol for remote terminal connection services.</td>
</tr>
<tr>
<td><strong>Glossary</strong></td>
<td></td>
</tr>
<tr>
<td>----------------</td>
<td></td>
</tr>
<tr>
<td><strong>Telnet client</strong></td>
<td>The local client that provides VT320 terminal emulation for connecting to a host using TELNET.</td>
</tr>
<tr>
<td><strong>terminal emulator</strong></td>
<td>A client used to mimic the function of a terminal so that you can use non-X applications in X windows. <em>xterm</em>, the standard X terminal emulator, emulates a VT102 terminal. NCD’s local client terminal emulators Telnet, LAT, CTerm, and Serial, emulate VT320 terminals.</td>
</tr>
<tr>
<td><strong>terminal server</strong></td>
<td>A device that connects X terminals to services or hosts in a local area network.</td>
</tr>
<tr>
<td><strong>threshold parameter</strong></td>
<td>A parameter used to specify at which point the acceleration parameter should come into effect in controlling mouse motion. You can change the threshold parameter using the Console’s Setup menu’s Change User Preferences submenu.</td>
</tr>
<tr>
<td><strong>Token-Ring</strong></td>
<td>A network protocol popular in the IBM world in which a token (a continuously repeating frame) is passed sequentially from station to station. Only the station that has the token can communicate on the network.</td>
</tr>
<tr>
<td><strong>Transmission Control Protocol/Internet Protocol (TCP/IP)</strong></td>
<td>Networking protocols commonly used for communication over local area networks.</td>
</tr>
<tr>
<td><strong>TRP board</strong></td>
<td>Token-Ring/PCMCIA. An interface board that incorporates a Token-Ring connector and a socket for a PCMCIA card.</td>
</tr>
<tr>
<td><strong>UNIX</strong></td>
<td>A portable, multi-user time-sharing operating system developed in the early 1970s.</td>
</tr>
<tr>
<td><strong>VAX</strong></td>
<td>A type of computer manufactured by DEC.</td>
</tr>
</tbody>
</table>
### Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>vi</td>
<td>A UNIX visual text editor.</td>
</tr>
<tr>
<td>VMS</td>
<td>Virtual Memory System; the operating system for a VAX computer.</td>
</tr>
<tr>
<td>VT102, VT220</td>
<td>Widely used terminal emulation standards.</td>
</tr>
<tr>
<td>VT320</td>
<td>The terminal emulation standard used in <code>ncdtterm</code>.</td>
</tr>
<tr>
<td>window</td>
<td>In X, a region on the display created by a client. Windows can be manipulated by a window manager.</td>
</tr>
<tr>
<td>window manager</td>
<td>A host-based or local client that allows you to manipulate windows on a display.</td>
</tr>
<tr>
<td>X</td>
<td>See X Window System.</td>
</tr>
<tr>
<td>X 11 Release 5 (X11R5)</td>
<td>The current release of the X Window System, implemented by NCD in NCDware.</td>
</tr>
<tr>
<td>X Consortium</td>
<td>The guiding organization for the development of standards for the X Window System. It is made up of more than 90 corporations and universities, including NCD. It is chaired by the Massachusetts Institute of Technology (MIT).</td>
</tr>
<tr>
<td>X Display Manager (XDM)</td>
<td>A protocol that provides automatic X protocol connection to a specified host when an X terminal is reset.</td>
</tr>
<tr>
<td>X server</td>
<td>The software that provides display services for clients and handles keyboard and pointer input. This is the part of the X Window System that runs in NCD X terminals.</td>
</tr>
<tr>
<td>X session</td>
<td>All the processing that goes on from the time you log in to use the X Window System until you log out.</td>
</tr>
<tr>
<td><strong>Glossary</strong></td>
<td></td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>X terminal</strong></td>
<td>A display monitor, keyboard, base containing processors, and a mouse. The X terminal processors are dedicated to running the X server.</td>
</tr>
<tr>
<td><strong>X Window System</strong></td>
<td>A network-based graphical window system developed at MIT to allow workstation users to use applications running on more than one host.</td>
</tr>
<tr>
<td><strong>XDM</strong></td>
<td>See X Display Manager.</td>
</tr>
<tr>
<td><strong>XRemote</strong></td>
<td>NCD's software for running X over a serial line.</td>
</tr>
<tr>
<td><strong>XRemote/Serial</strong></td>
<td>The XRemote operating mode involving use of NCD's proprietary, non-networked protocol for serial connectivity.</td>
</tr>
<tr>
<td><strong>XRemote/TCP</strong></td>
<td>The XRemote operating mode involving use of TCP/IP transport protocols run over PPP, SLIP, and Ethernet or Token-Ring.</td>
</tr>
<tr>
<td><strong>xterm</strong></td>
<td>The standard X terminal emulator gives you a box in which to type commands or run a program. See also terminal emulator and local client.</td>
</tr>
</tbody>
</table>
The following books describing the X Window System are available at computer book stores.

**Books About the X Window System**

The following books describe the X Window System for new users and system administrators:

Bibliography

Biblio-2
Index
Numerics
80/132 switching, see terminal emulator, Options menu

A
access control
of Console 6-2 to 6-5
of keystrokes 6-25
of X terminal, see screen, locking
via security keyboard 4-6
with DECwindows applications 9-13
active window, see window, active
application cursor mode, see terminal emulator, Options menu
application keypad mode, see terminal emulator, Options menu
applications
closing 7-9, 7-20
example 2-5
calculator 3-8
clock 3-8
mail 3-8
print screen 3-7
voice mail flag 1-5
font path, affects appearance of 6-39
for X
described 3-7 to 3-9
for EXPORT Catalog information 3-12
illustrated 2-5 to 2-6
non-X compatible 3-5, 3-8
see also clients; graphical user interface (GUI); graphics applications; window manager

applications (continued)
starting
automatic 1-5
via Console 1-3
via DCL command 9-20, 9-24
via root menu 1-6, 7-4 to 7-6

B
backing store 6-42, 9-28
bell
customizing 6-4, 6-33
duration 6-33
margin 6-25
pitch 6-33
preferences, illustrated 6-33
stopping the sound 6-3
test 6-33
visual 6-23
volume 6-33
Boot Monitor, version 6-48
booting
defined 1-2, 5-2
example 1-2
host 6-49
identifies keyboard group 4-6
procedure 6-12
PROMs 5-3
see also terminal emulator, File menu
X server 6-3

C
calculator utility 3-8
Index

Change User Preferences 6-27 to 6-44
  audio options, illustrated 6-45
  bell options, see bell
  compatibility options, see NCDware, compatibility
  console and utilities options, illustrated 6-44
  enforcing/canceling changes 6-30
File menu
  connecting to another terminal 6-29
  reading preferences from a file 6-29
  saving preferences to a file 6-29, 6-46
font options, see fonts
illustrated 6-4, 6-27
keyboard options, see keyboard
mouse options, see mouse
pointing devices options, see mouse
power management options, see power management
purpose 6-4
saving preferences 6-46
screen background options, see screen, background
screen saver options, see screen, saver
Sections menu, opening/hiding 6-29
X, graphics, and SIE options, see graphics applications
clicking, see mouse, actions
click-to-focus, see focus policy, click-to-focus
clients
  defined 1-5, 2-6, 2-11
  described 3-7 to 3-9
  example 2-11, 3-7
  function 2-9
  see also applications; window manager; graphical user interface (GUI)
clock utility 3-8
closing, see applications, closing; logging, out; terminal emulator, closing; window, closing
Command Terminal Protocol, see CTerm
command tool, see OpenWindows, command tool
communication protocol
CTERM
  see also CTerm
DECnet 3-5, 6-49
  over Ethernet 3-11
Ethernet 2-14, 6-47
  address 6-49
  see also Ethernet
  using DECnet 3-11
  using LAT 3-11
  using NCDnet 3-11
  using TCP/IP 3-11
LAT 3-5
  and DEC 3-5
  over Ethernet 3-11
  see also LAT
NCDnet
  address 6-49
  name 6-49
  over Ethernet 3-11
  see also communication protocol, DECnet
RS-232 C 3-11, 8-5, 8-7
serial 3-5
  see also serial
TCP/IP 2-14, 3-5
  address 6-19, 6-49
  name 6-19, 6-49
  netmask 6-49
  over Ethernet 3-11
  over Token-Ring 3-11
TELNET 3-5
  see also Telnet
Token-Ring 2-14, 6-47
  address 6-49
  using TCP/IP 3-11
compatibility, see NCDware, compatibility
computer use
  batch processing, illustrated 2-2
  history 2-1 to 2-4
computer use (continued)
  network, illustrated 2-4
  see also network; X Window System
standalone, illustrated 2-3
time-sharing, illustrated 2-2
work group, illustrated 2-3
configuring
  keyboard 4-6
  X terminal 5-2
connecting to
  applications, see applications, starting
  hosts, see host, connecting
new unit 6-29
Console 3-3 to 3-6, 6-2 to 6-52
  access control 6-2, 6-4
  also called NCD User Services 6-1
  alternative access methods 4-8
  closing 6-3
  Console menu
    illustrated 6-3
    purpose 6-3
  defined 3-3, 6-1
  illustrated 1-2
  in OpenWindows, illustrated 9-3
Login menu 5-8
  example 1-17
  illustrated 6-3
  purpose 6-3
menus 6-2 to 6-5
message area
  illustrated 6-6
  resizing 6-6
  see also diagnostic, messages
opening
  example 1-16
  via the Setup key 6-2
purpose 1-3
Setup menu
  illustrated 6-4
  purpose 6-4
  see also Change User Preferences
Console (continued)
  Statistics menu 6-47 to 6-52
    for system administrators 6-52
    illustrated 6-5, 6-47, 6-52
    purpose 6-5
  Terminals menu
    illustrated 6-3
    purpose 6-3
  utilities
    listed 3-3
Utilities menu
  example 1-16
  illustrated 1-16, 6-4
  purpose 6-4
WindowMgr menu 6-4
toggling ncdwm 7-3
Console menu, see console, Console menu
copying text 1-14, 3-9
CTerm
  connection
    via Console 6-3, 6-15
curses emulator 6-24
cursor
  blinking 6-25, 9-25
  for active window 9-7
  for inactive window 9-7
customizing work environment, see
  Change User Preferences; system administra-
tion
D
DECnet, see communication protocol, DEC-
et
DECwindows Motif 9-10 to 9-26
  applications
    access control by 9-13
    FileView 9-12, 9-13
    Session Manager 9-12, 9-13, 9-18
  compatibility with NCDware 9-25
cursor, effects of blinking 9-25
defined 2-13, 9-10
DECwindows Motif (continued)
dialog boxes 9-17
documentation 9-10
environment, customizing 9-15 to 9-16, 9-18 to 9-24
focus policy 9-15
logging in 9-10 to 9-12
  banner, illustrated 9-11
display, illustrated 9-12
login name 9-11
password 9-11
purpose 9-11
via Start Session dialog box 9-11
menu
  illustrated 9-20
types, described 9-16
  Workspace (root) menu 9-15
mouse button terminology 9-10
ncdwm and 9-22
pointers 9-16
procedures
  starting local terminal emulators 9-19 to 9-22
  using the local window manager 9-22 to 9-24
scroll bars 9-17
tips for running 9-25 to 9-26
window tools 9-14 to 9-17
window, illustrated 9-14
deiconifying, see window, deiconifying
diagnostic
  log file, see terminal emulator, File menu; terminal emulator, Options menu
messages
  categories of 6-7
deleting output 6-3
examples 6-7
fonts 6-7, 6-40
illustrated 6-6
recalling deleted output 6-3
see also Console, message area
diagnostic (continued)
  network testing 6-4
  status line, see terminal emulator, Options menu
testing 5-3
time stamps, toggling 6-44
Dialer client
  compared to Serial client 8-13
  connection via Console 6-16
  purpose 8-13
  usage 8-13 to 8-14, 8-18 to 8-19, 8-20 to 8-21
Digital Command Language (DCL)
  starting local clients 9-20
  starting local window manager 9-24
DISPLAY variable 6-19
documentation
  DECwindows, additional 9-10
  EXPORT Catalog of X products 3-12
  help, online 3-7
  NCD, related x to xii
  OpenWindows, additional 9-2
  OSF/Motif, additional 9-27
  XRemote, additional 3-11
double clicking, see mouse, actions
dragging, see mouse, actions
E
ECX terminal
  hardware requirements 3-11
  parallel port 3-11
80/132 switching, see terminal emulator, Options menu
emulator, see terminal emulator
enlarging, see window, resizing
Ethernet
  connections 3-11
  illustrated 3-10
  see also communication protocol, Ethernet
explicit focus, see focus policy, explicit focus
EXPORT Catalog 3-12
F

File Manager, see OpenWindows, applications
File menu, see Change User Preferences, File menu; terminal emulator, File menu
focus policy 4-9 to 4-11
  changed by system administration 4-10
  click-to-focus 4-9, 7-10, 9-7
    DECwindows Motif 9-15
defined 1-9
explicit focus 4-9, 7-10
  DECwindows Motif 9-15
implicit focus
    DECwindows Motif 9-15
ncdwm 7-10
  default 7-10
olwm
  click SELECT mode 9-7
  move pointer mode 9-7
pointer focus 4-9, 7-10, 9-7
  DECwindows Motif 9-15
fonts
diagnostic messages, requesting 6-7, 6-40
downloaded
  from host 3-6
  incorrectly 9-26
European characters, see terminal emulator, Options menu
font directory
  adding 6-40
deleting 6-40
font paths
customizing 6-39 to 6-40, 9-8
effects on X server, memory, clients 6-39
Font Server
canceling a font request 6-3
defined 2-10
development 3-6
diagnostic messages 6-40
  Font Server (continued)
    function 3-6
generating a font request 2-11
  references for additional information 3-6
Fonts menu in terminal emulator 6-25
format conversion 3-6
number in use 6-51
preferences, illustrated 6-39
rescanning the font path 6-4
scalable 3-6
function key mapping, see keyboard, mapping
G
generating lines, see terminal emulator, Options menu
graphical user interface (GUI) 2-12 to 2-13
defined 3-2
see also Console; window manager
graphics applications
  backing store
    defined 6-41
  enabling/disabling 6-41, 9-28
customizing for use with X 6-41 to 6-42
  factors affecting performance 6-41
  optimizing for benchmarks 6-41
  optimizing for speed 6-41
  preferences, illustrated 6-41
  resource usage 6-51
  screen resolution, changing 6-41
  SIE 6-41 to 6-42
    specifying the contrast 6-42
    specifying the sampling method 6-42
GUI, see graphical user interface
H
hardware
  monitor 3-1
  parallel port 3-11
  power switch 5-2
Index

hardware (continued)
see also Ethernet; interface board; keyboard;
mouse; PCMCIA card; PROMs; serial
port; Token-Ring; XRemote, hardware
requirements; X terminal
trackball 4-2
help, online
OpenWindows 9-8
UNIX, xman 3-7
VMS, help 3-7
host
access control 9-13
-based utilities
DECterm 3-8
help 3-7
print screen 3-7
xbiff 3-8
xcalc 3-8
xclock 3-8
xman 3-7
xpr 3-7
xterm 3-8
xwd 3-7
xwud 3-7
boot 6-49
connecting
Default Hosts list 5-5
transparency with X 2-8
via Console 1-3, 6-15 to 6-19
via local terminal emulator 3-5
via Login Chooser 1-3, 5-5
via protocol, see communication protocol
via root menu 1-6, 7-5 to 7-7
via serial port 3-5, 6-15
example 1-3
list
contents of 9-13
displaying 6-16
illustrated 6-16
login 6-49
name needed vi
selecting 1-3, 5-5, 6-17

host (continued)
setup by system administration vi
UNIX 6-19
VMS 6-19, 9-11
X 19-19, 9-11
XRemote, hardware
requirements; X terminal

icon
defined 4-13, 7-18
illustrated 4-13, 7-18
see also icon box; window, iconifying;
window, deiconifying

icon box
comparison with other windows 7-18
defined 4-13, 7-18
illustrated 4-13, 7-18
see also window, iconifying; window, deiconifying

information sources, see documentation
input devices, see keyboard; mouse; trackball
installing, see system administration

interface board
Communications Interface Module,
requirements 3-10
ESP (Ethernet/Serial/PCMCIA) board
requirements 3-10
serial ports, additional 8-6
TRP (Token-Ring/PCMCIA) board,
requirements 3-11

interface, see graphical user interface (GUI);
keyboard; mouse; trackball; window

Internet Protocol (IP) address 6-49

K
keyboard
access control 4-6
autorepeat, enabling/disabling 6-31
configuring 4-6
controlled by X server software 2-9
customizing 6-4, 6-31 to 6-32
keyboard (continued)
  foreign language 4-6
  getting information about your 6-48
  groups 4-6
  illustrated 4-5
  keys 4-7
    cursor (arrow) 4-7
    edit 4-7
    function 4-7
    legends 4-7
    numeric/application keypad 4-7
  LEDs, changing the function 6-32
  mapping
    old DEClwindows modifier keys 6-43
    Sun special keys 9-9
    UNIX function keys 6-31
    VMS function keys 6-31
  model 4-6
  preferences, illustrated 6-31
  purpose 3-1
  security 4-6
  volume of keyclicks, setting 6-31

logging, in (continued)
  to terminal emulator 6-18
  user name 5-6
  utility 6-3
  via Console Login menu 6-8
  via Login Banner 5-6
  via Login Chooser 5-5

login banner 5-5
  defined 1-4
  illustrated 1-4, 5-6
  procedure 5-6

Login Chooser 1-2 to 1-3, 5-4
  DEClwindows Start Session dialog box 9-11
    for new host connection 6-3
    illustrated
    procedure 5-5
    purpose
      starting new X session 1-17

login host 6-49
Login menu, see Console, Login menu
login name
  needed vi
typing into login banner 1-4

out 5-8
  automatic 6-11
  example 1-17
  utility 6-3
  via Console Login menu 5-8, 6-10
  via root menu 5-8

mail utility 3-8
manager, system, see system administration
manuals, see documentation
memory
  amount installed, getting
    information 6-49, 6-50
  consumption
    affected by font path 6-39
    saving via backing store 6-42
    illustrated 6-50
Index

memory (continued)
installing, references for x
testing, references for x
Messages hide box, see Console, message
area; fonts, diagnostic messages
modem, see XRemote, modem
monitor, function 3-1
mouse 4-2 to 4-5
  acceleration, setting 6-34
  actions 4-3 to 4-4
  button
    mapping 4-5, 6-35
    terminology 4-5, 9-4, 9-10
closing window
  example 1-14
  illustrated 1-14
controlled by X server software 2-9
copying text, example 1-14
customizing 6-4, 6-34 to 6-35
described 4-3
illustrated 4-2
moving window, illustrated 1-13
pasting text, example 1-14
pointer motion, controlling 4-4, 6-34
preferences, illustrated 6-34
purpose 3-1
resizing window
  example 1-11
  illustrated 1-11
selecting window, example 1-9
threshold distance, setting 6-34
moving windows, see window, moving
mwm, see ncdwm; OSF/Motif; window manager

N
NCD User Services 3-2 to 3-6, 6-1 to 6-52
  defined 3-2, 6-1
  listed 3-3
  see also Console
ncdlaunchd, for backwards
  compatibility 3-4

NCDnet, see communication protocol, NCDnet
ncdrunwm 7-2
  DECwindows and 9-12
  function 3-4
NCDware 3-2 to 3-9
  boot host for X server 6-49
  compatibility
    preferences, illustrated 6-43
    with DECwindows 6-43, 9-10, 9-25
    with non-standard clients 6-43
    with OpenWindows 9-2
  defined 3-2
  see also Console; fonts, Font Server;
    ncdrunwm; ncdwm; terminal emulator;
    window manager; X Window System, X
    server
  servers v, 2-10, 6-48
  version 6-48
ncdwm 7-1 to 7-21
  benefits 2-12, 3-4
  client, host-based 7-2
  client, local 7-2
  companion software, see ncdrunwm
  comparison
    host-based versus local 7-2
    with OSF/Motif 7-2
  DECwindows Motif and 9-12, 9-22
  defined 1-9
  example 1-9
  exiting 7-4
  focus policy, see focus policy
  function 3-4
  mwm and 9-27
  pointer
    arrow 7-11
    crossed-arrow 7-11
  defined 7-11
  illustrated 7-11
  resizing arrows 7-11
  root 7-11
  see also pointer
Index

pointer (continued)
  watch 7-11
root menu, see root menu
see also X Window System
starting 6-4, 6-13 to 6-14
  applications 7-4 to 7-6
  automatically 7-3
  from UNIX 7-3
  from VMS 7-3
  restarting while running 7-4
  via Console 7-3
  via remote configuration 7-3
stopping 6-4, 7-4
tools, see window manager, tools
window, see window

network
  communication
    channels 2-9
    connections 3-11
    illustrated 3-10
    see also communication protocol
  computing
    benefits 2-8
    example 2-4 to 2-6
    history 2-1 to 2-4
    illustrated 2-4 to 2-6
    processing power, distributed 2-8
    transparency with X 2-8
  defining parameters 6-4
  example 1-1
  statistics 6-52
  testing 6-4
Network File System 3-11
NFS, see Network File System

O
olwm, see OpenWindows, olwm
on switch 5-2
online help, see help, online
OPEN LOOK, see OpenWindows, olwm
Open Software Foundation, see OSF/Motif

OpenWindows 9-2 to 9-9
  applications
    Calendar Manager V3, illustrated 9-5
    DeskSet 9-7
    File Manager 9-2, 9-7
    quitting 9-6
    Save Workspace utility 9-9
  bug fix 9-9
  command tool 9-9
    defined 9-2, 9-7
    illustrated 9-3
  compatibility, screen resolution 9-9
  cursor
    for active window 9-7
    for inactive window 9-7
    defined 9-2
  documentation
    additional sources 9-2
    online 9-8
  focus policy
    click SELECT mode (default) 9-7
    move pointer mode 9-7
  fonts 9-8
  keyboard
    help key 9-8
    remapping 9-9
  logging in 9-2
  login display, illustrated 9-3
  mouse
    ADJUST button 9-4
    MENU button 9-4
    SELECT button 9-4
    usage 9-4
  olwm
    also called OPEN LOOK 9-2
    described 2-13
    online documentation 9-8
  pointer
    defined 9-4
    listed 9-4
    see also pointer
OpenWindows (continued)
  prompt
    command tool 9-9
    shell tool 9-9
    SunOs 9-9
    shell tool 9-9
    defined 9-7
  starting
    automatically 9-2
  tips for running 9-8 to 9-9
  tools
    border 9-5
    control area 9-5
    header 9-5
    menu button 9-5
    window pane 9-5
  window
    actions summarized 9-6
    closing 9-6
    hierarchy, changing 9-6
    managing 9-5 to 9-6
    menu 9-5
    moving 9-6
    resizing 9-6
  Workspace
    defined 9-4
    menu 9-7
  operating system
    independence from X 2-8
    name needed vi
    see also X Window System, X server; NCD
    ware
  UNIX
    example 1-10
    help, online 3-7
    VMS 9-10
    help, online 3-7
  Options menu, see terminal emulator,
    Options menu
  OSF/Motif 9-27 to 9-28
    defined 2-13
    documentation, additional sources 9-27
OSF/Motif (continued)
  logging in, see logging, in
    mwm
    changing to 9-27
    local version 7-1
    local versus host-based 9-27
    ncdwm and 7-2, 9-27
    see also ncdwm; window manager
    starting via command 7-3
    starting via Console 7-3

P
  parallel port 3-11
  password
    for locking the screen 1-17, 6-8 to 6-9
    for logging in 5-6, 6-19
      DECwindows environment 9-11
      name needed vi
      purpose 1-4
      to another terminal 6-29
    pasting text 1-14, 3-9, 6-21, 6-48
  PCMCIA cards
    for XRemote 2-10, 8-4
    with X server 3-2
  pointer
    controlling motion 4-4
    DECwindows Motif 9-16
    defined 4-3, 7-11
    illustrated 7-11
    ncdwm 7-11
    OpenWindows 9-4
  pointer focus, see focus policy, pointer focus
  pointing devices, see mouse 6-34
  power management
    customizing the settings 6-39
    enabling the feature 6-39
    Energy Star requirements 6-38
    for VESA-compliant terminals 6-38
    preferences, illustrated 6-38
    warning 6-38
  power switch 5-2
  pressing, see mouse, actions
printing
  log buffer 6-23
  screen 3-7, 6-22
  to parallel port 6-22
  to remote unit 6-22
  to serial port 6-22
programs, see applications; clients
prompt
  login 5-6, 6-19
  password 5-6
  SunOs 9-9
  UNIX 7-8
PROMs
  boot 5-3
  location 3-2
  X server 3-2
  XRemote 2-10, 8-4
protocols, see communication protocol
Q
quitting, see applications, closing; logging, out; terminal emulator, closing; window, closing
R
reading from file, see Change User Preferences, File menu
rebooting, see booting
redrawing, see Console, Utilities menu; terminal emulator, File menu
releasing, see mouse, actions
remote configuration, see system administration
resizing, see window, resizing
resource setting 7-21
reversing video, see terminal emulator, Options menu
root menu 7-4 to 7-6
  connecting to hosts 5-8
  customized by system administration 7-4, 7-5
root menu (continued)
  defined 1-6, 7-4
  described 3-4
  example 1-6, 1-12
  illustrated 1-6, 3-4
  purpose 1-6
  setup 1-6
  starting applications 5-8, 7-4
  system administration, set up by 3-4, 5-8
root window
  defined 1-6, 4-8, 7-16
  Workspace in OpenWindows 9-4
S
saving to file, see Change User Preferences, File menu
screen
  background
    customizing 6-4, 6-36
    preferences, illustrated 6-36
  blanking 6-4
  compatibility, resolution 9-9
  dump 3-7
  getting information about your 6-48
  locking 6-4, 6-8 to 6-9
    automatic 6-9
    example 1-16
    illustrated 1-16, 6-9
    password 6-8
  print 3-7
  redrawing 6-4
  refreshing 6-4
  resolution filter for OpenWindows 9-9
  saver 6-4
  customizing 6-4, 6-37
  delay, setting 6-44
  preferences, illustrated 6-37
  unlocking 6-9
  with ncdwm window manager,
    illustrated 6-14
  without window manager,
    illustrated 6-13
scrolling, see terminal emulator, Options menu
Sections menu, see Change User Preferences, Sections menu
security, see access control; screen, locking
selecting text 1-14, 3-9
serial
  communication
    connections 3-11
    illustrated 3-10
connection
  cancelling 6-3
  via Console 6-3, 6-15, 6-16
port 3-5, 3-11
  illustrated 8-5
  see also XRemote, serial ports
protocol 3-5
server
  defined 2-9 to 2-11
  list 6-48
  see also fonts, Font Server; X Window System, X server
Session Manager, see DECwindows, applications
setting up, see Console, Setup menu; system administration
Setup key
  equivalent key combinations 4-8
  customizing 6-44
  opening Console 1-16, 4-8
shell tool, see OpenWindows, shell tool; terminal emulator, shell tool
SIE 6-41 to 6-42
Simple Imaging Extension, see SIE
sizing, see window, resizing
software, see applications; clients
starting, see applications, starting; logging, in; ncdwm, starting; terminal emulator, starting; window, opening; X terminal, powering up
startup file, see system administration, startup file
Statistics menu, see Console, Statistics menu
system administration
  access control
    of menu selections 6-2
    of Setup menu tools 6-4
  alternatives to vi
  bug fix, SunOS prompt 9-9
  configuring
    local terminal emulator vi
    login methods, alternative 1-3, 9-10
    ncdrunwm 9-15
    remote configuration 3-3
    window manager vi
    X display manager vi
    XRemote vi
  control
    of commands and utilities 4-6
    cursor, turn off blinking 9-25
  defining setup parameters 6-4
  documentation used by x to xii
  focus policy, changing 4-10
  fonts, fix incorrect downloading 9-26
  hosts list, creation and maintenance 9-13
  information used by 6-52
  loading user preferences 6-46
  misplaced/missing icons, resolving 9-9
  resolution incompatibility, resolving 9-9
  root menu
    customizing 7-4, 7-5
    setup 1-6, 3-4, 5-8
  saving user preferences 6-46
startup file
  .xsession, UNIX 5-7, 9-9
  creation vi, 5-6 to 5-7, 7-3, 9-11
  customizing 9-2
DECW$XDEFAULTS.DAT, VMS 5-7, 9-12
LOGIN.COM, VMS 5-7, 9-12
system administration (continued)
utilities used by 3-6
X terminal setup vi, 5-2
XRemote setup
  collecting error messages 8-22
  configuration 8-11
  connecting 8-13
  modem setup, host-side 8-8
  modem, for user 8-4
  PPP/SLIP startup command 8-14
  search path 8-4, 8-16, 8-18, 8-19
  task list for UNIX 8-2
  task list for VMS 8-2
system manager, see system administration

T
TCP/IP, see communication protocol, TCP/IP
Telnet
  connection
    illustrated 6-18
    via Console 6-3, 6-15
terminal emulator 6-15 to 6-26
  3270
    defined 3-8
  benefits 3-5
closing, illustrated 1-14
command tool (OpenWindows) 3-8
Communications menu
  changing the connection 6-26
configured by system administration vi
Cursors menu
  changing the cursor appearance 6-26
DECTerm (DECwindows) 3-8
DECwindows Motif and 9-19 to 9-22
defined 1-5, 3-5, 3-8
example 1-10, 2-11, 6-20
File menu
  closing a connection 6-22
  debugging log 6-22
  exiting session 6-23
  printing to parallel 6-22
  printing to remote unit 6-22
terminal emulator, File menu (continued)
  printing to serial 6-22
  printing, log buffer 6-23
  printing, screen 6-22
  redrawing the screen 6-22
  resetting the terminal 6-22
  sending a break 6-23
Fonts menu
  changing font sizes 6-25
  function 2-11, 3-5
  illustrated 1-5, 1-10, 1-12
  number permitted 3-5
Options menu 6-23 to 6-25
  132-column format 6-24
  80/132 font switching 6-24
  80/132 switching 6-24
  bell, margin 6-25
  bell, visual 6-23
  blinking cursor 6-25
  clearing the screen 6-24
  condensed screen 6-24
curses emulator 6-24
  font, European characters 6-25
  font, ISO Latin 1 6-25
generating lines automatically 6-24
  grabbing the keyboard input 6-25
  local flow control 6-24
  log output, debugging 6-25
  mode, application cursor 6-24
  mode, application keypad 6-24
  preventing keystroke interception 6-25
  reversing video 6-23
  scrolling, jump 6-23
  status line, displaying 6-25
  stripping parity bit 6-25
  wrapping characters
    automatically 6-23
    wrapping in reverse 6-24
protocols, see communication protocol
shell tool (OpenWindows) 3-8
Sort menu
  sorting hosts list 6-17

Index-13
terminal emulator (continued)
starting 6-15 to 6-19
example 1-12
via Console 6-3, 9-19
via Session Manager 9-19
View menu
selecting connection types 6-17
VT102, see terminal emulator, xterm 1-6
VT320
access 3-5
defined 3-8
features 3-5, 6-20 to 6-26
for additional information 6-20
illustrated 6-20
menu bar 6-21 to 6-26
rectangular cut/paste 6-21
scroll bar 6-21
xterm
(NCDware) 3-8
(UNIX) 1-6, 3-8
defined 1-6, 3-8
example 1-6
illustrated 1-6, 5-7
Terminal Host Chooser 6-15 to 6-19
Terminals menu, see Console, Terminals menu
Token-Ring
connections 3-11
illustrated 3-10
see also communication protocol, Token-Ring
trackball
described 4-2
illustrated 4-2
see also mouse
twm, X Window System 2-13

U
UNIX, see operating system, UNIX
user name 5-6
User Preferences window, see Change User Preferences
Utilities menu, see Console, Utilities menu
utilities options, illustrated 6-44, 6-45

V
version
Boot Monitor 6-48
illustrated 6-47
NCDware 6-48
X terminal model 6-48
VMS, see operating system, VMS
VT102 terminal emulator, see terminal emulator, xterm
VT320 terminal emulator, see terminal emulator, VT320

W
window 4-8 to 4-13
actions summarized 9-6
active
defined 1-9, 4-9, 7-10
described 7-10
example 1-9
illustrated 1-10, 4-10, 7-6
closing 4-10, 7-9, 7-14, 7-20, 9-6
Console 6-3
defined 2-6, 4-8
deiconifying 4-13, 7-20
defined 2-6
example 2-6
focus policy, see focus policy
hierarchy, changing 7-9, 7-14, 7-16, 9-6
iconifying 4-13, 7-9, 7-14, 7-18 to 7-19
managing 9-5 to 9-6
maximizing 7-14
menu 9-5
minimizing 7-14
moving 4-12, 7-9, 7-14, 7-15, 9-6
defined 2-6
example 1-13
illustrated 1-14
purpose 2-8
window (continued)
  rearranging icon box 7-14
  resizing 4-12, 7-14, 7-17, 9-6
    example 1-11
    illustrated 1-11
    tools 7-9
  root, see root window
  see also Open Windows, window
  selecting 1-9
  undoing last manipulation 7-14
window manager 4-8 to 4-20
  automatic startup 1-6
  companion software, see ncdrunwm
  configured by system administration vi
  defined 1-6, 2-12
  host-based, defined 3-4
  interface tools 2-6 to 2-7
  local, defined 3-4
  on/off utility 6-4
  purpose 1-6, 2-8
  see also DECwindows, Motif; graphical
    user interface; ncdwm; OpenWindows,
    olwm; OSF/Motif, mwm; twm, X Window System
  tools
    buttons 4-16 to 4-17
    frame 2-12, 4-11, 7-8
    illustrated 4-14, 4-16, 4-18, 7-8
    maximize button 7-9
    menu bar 4-14 to 4-15
    menu button 7-9
    minimize button 7-9, 7-19
    OSF/Motif style 4-14 to 4-20
    resize handles 7-9
    see also DECwindows, Motif; OpenWindows, tools
  slider 4-18 to 4-20
  summarized 4-15, 4-17, 4-19 to 4-20, 7-9
  textual 4-18 to 4-20
  title bar 7-9
  window menu 7-9

window (continued)
  types 2-13
WindowMgr menu, see Console, WindowMgr menu
  wrapping, characters, see terminal emulator, Options menu

X
  X connections 6-51
  X Consortium 3-6
  X11R5 server
    implementation for NCD 3-2
  X Display Manager 5-7
    configured by system administration vi
    invisible in DECwindows
    environment 5-5
    starts up clients 5-6
  XDM banner with OpenWindows 9-2
  X server, see X Window System, X server
  X terminal
    base
      contents 3-1
      description 3-1
    bundled software 6-49
    client connections
      resource usage, illustrated 6-51
      defined 2-9
    getting information about your 6-5, 6-47
      to 6-52
    host connections 6-5
    Internet Protocol address 6-49
    licensable software 6-49
    memory 6-5, 6-49, 6-50
    model number 6-48
    powering up
    processor
      ability 2-14
      location 3-1
    resource usage 6-5
    statistics 6-5
    version 6-5
X Window System
- architecture 2-9 to 2-14
- benefits
  - access, consistent 2-8
  - device transparency 2-8
  - network transparency 2-8
  - operating system independence 2-8
  - processing, distributed 2-8
- components 2-9
- history 2-1 to 2-4
- illustrated 2-9
- introduction 2-1
- MIT
  - development 2-10
  - distribution 2-10, 3-7
- see also clients; ncdwm; NCDware

X server 2-9 to 2-11
- downloaded from host 6-49
- downloaded from media 3-2
- function 2-9, 2-10
- history 3-2
- Minimal, differences from Standard
  - v, 6-3, 6-4, 6-5, 6-10, 6-41, 6-45, 6-48, 6-50, 6-51, 6-52, 8-1
- performance, affected by font path 6-39
- performance, optimized 3-2
- requesting a font 2-11
- startup, automatic 5-7

X11, defined 2-10

X11, see X Window System, X11

XDM, see X Display Manager

.xmodmaprc.sun, remapping keys 9-9

XRemote
- /Serial, defined 8-4
- /TCP, defined 8-4
- additional sources of information 3-11
- and PCMCIA cards 2-10
- and PROMs 2-10

XRemote (continued)
- and UNIX
  - ending a session 8-20 to 8-21
  - invoking xinitremote 8-16, 8-17 to 8-18, 8-19
  - using who am i command 8-16, 8-17
- and VMS
  - ending a session 8-21
  - invoking XINITREMO T E 8-19
  - unsupported protocols 8-4
- configured by system administration
- connecting
  - directly to local host 8-11
  - via serial 8-12, 8-18 to 8-19
  - via TCP/IP over Ethernet/Token-Ring 8-12, 8-17 to 8-18
  - via TCP/IP over PPP/SLIP 8-12, 8-13 to 8-16
- defined 8-1
- described 2-10
- diagnosing problems 8-22
- Dialer client
  - Communications Menu 6-26
  - compared to Serial client 8-13
  - purpose 8-13
  - usage 8-13 to 8-14, 8-18 to 8-19, 8-20 to 8-21
- downloaded server 2-10
- ending a session 8-20 to 8-21
- files
  - .xinitremotec 8-16, 8-18, 8-19
  - .xservremotec 8-16, 8-18, 8-19
- hardware requirements 3-11, 8-3 to 8-7
- cable for host 8-4
- cable for modem 8-4
- modems 8-4
- see also XRemote, serial ports 8-5
- illustrated 8-3
XRemote (continued)
  logging into host for
    Ethernet/Token-Ring 8-17
    PPP/SLIP 8-15 to 8-16
    serial 8-19
  modem
    making the connection 8-10
    releasing the connection 6-23, 8-21
    setting up 8-7 to 8-10
    U.S. Robotics commands 8-9 to 8-10
    U.S. Robotics messages 8-10
  protocol
    characteristics 8-12
    choosing, reasons for 8-12
    unsupported for VMS 8-4
  purpose 8-1
  running XRemote helper for
    Ethernet/Token-Ring 8-17
    PPP/SLIP 8-14 to 8-15
  serial ports 8-5 to 8-6
    cable for DTE to DCE 8-6
    cable for DTE to DTE 8-6
    cable, null modem 8-6
    connector genders 8-6
    illustrated 8-5
  software requirements 8-3 to 8-4
    downloaded, X server 8-4
    host-resident helper program 8-4
    PCMCIA card, X server in 8-4
    PROMs, X server in 8-4
  starting session for
    PPP/SLIP 8-13 to 8-14
    serial 8-18
  system administration tasks
    collecting error messages 8-22
    configuration 8-11
    connecting 8-13
    listed for UNIX 8-2
    listed for VMS 8-2
    modem setup, host-side 8-8
    modem, for user 8-4
    PPP/SLIP startup command 8-14
    search path 8-4, 8-16, 8-18, 8-19
  .xsession, see system administration, startup file
  xterm, see terminal emulator, xterm